


Πριν από αρκετά χρόνια επιχείρησα να αξιοποιήσω για πρώτη φορά τις δυνατότητες
του λογισµικού Arc/info, στην πρώτη του έκδοση για προσωπικό υπολογιστή. Η δια-
δικασία της εκµάθησης ήταν πολύ πιο δύσκολη απ’ ότι σήµερα. Ο πρώτος λόγος
ήταν ότι έπρεπε να πληκτρολογείς τις εντολές, τις οποίες βέβαια έπρεπε να θυµάσαι.
Η διαδιασία θύµιζε µια απλή γλώσσα προγραµµατισµού. Ο δεύτερος λόγος ήταν
η ύπαρξη πολύ λίγων έµπειρων χρηστών για να ζητήσεις βοήθεια. Ευτυχώς, συνο-
δευτικό της άδειας του λογισµικού, ήταν το βιβλίο Understanding GIS, ένα εκπαι-
δευτικό εγχειρίδιο, για το οποίο επιτρέψτε µου να πω, ότι δεν έχω δει καλύτερο,
από την έκδοσή του µέχρι σήµερα. 

Από τη γενιά του PC ArcInfo έχουν περάσει αρκετά χρόνια. Έχουν µεσολαβήσει αρ-
κετές αλλαγές και προσπάθειες βελτίωσης. Σήµερα, το ώριµο, πια, λογισµικό Arcgis
10.1 for Desktop, έχει γίνει πιο φιλικό προς το χρήστη και παράλληλα έχει επεκταθεί
αρκετά και έχει γίνει πιο πολύπλοκο. Νοµίζω ότι για αυτό κυρίως το λόγο, ένα βι-
βλίο το οποίο καλύπτει τις βασικότερες δυνατότητες του λογισµικού και το οποίο
προσανατολίζει το χρήστη στα πρώτα του βήµατα, είναι επίκαιρο.

Με αφορµή αυτές τις σκέψεις πραγµατοποιήθηκε η συγγραφή του εκπαιδευτικού εγ-
χειριδίου που κρατάτε στα χέρια σας. Απευθύνεται, κυρίως, σε όλους όσους δεν
έχουν προηγούµενη εµπειρία µε το λογισµικό και θέλουν να αρχίσουν να εκµεταλ-
λεύονται τις δυνατότητές του. Επίσης, σε όσους θέλουν να επικαιροποιήσουν τις
γνώσεις τους στη νέα έκδοση 10.1 for Desktop. Ακόµα, αποτελεί ένα χρήσιµο
οδηγό για όσους θέλουν να γνωρίσουν τις βασικές δυνατότητες οποιουδήποτε λο-
γισµικού GIS, το οποίο διαχειρίζεται διανυσµατικά δεδοµένα και την πορεία των
εργασιών για την διεκπεραίωση µιας τυπικής µελέτης.

Το εγχειρίδιο αυτό αξιοποιεί την βασική δοµή του εγχειριδίου Understanding GIS.
Χρησιµοποιεί ένα ενιαίο εκπαιδευτικό παράδειγµα από την αρχή µέχρι το τέλος του.
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Αξιοποιεί την πολύ απλή και κατανοητή Γεωγραφική Βάση ∆εδοµένων του Understan-
ding GIS. Αποτελεί µετεξέλιξή του. Ελπίζω ότι η λογική του θα σας είναι υποβοη-
θητική.   

Στο σηµείο αυτό θα ήθελα να εκφράσω ευχαριστίες, σε όλους όσους βοήθησαν
στην ολοκλήρωση του βιβλίου.

Ευχαριστώ την εταιρεία QnR, η οποία έχει την αποκλειστική διάθεση της ψηφιακής
έκδοσης του βιβλίου.

Ευχαριστώ, επίσης, την εταιρεία Φάσµα inart publications, η οποία έχει την αποκλει-
στική διάθεση της έντυπης έκδοσης του εγχειριδίου.

Θα ήθελα να εκφράσω ευχαριστίες στην κα Μαρία Μέλλου για τη φιλολογική επι-
µέλεια του βιβλίου, στον κο Θωµά Ζέρµα για τη γραφιστική επεξεργασία και στην
κα Αλεξία Λουγιάκη για το εξώφυλλο.

Ιδιαίτερα ευχαριστώ την Κωνσταντίνα Μαρσέλη.

Τον Θεό που κάνει τα πάντα δυνατά.

Θωµάς Χατζηχρήστος
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1.1. Εισαγωγή

Τα τέσσερα βασικά µέρη µιας τυπικής µελέτης κατά την οποία αξιοποιείται η τεχνο-
λογία των Γεωπληροφοριακών Συστηµάτων (ΓΣ) είναι:

Η εισαγωγή των δεδοµένων στη γεωγραφική βάση
Η διαχείριση των δεδοµένων
Η ανάλυση των δεδοµένων
Η παρουσίαση των αποτελεσµάτων της ανάλυσης

Θεµελιώδους σηµασίας είναι το τµήµα του σχεδιασµού της µελέτης, το οποίο προ-
ηγείται της υλοποίησης. Το κεφάλαιο αυτό ασχολείται κυρίως µε το σχεδιασµό της
γεωγραφικής και περιγραφικής βάσης των δεδοµένων. Πιο αναλυτικά, θα εξετασθούν
παράµετροι που αφορούν:

στον προσδιορισµό των απαιτούµενων γεωγραφικών επιπέδων
στον προσδιορισµό των απαιτούµενων περιγραφικών τους χαρακτηριστικών
στον προσδιορισµό του κάθε χαρακτηριστικού µε την κωδικοποίησή του 
στις τεχνικές κωδικοποίησης και ονοµατολογίας

Στη συνέχεια παρουσιάζεται συνοπτικά το πρόβληµα που θα συναντήσει ο χρήστης
στα επόµενα κεφάλαια αλλά και τα απαραίτητα δεδοµένα για τη µελέτη που θα εκ-
πονήσει.
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1.2. Ο «Οδικός Χάρτης» µιας µελέτης ΓΣ

Γενικά, µια µελέτη µε τη χρήση ΓΣ µπορεί να οργανωθεί σε µια σειρά λογικών
σταδίων, καθένα από τα οποία προϋποθέτει την ύπαρξη των προηγούµενων. Τα στά-
δια αυτά είναι τα εξής:

Προσδιορισµός των στόχων της µελέτης
Σχεδιασµός της Βάσης
Εισαγωγή Γεωγραφικών ∆εδοµένων
∆ιόρθωση Λαθών και ∆ηµιουργία Τοπολογίας
∆ιαχείριση Περιγραφικών ∆εδοµένων
∆ιαχείριση Γεωγραφικών ∆εδοµένων
Ανάλυση των ∆εδοµένων
Χαρτογραφική Απεικόνιση

Για την καλύτερη κατανόηση των σταδίων εκπόνησης µιας µελέτης µε ΓΣ, καθώς
και των βασικών δυνατοτήτων του λογισµικού ArcGIS 10.1 for Desktop, θα χρησι-
µοποιηθεί ένα εκπαιδευτικό παράδειγµα, το οποίο αποτελεί µια τυπική µελέτη διανυ-
σµατικών γεωγραφικών δεδοµένων. Τα δεδοµένα είναι τεχνητά και δεν αναφέρονται
σε κάποια πραγµατική περιοχή. Το πρόβληµα που τίθεται γενικά αναλύεται παρακάτω. 

1.3. Εκπαιδευτικό Παράδειγµα

Ένας αναπτυξιακός φορέας σχεδιάζει την κατασκευή ενός κτιρίου. Η χωροθέτηση
του κτιρίου πρέπει να πληροί τα εξής κριτήρια:

Τα εδάφη πρέπει να είναι κατάλληλα για την κατασκευή του
Η χρήση της γης πρέπει να είναι συµβατή µε την ανέγερσή του 
Πρέπει να βρίσκεται τουλάχιστον 20m µακριά από το υπάρχον υδρογραφικό
δίκτυο.
Πρέπει να βρίσκεται το πολύ 300m από το υπάρχον αποχετευτικό δίκτυο.
Το συνολικό εµβαδόν του οικοπέδου πρέπει να είναι τουλάχιστον 2.000m2.

Το κόστος της αγοράς του οικοπέδου είναι επίσης µια σηµαντική παράµετρος. Για
το σκοπό αυτό θα πρέπει να κατασκευασθούν χάρτες µε τις υποψήφιες περιοχές
χωροθέτησης, την προτεινόµενη θέση, τα χαρακτηριστικά τους, καθώς και το οδικό
δίκτυο της περιοχής.

Σύµφωνα µε τα προηγούµενα, το πρώτο στάδιο στην επίλυση του προβλήµατος
αποτελεί ο Προσδιορισµός των στόχων της µελέτης.
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1.3.1. Προσδιορισµός των στόχων της µελέτης

Μερικά ερωτήµατα που θα µπορούσαν να βοηθήσουν στον προσδιορισµό των στό-
χων της µελέτης και της εφαρµογής της είναι τα ακόλουθα:

Ποιο είναι το πρόβληµα που πρέπει να επιλυθεί; Ποια είναι η πορεία επίλυσης
που ακολουθείται µέχρι αυτή τη στιγµή; Υπάρχουν εναλλακτικές µέθοδοι επίλυσης,
χρησιµοποιώντας τα πακέτα λογισµικού που έχει ο χρήστης στη διάθεσή του;
Ποια είναι τα παραδοτέα προϊόντα της µελέτης; Πόσο συχνά πρέπει αυτά τα
προϊόντα να παράγονται;
Ποιοι είναι οι χρήστες αυτών των προϊόντων και ποιες είναι οι γνώσεις τους;
Υπάρχουν ή θα υπάρξουν και άλλες χρήσεις για τα ίδια δεδοµένα; Εάν ναι,
τότε ποιες θα είναι οι απαιτήσεις;

1.3.2. Σχεδιασµός της Γεωγραφικής Βάσης ∆εδοµένων

Το πρώτο βήµα στην ανάπτυξη της ψηφιακής γεωγραφικής βάσης δεδοµένων είναι
ο προσδιορισµός των λογικών επιπέδων. Ο σωστός σχεδιασµός της Βάσης εξα-
σφαλίζει την πληρότητα και τη διαθεσιµότητα των γεωγραφικών και περιγραφικών
χαρακτηριστικών πριν από το στάδιο της ανάλυσης, ενώ η συµπλήρωσή της στη
διάρκεια της ανάλυσης ή της παρουσίασης των αποτελεσµάτων της ανάλυσης είναι
δαπανηρή, οικονοµικά και χρονικά. Μια καλά σχεδιασµένη βάση εξασφαλίζει και τη
µελλοντική της απρόσκοπτη χρήση.

Βήµα 1: Προσδιορισµός απαιτούµενων επιπέδων

Κάθε κριτήριο του προβλήµατος µπορεί να µεταφρασθεί σε ένα ή και περισσότερα
γεωγραφικά επίπεδα µε συγκεκριµένα περιγραφικά χαρακτηριστικά. 

Στο συγκεκριµένο παράδειγµα έχουµε τα ακόλουθα κριτήρια, τα οποία αντιστοιχούν
σε επίπεδα πληροφορίας:
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Κριτήριο Επίπεδο Τοπολογία
Κατάλληλα εδάφη SOILS Πολυγωνική

Επιτρεπόµενη χρήση γης LANDUSE Πολυγωνική

Απόσταση τουλάχιστον 20m από υδρογραφικό δίκτυο STREAMS Γραµµική

Απόσταση το πολύ 300m από αποχετευτικό δίκτυο SEWERS Γραµµική



Το κριτήριο του εµβαδού και του κόστους θα εφαρµοσθούν στο τελικό λογικό επί-
πεδο που θα προκύψει από το συνδυασµό των τεσσάρων επιπέδων, όπως θα δούµε
στα επόµενα κεφάλαια.

Βήµα 2: Προσδιορισµός των περιγραφικών χαρακτηριστικών

Για τα παραπάνω επίπεδα τα περιγραφικά χαρακτηριστικά είναι τα εξής:

Μετά τον προσδιορισµό των περιγραφικών
χαρακτηριστικών είναι απαραίτητη η κωδι-
κοποίησή τους. Όπως είναι γνωστό, τα πε-
ριγραφικά χαρακτηριστικά αποθηκεύονται
στον υπολογιστή µας είτε ως αριθµοί είτε
ως χαρακτήρες. Αν για παράδειγµα χρει-
άζεται να αποθηκευθεί το όνοµα µιας

οδού, θα αποθηκευθεί µε αλφαβητικούς χαρακτήρες (π.χ. Ο∆ΟΣ ΜΙΑΟΥΛΗ), ενώ
αν χρειάζεται να αποθηκευθεί το πλάτος της, µε αριθµητικά ψηφία (π.χ. 32). 

Μερικές φορές κάποια περιγραφικά χαρακτηριστικά αποθηκεύονται καλύτερα µ’ έναν
κωδικό. Εάν, για παράδειγµα, η ιδιότητα περιγράφει µια
τάξη, είναι προτιµότερο να χρησιµοποιηθεί ένας κωδικός
παρά το όνοµα της τάξης (π.χ. αντί για αστική γη το 100).
Η ίδια λογική µπορεί να χρησιµοποιηθεί και για το εύρος
των τιµών. Για παράδειγµα:

Βήµα 3: Προσδιορισµός αποθηκευτικού χώρου

Ένα ακόµα βήµα είναι ο προσδιορισµός του χώρου που απαιτείται για να αναπτυχ-
θούν τα γεωγραφικά επίπεδα και τα περιγραφικά τους χαρακτηριστικά.  

Βήµα 4: Εισαγωγή Μεταδεδοµένων

Το λεξικό δεδοµένων είναι ουσιαστικά πληροφορίες για τις πληροφορίες. Χρησιµεύει
για να µεταφέρει πληροφορίες σε άλλους, καθώς και για να υπενθυµίζει στο
χρήστη τις λεπτοµέρειες της βάσης του. Στο συγκεκριµένο εκπαιδευτικό παράδειγµα
θα µπορούσε να έχει την εξής µορφή:
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Επίπεδο Περιγραφικά χαρακτηριστικά
SOILS Καταλληλότητα

LANDUSE
Κωδικός χρήσης
Κόστος / Ha
Τύπος χρήσης

STREAMS Τύπος ποταµού

SEWERS Κατηγορία αποχετευτικού διτύου

Κλίσεις Κωδικός
0-10 1

11-30 2

31-45 3

45+ 4



Bήµα 5: Καθορισµός συστήµατος συντεταγµένων

Η απόδοση του ίδιου συστήµατος συντεταγµένων σε όλα τα γεωγραφικά επίπεδα
είναι απαραίτητη. Στο σηµείο αυτό ο χρήστης πρέπει να επιλέξει το σύστηµα συν-
τεταγµένων και την προβολή που κάθε φορά ανταποκρίνεται στο σκοπό του. Στο
συγκεκριµένο παράδειγµα χρησιµοποιείται το σύστηµα συντεταγµένων “Clarke 1866
UTM, Zone 18”.

Βήµα 6: Οργάνωση του χώρου εργασίας

Μετά το στάδιο του σχεδιασµού ακολουθεί το στάδιο της υλοποίησης µε τη συλλογή
των απαραίτητων δεδοµένων. Καταρχάς συλλέγονται τα δεδοµένα που υπάρχουν
ήδη σε ψηφιακή µορφή. Τα δεδοµένα που δεν υπάρχουν σε ψηφιακή µορφή πρέπει
να ψηφιοποιηθούν. 
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Κριτήριο Επίπεδο Τοπολογία
Περιγραφικά 

χαρακτηριστικά
(Κωδικοποίηση)

Περιγραφικά 
χαρακτηριστικά
(Περιγραφή)

Κατάλληλα εδάφη SOILS Πολύγωνα SUIT 
0 
1 
2 
3

Καταλληλότητα
Μηδενική 
Μικρή 
Μέση 
Μεγάλη

Επιτρεπόµενη χρήση γης LUAT Πολύγωνα LU-CODE 
100 
200 
300 
400 
500  
700

Κωδικός χρήσης 
Αστική 
Αγροτική 
Θαµνώδης 
∆ασική 
Υδάτινη 
Άγονη

COST/ Ha Κόστος/ Ha

10000 
15000 
20000 
30000 
40000

Απόσταση 20m από ποτάµια STREAMS Γραµµική STRM-CODE 
1 
2

Κατηγορία ποταµού 
Κύριο 

∆ευτερεύων

Απόσταση 300m από αποχέτευση SEWERS Γραµµική DIAMETER
60cm
45cm

∆ιάµετρος Αγωγού



Πριν τη συλλογή των δεδοµένων είναι χρήσιµο να οργανωθεί ο χώρος στον οποίο

θα αποθηκευθούν. Ένας τυπικός χώρος εργασίας περιλαµβάνει ένα folder για τη

µελέτη, κάτω από το οποίο υπάρχουν επίσης folders που αντιστοιχούν στα γεωγρα-

φικά επίπεδα. Σε καθένα από αυτά υπάρχουν διαφορετικές εκδόσεις των επιπέδων.

Αυτό φαίνεται παραστατικά στο επόµενο σχήµα:

Ένα άλλο πολύ σηµαντικό στοιχείο είναι η ονοµατολογία των

γεωγραφικών επιπέδων. Το όνοµα θα πρέπει να προδίδει,

εκτός από το θέµα του επιπέδου, το στάδιο επεξεργασίας

στο οποίο βρίσκεται το επίπεδο. Για παράδειγµα, για ένα επί-

πεδο που αφορά χρήσεις γης η ονοµατολογία θα µπορούσε να είναι η ακόλουθη:

LANDUSE_DG: Tο επίπεδο που ψηφιοποιείται
LANDUSE_TP: Tο επίπεδο που έχει διορθωθεί από πιθανά λάθη 

Επίσης, είναι χρήσιµο να διατηρείται ένας πίνακας µε τα διάφορα στάδια επεξερ-

γασίας και ο χρήστης να σηµειώνει για κάθε επίπεδο την πρόοδο των εργασιών.

Για παράδειγµα:

1.4. Επίλογος

Στο κεφάλαιο αυτό διαπιστώθηκε ότι τα βασικά συστατικά της Βάσης είναι τα γεω-

γραφικά επίπεδα και τα περιγραφικά τους χαρακτηριστικά. Κάθε κριτήριο της µελέτης

µπορεί να απαιτεί ένα ή περισσότερα γεωγραφικά επίπεδα µε τις ιδιότητές τους. 

Στο επόµενο κεφάλαιο παρουσιάζεται η δοµή και οι βασικές ιδιότητες του λογισµικού

ArcGIS 10.1 for Desktop, το οποίο θα χρησιµοποιηθεί για την επίλυση του τυπικού

προβλήµατος
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Επίπεδο / Στάδιο Ψηφιοποίηση ∆ιόρθωση Μετασχηµατισµός Τελικός Έλεγχος
LANDUSE OK - - OK

SOILS OK OK OK OK

STREAMS OK OK OK OK



2.1. Εισαγωγή

Tο ArcGIS for Desktop είναι το πιο διαδεδοµένο λογισµικό των Γεωπληροφοριακών
Συστηµάτων. Υπάρχουν τρία επίπεδα δυνατοτήτων στο ArcGIS 10.1, τα Basic, Standard
και Advanced. Το Basic είναι το αρχικό από τα τρία λειτουργικά επίπεδα του προ-

ϊόντος. Η πλατφόρµα του Advanced προσφέρει στο χρήστη περισσότερες δυνατότητες

συγκριτικά µε τις άλλες δύο. Στο πλαίσιο του βιβλίου αυτού καλύπτονται οι βασικές

δυνατότητες της έκδοσης Basic του λογισµικού ArcGIS 10.1. 

Το ArcGIS for Desktop περιλαµβάνει ένα σύνολο από εφαρµογές, όπως ArcMap,
ArcCatalog, ArcToolbox κ.λπ., και µπορεί να επιτελέσει τις βασικές λειτουργίες της
εισαγωγής, διαχείρισης, ανάλυσης και απεικόνισης γεωγραφικών δεδοµένων.

Στις επόµενες παραγράφους παρουσιάζονται περιληπτικά τα βασικά συστατικά µέρη

του ArcGIS Desktop.
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2 Εισαγωγή στο
λογισµικό



2.2. Εφαρµογή ArcMap 
2.2.1. Το περιβάλλον του ArcMap

Το περιβάλλον του ArcMap αποτελεί την κεντρική εφαρµογή του λογισµικού, η
οποία δίνει στο χρήστη τη δυνατότητα να δηµιουργεί χάρτες, συνθέτοντας επίπεδα
χωρικής πληροφορίας και επιτελώντας τις λειτουργίες διαχείρισης και ανάλυσης
των γεωγραφικών δεδοµένων, τις οποίες προβλέπει η εκάστοτε έκδοση του λογι-
σµικού.  

Η εκκίνηση του ArcMap επιτυγχάνεται µέσα από το µενού “Έναρξη > Όλα
τα Προγράµµατα > ArcGIS > ArcMap 10.1” του υπολογιστή και µε κλικ στο
εικονίδιο    , το οποίο υπάρχει στη “Standard Εργαλειοθήκη” του ArcCatalog
η εκκίνηση του οποίου επιτυγχάνεται κατά τον ίδιο τρόπο µέσα από τη λίστα
προγραµµάτων. 

Το περιβάλλον εργασίας του ArcMap αποτελείται από:

τον Πίνακα Περιεχοµένων, στον οποίο περιέχονται τα επίπεδα που έχει προ-
σθέσει ο χρήστης
την Περιοχή Εµφάνισης Χάρτη, στην οποία παρουσιάζονται τα επίπεδα, ανάλογα
µε τη σειρά εµφάνισής τους και τον τρόπο συµβολισµού τους
τις Εργαλειοθήκες, οι οποίες παρέχουν στον χρήστη διάφορα εργαλεία που
ενεργοποιούνται µε απλό κλικ
τη Ράβδο Μηνυµάτων, στην οποία εµφανίζονται διάφορα µηνύµατα κατά την
εκτέλεση των λειτουργιών, συντεταγµένες του χάρτη κ.λπ.

Στη συνέχεια δίνεται το παράδειγµα εισαγωγής του θεµατικού επιπέδου STREAMS
στο περιβάλλον του ArcMap. Αυτό είναι εφικτό ακολουθώντας τα εξής βήµατα:

Εκκίνηση του ArcMap. 
Εισαγωγή του επιπέδου STREAMS {...\\DATA\BASIC\SHAPEFILES} µε επιλογή

του εικονιδίου “Add Data” µέσα από τη “Βασική Εργαλειοθήκη”. Η επι-
λογή του εργαλείου “Add Data” έχει ως αποτέλεσµα το άνοιγµα ενός παρα-
θύρου στο οποίο ο χρήστης καλείται να επιλέξει το επιθυµητό θεµατικό επίπεδο.
Επιλογή “Αdd” στο παράθυρο “Add Data”.

Το αποτέλεσµα φαίνεται στην εικόνα 2.1 που ακολουθεί.
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Εικόνα 2.1. : Περιβάλλον ArcMap

2.2.2. Πίνακας Περιεχοµένων

Στον “Πίνακα Περιεχοµένων / Table Of Contents” ο χρήστης έχει τη δυνατότητα: 

Να αναδιατάσσει τα επίπεδα µε απλό drag and drop, ώστε να απεικονίζονται
µε την αντίστοιχη σειρά στην “Περιοχή Εµφάνισης Χάρτη”.
Να ενεργοποιεί και να απενεργοποιεί τα επίπεδα, για να εµφανίζονται ή όχι.
Να ανοίγει το παράθυρο των ιδιοτήτων (Properties) του κάθε επιπέδου µε
διπλό κλικ στο όνοµά του. 
Να µεταβαίνει απευθείας στην καρτέλα “Symbology”, όπου µπορεί να καθο-
ρίσει τον τρόπο εµφάνισης του κάθε επιπέδου µε απλό κλικ στο σύµβολό του. 

ΠΡΟΣΟΧΗ!! Η σειρά διάταξης των θεµατικών επιπέδων στην περίπτωση
που υπάρχουν όλων των ειδών τα επίπεδα, είναι: Σηµειακά, Γραµµικά
και Πολυγωνικά. Τα πολυγωνικά επίπεδα θα πρέπει να βρίσκονται τελευ-
ταία στη λίστα Layers του Table Of Contents ώστε να µην καλύπτουν
τα σηµειaκά ή τα γραµµικά επίπεδα πληροφορίας. 
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Ο χρήστης έχει στη διάθεσή του τέσσερις τρόπους
εµφάνισης των επιπέδων.

List By Drawing Order: Στην περίπτωση αυτή, ο χρήστης µπορεί να επιλέξει τη
σειρά µε την οποία εµφανίζονται τα θεµατικά επίπεδα, να µεταβάλει τον τρόπο
απεικόνισης κ.ά.

List by Source: Ο δεύτερος τρόπος εµφάνισης των δεδοµένων συνδέεται µε
τη θέση στην οποία έχουν αποθηκευτεί. Τα δεδοµένα µε αυτή την επιλογή εµ-
φανίζονται µε τέτοιο τρόπο, ώστε ο χρήστης  να γνωρίζει το φάκελο στον
οποίο είναι αποθηκευµένα.

List By Visibility: Αποτελεί τον κλασικό τρόπο εµφάνισης των θεµατικών επι-
πέδων. Τα επίπεδα απεικονίζονται σε συνδυασµό µε το σύµβολο απεικόνισής
τους, προσφέροντας στο χρήστη τη δυνατότητα να αναγνωρίσει και να διακρίνει
τα διανυσµατικά από τα ψηφιδωτά αρχεία, καθώς και τα πολυγωνικά, γραµµικά
και σηµειακά επίπεδα µεταξύ τους.

List By Selection: Τα επίπεδα, όπως και στον προηγούµενο τρόπο απεικόνισης,
συνοδεύονται από τα αντίστοιχα σύµβολα που αποτυπώνουν τη γεωµετρία τους,
ενώ παράλληλα εµφανίζονται και οι επιλεγµένες για κάθε θεµατικό επίπεδο
εγγραφές.

Επίσης, µε δεξί κλικ σε κάθε επίπεδο εµφανίζεται λίστα ενεργειών, όπως “Zoom
To Layer”,  “Data > Export Data”, “Properties”, κ.ά. 

Μέσα από το περιβάλλον του ArcMap όπως και των υπόλοιπων εφαρµογών, προ-
σφέρεται η δυνατότητα στο χρήστη να αλλάξει τη θέση στην οποία εµφανίζεται ο
“Πίνακας Περιεχοµένων/ Table Of Contents”, όπως και οι πίνακες περιγραφικής
πληροφορίας των επιπέδων. Επιπλέον, µπορεί να επιλέξει την εµφάνιση των πλαισίων
αυτών είτε σε µια από τις τέσσερις πλευρές της “Περιοχής Εµφάνισης Χάρτη” είτε
ως µεµονωµένο παράθυρο στην περιοχή αυτή. 

Στην περίπτωση του “Πίνακα Περιεχοµένων”, αυτό είναι εφικτό να συµβεί σύροντας
απλώς το παράθυρο στο κέντρο της “Περιοχής Εµφάνισης Χάρτη”. Η µορφή του
είναι αυτή της Εικόνας 2.2. Σε µια νέα προσπάθεια µετακίνησης του πλαισίου του
“Πίνακα Περιεχοµένων” εµφανίζονται τα εικονίδια σε σχήµα βέλους, τα οποία πλη-
ροφορούν το χρήστη για τη θέση που θα πάρει ο “Πίνακας Περιεχοµένων” ανάλογα



µε την επιλογή του. Σύροντας έτσι το πλαίσιο του “Πίνακα Περιεχοµένων” πάνω στο
επιθυµητό βέλος, αυτόµατα η περιοχή στην οποία θα τοποθετηθεί το πλαίσιο χρω-
µατίζεται µε µπλε χρώµα. Αφήνοντας το ποντίκι του υπολογιστή, ο “Πίνακας Περιε-
χοµένων” «κλειδώνει» στη δεξιά θέση του παραθύρου εµφάνισης χάρτη.

Εικόνα 2.2. : Ορισµός Θέσης Πίνακα Περιεχοµένων

2.2.3. Συµβολισµός θεµατικών επιπέδων

Στο σηµείο αυτό αναφέρεται συνοπτικά ο απλούστερος τρόπος µεταβολής της απει-
κόνισης ενός θεµατικού επιπέδου.  Ο χρήστης µπορεί να τροποποιήσει το χρώµα
ή το σύµβολο µε το οποίο απεικονίζεται ένα θεµατικό επίπεδο στο παράθυρο εµ-
φάνισης χάρτη. Είτε πρόκειται για σηµειακό, είτε για γραµµικό, είτε για πολυγωνικό
θεµατικό επίπεδο, η αλλαγή είναι εφικτή µε διπλό κλικ στο εικονίδιο του συµβόλου. 
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Στην περίπτωση του γραµµικού
επιπέδου STREAMS, το παρά-
θυρο που ανοίγει έχει τη
µορφή της διπλανής εικόνας. 

Το παράθυρο ονοµάζεται
“Symbol Selector” και χωρί-
ζεται σε δύο τµήµατα. 

Το αριστερό τµήµα παρέχει
πλήθος έτοιµων συµβόλων.

Στο δεξί τµήµα ο χρήστης
έχει τη δυνατότητα να αλλάξει
τη µορφή, το πάχος της
γραµµής και το χρώµα της.

Κατά τη διαδικασία των αλλαγών, στο δεξί πάνω µέρος του παραθύρου εµφανίζεται

η προεπισκόπηση του επιπέδου. Ο χρήστης µπορεί επίσης να επεξεργαστεί ένα ήδη

υπάρχον σύµβολο µε την εντολή “Edit Symbols” και εν συνεχεία να το αποθηκεύσει

για µελλοντική χρήση. Τέλος, κάνοντας “Reset” επαναφέρει τον αρχικό τρόπο συµ-

βολισµού του επιπέδου που επεξεργάζεται, αναιρώντας όλες τις αλλαγές που είχε

εκτελέσει.

Στο όγδοο κεφάλαιο αναλύεται λεπτοµερέστερα το θέµα του συµβολισµού των επι-

πέδων µε τελικό στόχο τη σχεδίαση και υλοποίηση ενός χάρτη. 

2.2.4. Πίνακας περιγραφικών χαρακτηριστικών

Στην ενότητα αυτή αναφέρεται η διαδικασία εµφάνισης του “Πίνακα Περιεχοµένων”
για οποιοδήποτε από τα θεµατικά του επίπεδα. 

Όπως φαίνεται στην Εικόνα 2.3., κάνοντας δεξί κλικ στο επίπεδο STREAMS, ανοίγει
µια λίστα/καρτέλα επιλογών. 



Επιλέγοντας την τρίτη επιλογή “Open Attribute Table”, ο χρήστης ανοίγει τον
πίνακα µε την περιγραφική πληροφορία του επιπέδου.
Ο χρήστης µπορεί να τοποθετήσει τον πίνακα σε οποιαδήποτε θέση µέσα στο
παράθυρο του περιβάλλοντος ArcMap µε τον ίδιο τρόπο που ακολουθεί για
τον καθορισµό της θέσης του “Πίνακα Περιεχοµένων”.

2.2.5. Τρόποι Εµφάνισης Χάρτη

Υπάρχουν δύο τρόποι εµφάνισης των δεδοµένων. Mέσα από το κύριο µενού µε

την επιλογή “View”, ο χρήστης µπορεί να επιλέξει µεταξύ του “Data View” και

του “Layout View”. Αυτό επιτυγχάνεται µε τη χρήση των κουµπιών συντόµευσης, τα

οποία βρίσκονται στο κάτω µέρος του παραθύρου «εµφάνισης χάρτη»:
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Εικόνα 2.3. : Εµφάνιση πίνακα περιγραφικών χαρακτηριστικών
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Data View     : Σε αυτό ο χρήστης πραγµατοποιεί όλες τις ενέργειες, από
απλή πλοήγηση µέχρι επεξεργασία και ανάλυση των δεδοµένων. Τίτλοι χαρτών,

υποµνήµατα, γραφικά κλίµακας δεν µπορούν να δηµιουργηθούν και να εµφα-

νιστούν.

Layout View    : Σε αυτό ο χρήστης µεταβαίνει για να προετοιµάσει την
εκτύπωση του χάρτη του. Εδώ µπορεί να ορίσει µέγεθος χαρτιού, να προσθέσει

τίτλους, υποµνήµατα, κτλ.

2.2.6. Εργαλειοθήκες

Παρακάτω ακολουθεί µια σύντοµη περιγραφή των δύο βασικών εργαλειοθηκών της

εφαρµογής:

Standard Εργαλειοθήκη:

Η εργαλειοθήκη αυτή περιλαµβάνει εργαλεία όπως:

Επίσης, σε αυτή την εργαλειοθήκη εµφανίζεται και η κλίµακα του χάρτη, η οποία

ενηµερώνεται αυτόµατα ανάλογα µε το επίπεδο µεγέθυνσης (zoom).

22

Εντολή “Undo” 

Εντολή “Redo” 

Προσθήκη επιπέδων 
(shapefile, coverage, grid) στο χάρτη

Ενεργοποίηση εργαλείων διαχείρισης
δεδοµένων (editing)    

Εκκίνηση ArcCatalog

Εκκίνηση ArcToolbox
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Εργαλειοθήκη Πλοήγησης:

Η εργαλειοθήκη αυτή περιλαµβάνει τα εξής:

Οι χάρτες (σύνθεση επιπέδων, συµβολισµοί, χρώµατα, layout κ.λπ.) που δηµιουρ-
γούνται στο ArcMap αποθηκεύονται σε αρχεία µε επέκταση ονόµατος ”.mxd”. Στα
αρχεία αυτά αποθηκεύονται πληροφορίες για τα δεδοµένα και όχι τα δεδοµένα
αυτά καθεαυτά.

Το άνοιγµα ενός αποθηκευµένου χάρτη γίνεται µε διπλό κλικ στο αντίστοιχο αρχείο
(αρχείο .mxd) ή από την επιλογή “Open” του µενού “File” του ArcMap.

∆ηµιουργία παραθύρου εστίασης 

∆ηµιουργία παραθύρου σµίκρυνσης 

Μεγέθυνση 

Σµίκρυνση 

Ολίσθηση στο χάρτη 

Εµφάνιση ολόκληρου του χάρτη 

Μετάβαση στο προηγούµενο επίπεδο
εστίασης  

Μετάβαση στο επόµενο επίπεδο εστίασης  

Επιλογή οντοτήτων του χάρτη 
(π.χ. σηµεία, γραµµές, πολύγωνα) 

Επιλογή στοιχείων του χάρτη 

Ακύρωση επιλογής οντοτήτων 

Εµφάνιση περιγραφικών ιδιοτήτων
οντότητας

Σύνδεση µε κάποιο αρχείο Html Popup  

Εύρεση οντοτήτων 

Μέτρηση αποστάσεων 

Παρατήρηση χρονικής µεταβολής

Εργαλείο εύρεσης διαδροµής 

∆ηµιουργία νέου παραθύρου
µεγέθυνσης

Μεταφορά σε σηµείο µε γνωστές
συντεταγµένες

ΠΡΟΣΟΧΗ!! Στην περίπτωση που µεταβληθεί το “path” στο οποίο είναι
αποθηκευµένα τα δεδοµένα που εµφανίζονται σε ένα αρχείο ”.mxd”,
τότε τα δεδοµένα αυτά εµφανίζονται µε την προσθήκη ενός θαυµαστικού
“!” στη λίστα “Layers” του “Table of Constents”.



2.3. Εφαρµογή ArcCatalog
2.3.1. Το περιβάλλον του ArcCatalog

Ο ArcCatalog αποτελεί µια εφαρµογή διαχείρισης γεωγραφικών δεδοµένων. Εκτελεί
λειτουργίες παρόµοιες µε τον Windows Explorer, προσανατολισµένες, βέβαια, στα
γεωγραφικά δεδοµένα. 

Μέσω του ArcCatalog ο χρήστης µπορεί:
Να δηµιουργεί νέα δεδοµένα
Να µετακινεί τα γεωγραφικά δεδοµένα (αντιγραφή – επικόλληση)
Να διαγράφει γεωγραφικά δεδοµένα
Να µετονοµάζει γεωγραφικά δεδοµένα
Να διερευνά τα γεωγραφικά δεδοµένα σε επίπεδο προεπισκόπησης (preview)
Να συµπληρώνει τα µεταδεδοµένα σύµφωνα µε το επιλεγµένο πρότυπο κ.ά.

Ο ArcCatalog ενεργοποιείται µέσα από το µενού “Έναρξη > Όλα τα Προγράµµατα
> ArcGIS > ArcCatalog 10.1” του υπολογιστή. Στην παρακάτω εικόνα φαίνεται το
περιβάλλον του ArcCatalog.
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Εικόνα 2.4.: Περιβάλλον ArcCatalog
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Το περιβάλλον εργασίας του ArcCatalog αποτελείται από:

Το “Παράθυρο Πλοήγησης Αρχείων” όπου ο χρήστης µπορεί να µεταβαίνει
σε διαφορετικές τοποθεσίες του υπολογιστή και να διαχειρίζεται τα αρχεία µε
δεξί κλικ (copy, paste, delete, rename κτλ.).

Το “Παράθυρο Εµφάνισης ∆εδοµένων” όπου πραγµατοποιείται η εµφάνιση των

γεωγραφικών δεδοµένων που έχουν επιλεγεί στο Παράθυρο Πλοήγησης Αρ-
χείων µε τρεις τρόπους:

Contents: Εµφάνιση των δεδοµένων ως µικρογραφίες

και των περιεχοµένων των φακέλων (αν έχει επιλεγεί

φάκελος) ως λίστα µικρογραφιών, στην οποία υπάρχει η

δυνατότητα ενεργειών, όπως copy, paste, delete, rename

κτλ.

Αυτό είναι εφικτό µέσα από το περιβάλλον του ArcCata-

log µε την επιλογή από το “Παράθυρο Πλοήγησης Αρ-
χείων” οποιουδήποτε θεµατικού επιπέδου. Στο παράδειγµα της παραπάνω εικόνας

εµφανίζεται το θεµατικό επίπεδο STREAMS το οποίο βρίσκεται στο φάκελο

{\\DATA\BASIC\SHAPEFILES}. 

Preview: Εµφάνιση της γεωµετρίας

(γραφικά) ή της περιγραφικής πλη-

ροφορίας (πίνακα) του επιλεγµένου

επιπέδου. 

Description: Εµφάνιση των µεταδεδοµένων
του επιπέδου σύµφωνα µε το επιλεγµένο

πρότυπο µεταδεδοµένων, στη συγκεκρι-

µένη περίπτωση το “ISO 19115:2003”. 

Από το “Παράθυρο Πλοήγησης Αρχείων” ο χρήστης είναι σε θέση να εισάγει

οποιαδήποτε πληροφορία σχετική στο επιλεγµένο επίπεδο µε τη χρήση της εντολής

“Edit”. Κατόπιν µπορεί να αποθηκεύσει, να επικυρώσει τις αλλαγές, καθώς επίσης



και να εξάγει τις πληροφορίες των µεταδεδοµένων σε αρχείο. Επιπλέον, είναι

δυνατό να εισάγει ένα αρχείο µεταδεδοµένων, αν αυτό είναι διαθέσιµο, αποφεύ-

γοντας µε αυτόν τον τρόπο την εκ νέου πληκτρολόγηση των πληροφοριών.

Στη συνέχεια παρουσιάζεται το περιβάλλον εισαγωγής και επεξεργασίας των µετα-

δεδοµένων του θεµατικού επιπέδου STREAMS στον ArcCatalog. Η συµπλήρωση των

µεταδεδοµένων ενός οποιουδήποτε θεµατικού επιπέδου γίνεται ύστερα από την επι-

λογή του επιπέδου αυτού από το “Παράθυρο Πλοήγησης Αρχείων”.

Μέσω του περιβάλλοντος του ArcCatalog, ο χρήστης µπορεί να επιτελέσει απλές
λειτουργίες “Geoprocessing”, όπως φαίνεται στην εικόνα 2.5 που ακολουθεί.
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Με την ενεργοποίηση του “Edit” παρέχεται
ένα περιβάλλον καταχώρησης πληροφοριών

για το επιλεγµένο επίπεδο (STREAMS).

Mε την επιλογή ενός αρχείου Shapefile
(STREAMS) εµφανίζεται η παραπάνω ει-
κόνα στο παράθυρο “Description”.



Εικόνα 2.5. : Εργαλεία Geoprocessing.

Τέλος, ο χρήστης έχει στη διάθεσή του τα βασικά “Εργαλεία Πλοήγησης” (µετακί-
νηση, εστίαση, κτλ.). Τα εργαλεία αυτά ταυτίζονται µε τα αντίστοιχα της εφαρµογής
ArcMap και περιγράφονται στο υποκεφάλαιο 2.2.6.

Θα πρέπει να αναφερθεί ότι ο χρήστης µπορεί να περιηγηθεί στον  ArcCatalog
µέσα από το περιβάλλον του ArcMap, όπως φαίνεται στο παράδειγµα της Eικόνας
2.6. Ο ArcCatalog υπάρχει ως ετικέτα στο πλάγιο µέρος του παραθύρου του ArcMap,
δίνοντας στο χρήστη τη δυνατότητα για αµεσότερη διαχείριση των δεδοµένων. Από
τη στιγµή που ολοκληρώνεται η χρήση του περιβάλλοντος ArcCatalog, το παράθυρο
κλείνει αυτόµατα, και µε αυτόν τον τρόπο ο χρήστης είναι σε θέση να αξιοποιήσει
ολόκληρο το διαθέσιµο χώρο στο περιβάλλον του ArcMap.
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Εικόνα 2.6.: Το περιβάλλον του ArcCatalog µέσα στο περιβάλλον του ArcMap.

2.3.2. Αρχεία που διαχειρίζεται το ArcGIS

Ακολουθεί µια σύντοµη περιγραφή των τύπων των γεωγραφικών δεδοµένων, που
έχει χρησιµοποιήσει η εταιρεία ESRI και των οποίων διαχειρίζεται το λογισµικό.
Κάθε τύπος αρχείου απεικονίζεται µε διαφορετικό εικονίδιο στον ArcCatalog.

ArcInfo Coverage

Η πρώτη µορφή δεδοµένων της ESRI. Η γεωµετρία αποθηκεύεται σε αρκετά αρχεία

στο δίσκο, σε ένα folder µε το όνοµα του επιπέδου. Στο φάκελο (folder)  µε το
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όνοµα info αποθηκεύονται τα περιγραφικά χαρακτηριστικά του επιπέδου. Η πλήρης

διαχείριση των δεδοµένων αυτών είναι δυνατή µόνο µε το module Arcinfo.

Πρόκειται για βάση χωρικών δεδοµένων, η σχεδίαση της οποίας

ανάγεται στη δεκαετία του 1980. Μπορεί να περιέχει σηµεία,

γραµµές ή πολύγωνα, ή γραµµές και πολύγωνα ταυτόχρονα..

Grids / Images

Αρχεία µορφής καννάβου (raster). Απεικονίζουν συνεχή φαινόµενα (Ψηφιακά Μοντέλα

Εδάφους) ή αφορούν δορυφορικές εικόνες, αεροφωτογραφίες κτλ.

Η δοµή των αρχείων αυτών είναι ακριβώς η ίδια µε των coverages, όπως ανα-

φέρθηκε παραπάνω. 

Shapefile

Η δοµή αυτή παρουσιάστηκε για πρώτη φορά τη δεκαετία του 1990 µε την πρώτη

έκδοση του λογισµικού Arcview. Πρόκειται για την απλούστερη µορφή επιπέδου. Το

κάθε επίπεδο αποτελείται απο αρκετά αρχεία, .shp, .sbn, .dbf κτλ. Το αρχείο .dbf

περιέχει τις περιγραφικές πληροφορίες σε µορφή βάσης δεδοµένων DBASE. 

Τα Σχηµατικά αρχεία µπορούν να τροποποιηθούν στο περιβάλλον του λογισµικού

Arcgis επιπέδου Arcview. 

Μπορεί να αφορούν µόνο σηµεία, µόνο γραµ-

µές ή µόνο πολύγωνα. Τα αρχεία αυτά εµφα-

νίζονται µε τα ακόλουθα εικονίδια στο

περιβάλλον του ArcCatalog.
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Αρχείο γραµµικής τοπολογίας

Αρχείο πολυγωνικής τοπολογίας

Αρχείο σηµειακής τοπολογίας

Κάνναβος, δορυφορική εικόνα κ.λπ.



Κάθε shapefile αποτελείται από ένα σύνολο αρχείων, όπως φαίνεται

στη διπλανή εικόνα. Τα αρχεία αυτά εµφανίζονται στο περιβάλλον

του “Windows Explorer”.

Geodatabase

Η γεωβάση αποτελεί τη νεότερη µορφή δεδοµένων, η οποία αναπτύχθηκε στην αρ-

χική της µορφή µετά το 2000. Σε µια γεωβάση µπορούν να αποθηκευθούν δεδοµένα

σηµειακής, γραµµικής ή και πολυγωνικής τοπολογίας. Υπάρχουν τρία είδη γεωβά-

σεων µε διαφορετικές δυνατότητες. Παρακάτω δίνονται τα είδη γεωβάσεων, καθώς

και ο τρόπος µε τον οποίο εµφανίζονται τόσο στο περιβάλλον του ArcCatalog, όσο

και στο περιβάλλον των Windows:

Η πιο απλή µορφή είναι αυτή της File Geodatabase. Αποτελεί ουσιαστικά µια συλλογή

από shapefiles σε ένα αρχείο της access, .mdb. H personal Geodatabase αποτελεί

πιο εξελιγµένη και µεταγενέστερη µορφή, της οποίας τα πλεονεκτήµατα µπορείτε να

αναζητήσετε στο site της ESRI www.esri.com. Η ArcSDE αποτελεί ενδιάµεση πλατ-

φόρµα για τη σύνδεση του Arcgis µε εξωτερικές βάσεις, όπως η Oracle, η SQL

Server κτλ.

Στη συνέχεια παρατίθεται ένας πίνακας µε τα υποστηριζόµενα από το λογισµικό δε-

δοµένα:
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ArcCatalog Windows ExplorerGeodatabases 

Personal Geodatabase  

File Geodatabase  

ArcSDE Geodatabase
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Πίνακας 2.1: File formats που υποστηρίζει το λογισµικό ArcGIS

2.4. Εφαρµογή ArcToolBox
2.4.1. Το περιβάλλον του ArcToolBox

Το ArcToolBox αποτελείται από µια ολοκλη-

ρωµένη συλλογή εργαλείων, τα οποία δια-

κρίνονται στις ακόλουθες κατηγορίες: 

Κάθε κατηγορία οργανώνεται σε υποσύνολα
εργαλείων µε βάση το είδος της λύσης του
παρέχουν. 

Το παράθυρο µε τις εργαλειοθήκες ενεργο-
ποιείται µε την επιλογή του εικονιδίου
µέσα από το περιβάλλον των εφαρµογών
ArcCatalog και ArcMap. 

ArcGIS for Server  (geocode services, globe serv-
ices, image services, map services)

Rasters (includes) :

>> ADRG Image (.img)
>> ArcSDE raster
>> DTED Level 0, 1, and 2 (.dt*)
>> Esri  Grid
>> Hierarchical Data Format (HDF)
>> LizardTech MrSID and MrSID Gen 3 (.sid)
>> National Imagery Transmission Format (NITF) (.ntf)
>> Tagged image file format (TIFF) (.tif)
>> Sun Raster

coverages

ArcIMS (features services, map services)

DGN, DWG, DXF

Geodatabases (Personal, file, ArcSDE)

OGC (WCS services, WMS services)

OLE DB table

PC ARC/INFO coverages

SDC

SDE layers DLG

Shapefiles (.shp) ETAK

Text files (.txt), Excel files (.xls) GIRAS

TIN IGDS

VPF IGES

ADS MIF

AGF MOSS

DFAD SDTS (point, raster, and vector)

DIME SLF TIGER (through v2002)



Το ArcToolBox προσφέρει ένα περιβάλλον, µέσα από το οποίο ο χρήστης µπορεί

να επιλέξει τις κατάλληλες παραµέτρους και επίπεδα πληροφορίας για την αποτελε-

σµατική διεκπεραίωση της κάθε διαδικασίας, διαχείρισης ή ανάλυσης των δεδοµένων.

Για κάθε περιβάλλον εργασίας παρέχεται βοήθεια, ενώ σε περίπτωση λανθασµένης

εισαγωγής επιπέδων ο χρήστης ενηµερώνεται για τη φύση του προβλήµατος και

για τους τρόπους επίλυσης.

Το παράθυρο της εφαρµογής προσαρµόζεται ανάλογα µε τις απαιτήσεις του χρήστη,

καθώς παρέχεται η δυνατότητα αλλαγής του µεγέθους, της θέσης και της έκτασης

που καταλαµβάνει στο παράθυρο του ArcMap και του ArcCatalog. Οποιαδήποτε αλ-

λαγή πραγµατοποιείται, αποθηκεύεται αυτόµατα από την εφαρµογή για µελλοντική

χρήση.

Κάποιες από τις βασικές κατηγορίες εργαλείων και λειτουργιών που επιτελούνται

παρουσιάζονται στη συνέχεια: 

Data management tools

Τα εργαλεία διαχείρισης δεδοµένων χρησιµεύουν

στη διαχείριση της τοπολογίας ενός επιπέδου (co-

verage, shapefile), των πινάκων περιγραφικών χα-

ρακτηριστικών, του προβολικού συστήµατος ενός

επιπέδου κ.ά.   

Analysis Tools

Πρόκειται για εργαλεία χωρικής ανάλυσης. Ο

χρήστης, µε τα εργαλεία που παρέχονται στη συγ-

κεκριµένη κατηγορία, µπορεί να εκτελέσει λειτουρ-

γίες επικάλυψης, να δηµιουργήσει ζώνες

επιρροής/αποκλεισµού, να υπολογίσει στατιστικά

στοιχεία, να συγχωνεύσει επίπεδα δεδοµένων κ.ά.
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Conversion Tools

Τα εργαλεία αυτά υποστηρίζουν τα γνωστότερα

formats δεδοµένων. Πρόκειται για εργαλεία που

βοηθούν στη µετατροπή αρχείων σε άλλες µορ-

φές, όπως kml, geodatabase, collada, coverage,

shapefile, raster και αντίστροφα. 

2.4.2. Παραδείγµατα χρήσης εργαλειοθηκών ArcToolBox

Στις επόµενες παραγράφους παρουσιάζονται δύο απλές διαδικασίες, οι οποίες υλο-
ποιούνται µέσω των εργαλειοθηκών που παρέχονται από το ArcToolBox.

2.4.2.1. ∆ιαδικασία µετατροπής µορφής επιπέδου (Coverage To Shapefile)

Η µετατροπή ενός αρχείου από µία µορφή σε άλλη αποτελεί µια απλή εργασία, η
οποία εκτελείται µε τη βοήθεια του ArcToolBox. Στη συγκεκριµένη περίπτωση εξετάζεται
η µετατροπή ενός αρχείου από µορφή Coverage σε Shapefile. 

Στο περιβάλλον του ArcMap ο χρήστης θα πρέπει αρχικά να ανοίξει το αρχείο
coverage µε την ονοµασία streams, το οποίο επιθυµεί να µετατρέψει σε αρχείο
Shapefile. Το αρχείο αυτό βρίσκεται στη
θέση {..\\DATA\BASIC\COVERAGES}

Στη συνέχεια χρειάζεται να ανοίξει την
εργαλειοθήκη ArcToolBox και να επιλέ-
ξει την εντολή “To Shapefile” µέσα από
την κατηγορία των Εργαλείων Μετατρο-
πής “Conversion Tools ”.

Η επιλογή της εντολής αυτής έχει
ως αποτέλεσµα το άνοιγµα ενός
παραθύρου, στο οποίο ο χρήστης
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καλείται αρχικά να επιλέξει το επίπεδο το οποίο επιθυµεί να µετατρέψει σε
Shapefile, δηλαδή το αρχείο streams arc, όπως εµφανίζεται στον “Πίνακα Πε-
ριεχοµένων”.
Επόµενο βήµα είναι η επιλογή του φακέλου στον οποίο θα αποθηκευθεί το
παραγόµενο θεµατικό αρ-
χείο Shapefile 

Με την επιλογή του εικονιδίου,
ανοίγει το παράθυρο της δι-
πλανής εικόνας, όπου ο χρή-
στης είναι σε θέση να επιλέξει
τη θέση που θα δηµιουργήσει
τον υποφάκελο µε όνοµα
“COVERAGE TO SHAPEFILE”,
στον οποίο θα αποθηκευθεί το
παραγόµενο αρχείο Shapefile. 

Μετά τη δηµιουργία του υποφακέλου “COVERAGE TO SHAPEFILE” στο φάκελο
RESULTS, ο χρήστης µπορεί µε την επιλογή “ΟΚ” να ολοκληρώσει τη διαδικασία
της µετατροπής του αρχείου. Το όνοµα του επιπέδου ορίζεται αυτόµατα από το σύ-
στηµα, λαµβάνοντας υπόψη το αρχικό όνοµα του αρχείου coverage. Στη συγκεκρι-
µένη περίπτωση το παραγόµενο επίπεδο ονοµάστηκε “streams arc”.

Στη συνέχεια µέσα από το περιβάλλον του ArcCatalog, ακολουθεί η αντιγραφή του
αρχείου στο φάκελο {...\\DATA\BASIC\SHAPEFILES} και η µετονοµασία του σε
STREAMS µε δεξί κλικ και επιλογή της εντολής “Rename”. Το αρχείο αυτό θα χρη-
σιµοποιηθεί µετέπειτα για τον ορισµό προβολικού συστήµατος συντεταγµένων µέσω
της κατάλληλης εργαλειοθήκης στο ArcToolbox. 

2.4.2.2. Ορισµός Συστήµατος Συντεταγµένων (Define Projection)

Για το παράδειγµα αυτό θα χρησιµοποιηθεί το θεµατικό επίπεδο STREAMS που βρί-
σκεται στη θέση {...\\DATA\BASIC\SHAPEFILES}, το οποίο προέκυψε από την προ-
ηγούµενη ενότητα (2.4.2.1). 

Η εισαγωγή του συστήµατος συντεταγµένων αποτελεί µια απλή διαδικασία, η οποία
µπορεί να επιτευχθεί τόσο από το περιβάλλον του ArcCatalog, όσο και από αυτό
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του ArcMap µε τη χρήση της εργαλει-
οθήκης “ArcToolbox > Data Manage-
ment Tools > Projections and
Transformations > Define Projections”.

Στο παράθυρο της διπλανής εικόνας
που εµφανίζεται, ο χρήστης καλείται να
επιλέξει το επίπεδο στο οποίο επιθυµεί

να ορίσει Προβολικό Σύστηµα. Στην περίπτωση αυτή πρόκειται για το επίπεδο STRE-
AMS. Έπειτα, ακολουθεί η επιλογή του εικονιδίου    , η οποία οδηγεί στο άνοιγµα
της καρτέλας ορισµού προβολικού συστήµατος (Εικόνα 2.7.). 

Στο νέο παράθυρο µε την ονοµασία “Spatial Reference Properties”, ο χρήστης
είναι σε θέση να επιλέξει το Σύστηµα Συντεταγµένων. ∆ίνεται η δυνατότητα χρήσης
χωρικού φίλτρου για τη διευκόλυνση της διαδικασίας αναζήτησης του επιθυµητού
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Εικόνα 2.7. : Παράθυρο για τον ορισµό του προβολικού συστήµατος συντεταγµένων.



κάθε φορά Συστήµατος Συντεταγµένων. Όπως φαίνεται στην Εικόνα 2.7 το χωρικό
φίλτρο     που έχει πλέον προστεθεί  δίνει τη δυνατότητα πληκτρολόγησης και
αναζήτησης του επιθυµητού Συστήµατος Συντεταγµένων, µε τη χρήση του εικονιδίου

. Η διακοπή της αναζήτησης γίνεται µε τη χρήση του εικονιδίου    .

Εκτός από το χωρικό φίλτρο για την αναζήτηση ενός υπάρχοντος Συστήµατος Συν-
τεταγµένων, παρέχεται η δυνατότητα προσθήκης ενός νέου συστήµατος µε τη χρήση
του εικονιδίου       (Add Coordinate System) αλλά και ο ορισµός κάποιων συ-
στηµάτων ως “Αγαπηµένα – Favorites” για άµεση και ευκολότερη χρήση µε τη
χρήση του εικονιδίου    . 

Στην περίπτωση που το επιθυµητό Σύστηµα Συντεταγµένων δεν είναι διαθέσιµο, ο
χρήστης είναι σε θέση είτε να το δηµιουργήσει ο ίδιος είτε να το εισάγει µε τη
χρήση της επιλογής “Import”. Αυτό είναι υποβοηθητικό στις περιπτώσεις που επιθυ-
µούµε να αποδώσουµε σε ένα θεµατικό επίπεδο το Σύστηµα Συντεταγµένων άλλων
θεµατικών επιπέδων που έχουµε ήδη στη διάθεσή µας. 

Για το σκοπό αυτό θα αξιοποιηθεί το επίπεδο LUAT από το φάκελο
{...\\DATA\BASIC\SHAPEFILES}, το οποίο ακολουθεί το Σύστηµα Συντεταγµένων
“Clarke_1866_UTM_Zone_18”. Με τον τρόπο αυτό το θεµατικό επίπεδο STREAMS
αποκτά το προβολικό σύστηµα του θεµατικού επιπέδου LUAT όπως φαίνεται στην ει-
κόνα 2.7.

Συγκεκριµένα, µε την επιλογή της εντολής “Import” µέσα από την καρτέλα “Spatial
Reference Properties > Add Coordinate System > Import” ανοίγει ένα νέο παράθυρο
µε την ονοµασία “Browse for Dataset or Coordinate Systems”. Μέσα από το πα-
ράθυρο αυτό ο χρήστης είναι σε θέση να επιλέξει το θεµατικό επίπεδο LUAT,  κά-
νοντας “ADD”,  βάσει του οποίου θεµατικό επίπεδο STREAM θα αποκτήσει το
επιθυµητό προβολικό σύστηµα. Αυτοµάτως, το σύστηµα συντεταγµένων του επιπέδου
LUAT προστέθηκε κάτω από τη λίστα Favorites όπως φαίνεται στην Εικόνα 2.7.

Στο πάνω µέρος της καρτέλας εµφανίζεται η λίστα µε τα Συστήµατα Συντεταγµένων
τα οποία προήλθαν ύστερα από την αναζήτηση µε τη χρήση του χωρικού φίλτρου.
Στο συγκεκριµένο παράδειγµα φαίνεται ότι υπάρχουν δώδεκα συστήµατα συντεταγ-
µένων που περιέχουν τη λέξη Clarke. Επίσης, στη λίστα Favorites έχει προστεθεί το
σύστηµα συντεταγµένων του θεµατικού επιπέδου LUAT. Ο χρήστης πληροφορείται
για τα χαρακτηριστικά του επιλεγµένου κάθε φορά Συστήµατος συντεταγµένων από
το κάτω περιθώριο της καρτέλας. Εδώ εµφανίζονται τα χαρακτηριστικά του συστή-
µατος “Clarke_1866_UTM_Zone_18”. Με την επιλογή “ΟΚ” ολοκληρώνεται η από-
δοση του συστήµατος συντεταγµένων από το θεµατικό επίπεδο LUAT στο θεµατικό
επίπεδο STREAMS.
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2.5. Εφαρµογή ArcGlobe

Το ArcGlobe είναι µία από τις δύο τρισδιάστατες εφαρµογές απεικόνισης, που επι-
τρέπει την οπτικοποίηση των δεδοµένων στη γήινη επιφάνεια.
Τα δεδοµένα τοποθετούνται στη σωστή γεωδαιτική τους θέση στην τρισδιάστατη επι-
φάνεια της Γης. Ο χρήστης µπορεί να εξερευνήσει τον κόσµο στο σύνολό του, να
ερευνήσει και να αναλύσει τα δεδοµένα που απεικονίζονται, εστιάζοντας ανάλογα
κάθε φορά.

Η εκκίνηση του ArcGlobe γίνεται µέσα από το µενού “Έναρξη > Όλα τα Προ-
γράµµατα > ArcGIS > ArcGlobe 10.1” του υπολογιστή και µε κλικ στο εικονίδιο

που βρίσκεται στην εργαλειοθήκη 3D Analyst.

Εικόνα 2.8.: Περιβάλλον ArcGlobe
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Συγκεκριµένα το ArcGlobe:

Υποστηρίζει την τρισδιάστατη ανάλυση των γεωγραφικών δεδοµένων
Επιτρέπει την οµαλή µετάβαση µεταξύ των τριών επιπέδων κλίµακας (global,
local, street-level)
Χρησιµοποιεί βασικά γεωγραφικά δεδοµένα

2.6. Εφαρογή ArcScene

Το ArcScene, ως βασικό τµήµα του ArcGIS, αποτελεί την εφαρµογή απεικόνισης
των γεωγραφικών δεδοµένων σε τρεις διαστάσεις. Η πληροφορία του υψοµέτρου
(Z Value), η οποία αποθηκεύεται στον πίνακα περιγραφικών χαρακτηριστικών κάθε
επιπέδου, είναι απαραίτητη για την απεικόνιση της τρίτης διάστασης.

Σηµειακά, γραµµικά και πολυγωνικά γεωγραφικά δεδοµένα αποδίδονται σε τρεις
διαστάσεις µε τη βοήθεια ενός Ψηφιακού Μοντέλου Εδάφους, το οποίο αποτελεί
τη βάση για την απεικόνισή τους.

Η εκκίνηση του ArcScene γίνεται µέσα από το µενού “Έναρξη > Όλα τα Προ-
γράµµατα > ArcGIS > ArcScene 10.1” του υπολογιστή και µε κλικ στο εικονίδιο

, που βρίσκεται στην εργαλειοθήκη 3D Analyst.

2.7. Επίλογος

Στο κεφάλαιο αυτό σταχυολογήθηκαν οι δυνατότητες των βασικών εφαρµογών του
λογισµικού ArcView.

Στο επόµενο κεφάλαιο αναπτύσσεται η διαδικασία της ψηφιοποίησης διανυσµατικών
δεδοµένων, µε το συγκεκριµένο λογισµικό.
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3.1. Εισαγωγή

Τα Γεωπληροφοριακά Συστήµατα αποτελούνται από τα ακόλουθα τµήµατα, όπως φαί-
νονται στο επόµενο σχήµα:

Η αρχιτεκτονική τους αναφέρεται πιο αναλυτικά στο υλικό (hardware), στο λογισµικό
(software), στο προσωπικό ή στους χρήστες (humanware), καθώς και στο οργανωτικό
τους σχήµα (orgware). 

Ο πραγµατικός κόσµος προσοµειώνεται για να καταχωρηθεί στο Σύστηµα. Τα γε-
ωγραφικά δεδοµένα µοντελοποιούνται µε δύο τρόπους ή διακρίνονται σε δύο µε-
γάλες κατηγορίες, τη διανυσµατική και την ψηφιδωτή. Τα διανυσµατικά δεδοµένα
ανήκουν σε µία από τις τρεις οµάδες: σηµεία, γραµµές ή πολύγωνα. 
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3 Εισαγωγή Γεωγραφικων
∆εδοµένων

Σχήµα 1: Γεωπληροφοριακό Σύστηµα



Τα διανυσµατικά δεδοµένα µε τη µορφή σηµείου αποτελούν την απλούστερη µέθοδο
αναπαράστασης. Χρησιµοποιούνται στις περιπτώσεις όπου τα αντικείµενα, τα οποία
προσδιορίζουν, δεν έχουν διάσταση στο χώρο. Τέτοιες περιπτώσεις είναι τα σηµεία
ενδιαφέροντος, οι οικισµοί κ.ά. Τα γραµµικά διανυσµατικά δεδοµένα χρησιµοποι-
ούνται στην περίπτωση απεικόνισης δικτύων. Κάθε γραµµή του δικτύου αποτελείται
από συνδέσµους (links), οι κορυφές των οποίων ονοµάζονται κόµβοι (nodes). Τέλος,
τα πολύγωνα αποτελούνται από µια σειρά κλειστών γραµµών, οι οποίες αποτελούν
και τα όρια του πολυγώνου. Η αντιστοίχιση ενός αντικειµένου σε σηµείο ή πολύγωνο
εξαρτάται από την κλίµακα.

Τα ψηφιδωτά δεδοµένα αποτελούνται απο φατνία ίσου µεγέθους, παραλληλόγραµµα
ή και ακανόνιστου σχήµατος. Χαρακτηριστικά παραδείγµατα ψηφιδωτών δεδοµένων
αποτελούν οι φωτογραφίες κάθε είδους, επίγειες ή αεροφωτογραφίες, αλλά και οι
δορυφορικές εικόνες. Κάθε σχέδιο που υπόκειται στη διαδικασία scanning, ανεξάρτητα
από το µέγεθος του scanner, παράγει ένα ψηφιακό ψηφιδωτό αρχείο. Στο βιβλίο
αυτό εξετάζονται ψηφιδωτά δεδοµένα µε φατνία τετράγωνου σχήµατος, ίσου µεγέ-
θους.

Ψηφιοποίηση ή πιο συγκεκριµένα διανυσµατοποίηση είναι η διαδικασία µετατροπής
επιπέδων ψηφιδωτής µορφής σε διανυσµατική µορφή. Πρόκειται γενικά για απλή
διαδικασία, η οποία περιλαµβάνει τα ακόλουθα βήµατα:

Αναγνώριση των οντοτήτων προς ψηφιοποίηση (σηµεία, γραµµές, πολύγωνα)
Γεωαναφορά των ψηφιδωτών αρχείων
∆ηµιουργία των αντίστοιχων επιπέδων 
Ψηφιοποίηση των γεωµετρικών και περιγραφικών χαρακτηριστικών των επιπέδων 

Στο κεφάλαιο αυτό ο χρήστης θα εξοικειωθεί µε τη διαδικασία της ψηφιοποίησης
µε τη βοήθεια ενός εκπαιδευτικού παραδείγµατος. Ο χρήστης πρέπει, αρχικά, να
δηµιουργήσει ένα νέο διανυσµατικό αρχείο, στο οποίο θα προσθέσει στη συνέχεια
τα απαραίτητα γεωµετρικά και περιγραφικά χαρακτηριστικά. 

3.2. Γεωαναφορά

Η γεωαναφορά είναι η διαδικασία µε την οποία ορίζεται η θέση µιας οντότητας
στο χώρο. Αποτελεί απαραίτητη προϋπόθεση για την απεικόνιση των δεδοµένων στη
σωστή θέση. Υπάρχουν δύο τρόποι µε τους οποίους ο χρήστης µπορεί να ορίσει
τη θέση των γεωγραφικών δεδοµένων στο χώρο.
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Α. Εισαγωγή συντεταγµένων Χ,Υ (Με χρήση της εντολής Georeferencing): Χρησιµο-
ποιείται στην περίπτωση που υπάρχουν σηµεία µε γνωστές συντεταγµένες (σηµεία
ελέγχου).

Β. Γεωαναφορά µε χρήση άλλου επιπέδου (Με χρήση της εντολής Spatial Adjustment):
Συναντάται στην περίπτωση που ο χρήστης έχει στη διάθεσή του ένα διανυσµατικό
επίπεδο µε γνωστές συντεταγµένες, σε κοινή περιοχή µε το θεµατικό επίπεδο που
θέλει να γεωαναφέρει. 

Στη συνέχεια θα εξεταστεί η γεωαναφορά ενός επιπέδου ψηφιδωτής µορφής, για
το οποίο είναι γνωστές οι συντεταγµένες τεσσάρων σηµείων. Το ψηφιδωτό αρχείο

LANDUSE, το οποίο βρίσκεται στο φάκελο {…\\DATA\BASIC\TIFF FILES}, προέκυψε

από τη σάρωση της Εικόνας 3.1, η οποία περιέχεται στο ευρετήριο του βιβλίου.

Εικόνα 3.1: Ψηφιδωτό αρχείο LANDUSE
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Τα γνωστά σηµεία και οι συντεταγ-
µένες τους δίνονται στο διπλανό
Πίνακα 3.1.

Για τη γεωαναφορά του ψηφιδωτού αρχείου θα πρέπει να ακολουθηθούν τα παρα-
κάτω βήµατα εργασιών στο περιβάλλον του ArcMap:

1ο Βήµα: Εισαγωγή σαρωµένου αρχείου στο περιβάλλον του ArcMap.

Αρχικά, ο χρήστης θα πρέπει να εισάγει στον ArcMap το αρχείο εικόνας LANDUSE,
για το οποίο είναι γνωστά τέσσερα σηµεία συντεταγµένων (1, 2, 3, 4). 

Κατά την εισαγωγή ενός αρχείου εικόνας εµφανίζεται ένα παράθυρο στο οποίο ο
χρήστης ερωτάται, αν επιθυµεί να δηµιουργήσει πυραµίδες για την εικόνα την οποία
εισάγει. Πρόκειται για τη δηµιουργία ενός συνόλου από διαφορετικές εκδόσεις των
ίδιων ουσιαστικά ψηφιδωτών δεδοµένων. Κάθε έκδοση διαφοροποιείται από το µέ-
γεθος των φατνίων που δηµιουργούνται. Σκοπός της δηµιουργίας πυραµίδων είναι
η αύξηση της ταχύτητας στην απεικόνιση των ψηφιδωτών επιπέδων κατά τη σµίκρυνση
ή µεγέθυνση της περιοχής ενδιαφέροντος. Μετά τη δηµιουργία πυραµίδων το αρχείο
της εικόνας συνοδεύεται από ένα δεύτερο αρχείο που έχει επέκταση .RRD (Reduced
Resolution Dataset), το οποίο και περιέχει τις σχετικές πληροφορίες.

2ο Βήµα: Γεωαναφορά σαρωµένου αρχείου µε την εισαγωγή σηµείων ελέγχου

Κατόπιν ο χρήστης θα πρέ-
πει να εµφανίσει την εργα-
λειοθήκη “Georeferencing”
(µε δεξί κλικ στην γκρι πε-
ριοχή δίπλα από τα εργα-
λεία), µε τη βοήθεια της
οποίας θα γίνει η γεωανα-
φορά του επιπέδου.
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Σηµεία Χ Υ
1 4024,895 5964,872

2 4040,805 4577,147

3 6141,984 4601,535

4 6125,677 5989,261

Πίνακας 3.1.: Συντεταγµένες σηµείων αγκίστρωσης



Από την εργαλειοθήκη αυτή µε την επιλογή “Fit to Display”, η εικόνα του επι-
πέδου προσαρµόζεται στα όρια του παραθύρου, διευκολύνοντας τη διαδικασία.
Ακολουθεί η εισαγωγή των σηµείων ελέγχου. Για την εισαγωγή των σηµείων
αυτών θα χρησιµοποιηθεί το εργαλείο “Add control points”    . Κάθε φορά
που εισάγονται οι συντεταγµένες ενός σηµείου ελέγχου, ο χρήστης θα πρέπει
να έχει εστιάσει στο σηµείο αυτό µε στόχο την ελαχιστοποίηση του σφάλµατος.  
Έχοντας λοιπόν εστιάσει στο επιθυµητό zoom στο πρώτο σηµείο ελέγχου µε
τη χρήση του εργαλείου “Add control points”     , εµφανίζεται ένα σταυρό-
νηµα. Με απλό κλικ στο κέντρο του σηµείου ο χρήστης πρέπει να επιλέξει τη
θέση στην οποία θα εισαχθούν οι συντεταγµένες του σηµείου αυτού.
Στη συνέχεια, και χωρίς να µετακινηθεί ο κέρσορας από το σηµείο αυτό, µε
δεξί κλικ εµφανίζεται η εντολή “Input X and Y”, όπως φαίνεται στην Εικόνα
3.2.

Η επιλογή της εντολής αυτής

έχει ως αποτέλεσµα την εµ-

φάνιση ενός παραθύρου, µε

τίτλο “Enter Coordinates”,
όπου είναι δυνατή η εισα-

γωγή των συντεταγµένων

για το πρώτο σηµείο.  
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ΠΡΟΣΟΧΗ!! Κάθε εργαλειοθήκη που απαιτείται για την εκπόνηση εργα-
σιών είναι διαθέσιµη στο χρήστη µε δεξί κλικ πάνω στην γκρι περιοχή
του περιβάλλοντος του ArcMap. Επιλέγοντας κάθε φορά την επιθυµητή
εργαλειοθήκη, αυτή επικολλάται στο παράθυρο του περιβάλλοντος.

Εικόνα 3.2: Εισαγωγή σηµείων ελέγχου



Η διαδικασία επαναλαµβάνεται τρεις ακόµα φορές, ώστε να εισαχθούν οι συντε-
ταγµένες και των τεσσάρων σηµείων ελέγχου.

Σε περίπτωση λάθους, ο χρήστης έχει στη διάθεσή του κάποια επιπλέον εργαλεία µέσα
από την εργαλειοθήκη “Georeferencing” όπως την εστίαση    , την εισαγωγή    , τη
διαγραφή     και την επιλογή     συγκεκριµένου σηµείου ελέγχου είτε µέσα από
τον πίνακα Link όπου παρέχονται τα σηµεία ελέγχου, είτε από την ίδια την εργαλειοθήκη. 

Με την επιλογή του εικονιδίου “View Link Table” ανοίγει ο παρακάτω πίνακας.
Εδώ δίνονται πληροφορίες για τις συντεταγµένες των σηµείων αγκίστρωσης, πριν
και µετά τη γεωαναφορά,
για το σφάλµα που προκύ-
πτει για κάθε σηµείο αλλά
και συνολικά για όλα τα
σηµεία µετά την ολοκλή-
ρωση της διαδικασίας.

Στόχος µας είναι το RMS
που θα προκύψει κατά τη γεωαναφορά, για κάθε σηµείο να είναι µικρότερο από
το 1/4 του χιλιοστού της κλίµακας.

Στη συγκεκριµένη περίπτωση το RMS κρίνεται ικανοποιητικό. 

Αν το σφάλµα κάποιου σηµείου ή το µέσο σφάλµα δεν είναι ικανοποιητικό, τότε
ο χρήστης επιβάλλεται να ψηφιοποιήσει µε µεγαλύτερη ακρίβεια κάποιο ή όλα τα
σηµεία ελέγχου. Τα εργαλεία του πίνακα δίνουν τη δυνατότητα στο χρήστη να αφαι-
ρέσει κάποιο σηµείο ελέγχου, επιλέγοντας τη συγκεκριµένη «εγγραφή» στον πίνακα
“Link” και πατώντας το εικονίδιο “Delete Link”  . 

Ο χρήστης έχει τη δυνατότητα να αποθηκεύσει τον πίνακα των συντεταγµένων σε
αρχείο .txt επιλέγοντας το εικονίδιο    “Save” από το παράθυρο “Link”.

3ο Bήµα: Εξαγωγή και αποθήκευση του γεωαναφερµένου αρχείου εικόνας

Από τη στιγµή που το µέσο σφάλµα είναι ικανοποιητικό, ακολουθεί η επιλογή της
εντολής “Update Georeferencing”. Η εντολή αυτή δηµιουργεί ένα αρχείο µε επέκταση
*.txt, το οποίο περιέχει πληροφορίες για το µετασχηµατισµό της εικόνας. Το αρχείο
αυτό πρέπει να συνοδεύει την εικόνα, για να είναι δυνατή η απεικόνισή της στο
νέο σύστηµα συντεταγµένων. Αν ο χρήστης επιθυµεί να αποθηκεύσει τις συντεταγ-
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µένες µόνιµα στο βασικό αρχείο της εικόνας, θα πρέπει να δηµιουργήσει µια νέα
εικόνα µε τη βοήθεια της εντολής “Rectify”.

Στη διπλανή εικόνα παρουσιάζεται το περιβάλλον της εντολής αυτής. Ο χρήστης

µπορεί να αποθηκεύσει την εικόνα που δηµιουργεί κάθε φορά σε µια από τις ακό-

λουθες µορφές: grid, tiff, bmp, ima-

gine image κ.ά. 

Επίσης, έχει τη δυνατότητα να αλ-

λάξει το µέγεθος του φατνίου της

εικόνας, κάνοντας επαναδειγµατολη-

ψία (Resampling), επιλέγοντας τον

αλγόριθµό της, τον τύπο και την

ποιότητα συµπίεσης, αλλά και το

φάκελο στον οποίο θα αποθηκευθεί

το παραγόµενο αρχείο εικόνας.

Το αρχείο εικόνας LANDUSE_GR, που προέκυψε από την παραπάνω διαδικασία της
γεωαναφοράς, έχει πλέον πραγµατικές συντεταγµένες. Το αρχείο αυτό  που είναι
αποθηκευµένο στο φάκελο {..\\DATA\RESULTS\ 1_GEOREFERENCING } θα ψηφιο-
ποιηθεί στο επόµενο υποκεφάλαιο.

3.3. Ψηφιοποίηση

Στην ενότητα αυτή παρουσιάζεται η διαδικασία της µετατροπής σε διανυσµατική
µορφή των πολυγώνων της εικόνας LANDUSE_GR, η οποία µετά τη διαδικασία της
γεωαναφοράς, που εξετάστηκε στην προηγούµενη ενότητα, έχει πλέον πραγµατικές
συντεταγµένες.

Το αποτέλεσµα της ψηφιοποίησης διαφέρει ανάλογα µε το είδος των οντοτήτων,
όπως φαίνεται στον Πίνακα 3.2 που ακολουθεί:

ΚΕΦΑΛΑΙΟ 3 ΕΙΣΑΓΩΓΗ ΓΕΩΓΡΑΦΙΚΩΝ ∆Ε∆ΟΜΕΝΩΝ 45

ΠΡΟΣΟΧΗ!! Για εκπαιδευτικούς λόγους στην εικόνα αυτή υπάρχουν ορι-
σµένα λάθη. Τα λάθη αυτά εξασφαλίζουν την κάλυψη της ύλης της διόρ-
θωσης λαθών κατά το στάδιο της τοπολογίας του επόµενου κεφαλαίου.



Πίνακας 3.2: Σχηµατική Απεικόνιση οντοτήτων κατά τη διαδικασία της ψηφιοποίησης

Τα βήµατα εργασιών που θα πρέπει να ακολουθηθούν για την ψηφιοποίηση της ει-
κόνας, η οποία περιέχει επιφάνειες µε διαφορετική χρήση γης, είναι τα παρακάτω:

1ο Βήµα: ∆ηµιουργία πολυγωνικού θεµατικού επιπέδου

Στο στάδιο αυτό ο χρή-
στης δηµιουργεί ένα πο-
λυγωνικό επίπεδο µε την
ονοµασία LANDUSE_DG.
Η ονοµασία αυτή παρα-
πέµπει αυτόµατα στο στά-
διο της ψηφιοποίησης
(Digitizing). Η διαδικασία
της δηµιουργίας ενός θε-
µατικού επιπέδου εκτελείται
µέσα από το περιβάλλον
του ArcCatalog. 

Για το λόγο αυτό ο χρή-
στης πρέπει να ενεργοποι-
ήσει τον ArcCatalog και
να επιλέξει / υλοποιήσει
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Οντότητα Ψηφιοποίηση
Πίνακας

περιγραφών
Σχηµατική
απεικόνιση

Σηµεία Σηµεία
ενδιαφέροντος:

Πλήθος σηµείων Κάθε σηµείο αποτελεί
εγγραφή του πίνακα

Γραµµές Οδικό δίκτυο: Κάθε τµήµα του οδικού
δικτύου αποτελείται από
ένα σύνολο σηµείων που
αποτυπώνουν µια γραµµή.

Κάθε τµήµα γραµµής
που αποτελείται από

πλήθος σηµείων, αποτελεί
εγγραφή του πίνακα.

Πολύγωνα Χρήσεις Γης: Κάθε επιφάνεια µε διαφορετική
χρήση γης αποτελείται από ένα
σύνολο σηµείων. Το αρχικό και
τελικό σηµείο κατά τη διαδικασία
της ψηφιοποίησης είναι κοινό.

Κάθε επιφάνεια
διαφορετικής χρήσης γης,

ως σύνολο σηµείων,
αποτελεί ξεχωριστή

εγγραφή στον πίνακα.

Εικόνα 3.3: ∆ηµιουργία θεµατικού επιπέδου στον ArcCatalog



το φάκελο, µέσα στον οποίο θα δηµιουργήσει το θεµατικό επίπεδο {…\\DATA\RE-
SULTS\2_DIGITIZING}.

Στη συνέχεια µε δεξί κλικ στο δεξί µέρος
του παραθύρου του περιβάλλοντος ArcCata-
log επιλέγεται η δηµιουργία του Shapefile

µε τις εντολές “New > Shapefile” στις
καρτέλες που εµφανίζονται. 

Η επιλογή της εντολής Shapefile από τη

λίστα εντολών έχει ως αποτέλεσµα το

άνοιγµα ενός νέου παραθύρου, στο οποίο

ο χρήστης καλείται να δηλώσει το όνοµα

και τον τύπο του επιπέδου. Στη συγκεκριµένη

περίπτωση πρόκειται για πολυγωνικό θεµα-

τικό επίπεδο, οπότε επιλέγεται το “Feature
Type” να είναι “Polygon”.

Ο ορισµός του προβολικού συστήµατος συντεταγµένων θα γίνει σε επόµενο υπο-

κεφάλαιο.

2ο Βήµα: Εισαγωγή των αρχείων LANDUSE_GR και LANDUSE_DG στο περιβάλλον
του ArcMap και ρύθµιση των παραµέτρων ψηφιοποίησης.

Στο σηµείο αυτό ο χρήστης εισάγει την εικόνα και το διανυσµατικό αρχείο στο πε-

ριβάλλον του ArcMap µε τη χρήση του εικονιδίου “Add Data” . Ακολουθεί

η ενεργοποίηση της εργαλειοθήκης “Editor” µε δεξί κλικ στην γκρι περιοχή, όπως

επισηµαίνεται και σε προηγούµενη παράγραφο. 

Τα δεδοµένα που θα ψηφιοποιηθούν θα πρέπει να χαρακτηρίζονται από σωστή το-

πολογική δοµή. Γι’ αυτό είναι σκόπιµο να οριστούν εξαρχής κάποιες παράµετροι.

Μέσα από την εργαλειοθήκη “Snapping  > Options” ορίζεται το “Tolerance” σε

pixels. Ουσιαστικά ορίζεται ότι, κατά την ψηφιοποίηση µιας οντότητας, αν ο κέρ-

ΚΕΦΑΛΑΙΟ 3 ΕΙΣΑΓΩΓΗ ΓΕΩΓΡΑΦΙΚΩΝ ∆Ε∆ΟΜΕΝΩΝ 47



σορας βρίσκεται σε απόσταση µικρότερη
από την τιµή του “Tolerance” από την πλη-
σιέστερη γειτονική οντότητα, τότε θα µετακι-
νείται αυτόµατα προς την οντότητα αυτή,
ώστε να µην δηµιουργούνται κενά.  Αρ-
χικά, είναι δυνατό να χρησιµοποιηθεί η προ-
καθορισµένη τιµή του “Tolerance”. 

Μέσω της εργαλειοθήκης “Snapping”
, ο χρήστης επιλέγει κάθε

φορά το είδος της οντότητας µε βάση την
οποία θα γίνει η σύµπτωση.

Point: ∆ιαδικασία σύµπτωσης µε σηµείο
End: ∆ιαδικασία σύµπτωσης µε υπάρχοντα κόµβο 
Vertex: ∆ιαδικασία σύµπτωσης µεταξύ κορυφών
Edge: ∆ιαδικασία σύµπτωσης µεταξύ πλευρών

Μέσα από τα “Options” της εργαλειοθήκης “Snapping” ο χρήστης είναι σε θέση
να επιλέξει το επίπεδο στο οποίο εφαρµόζεται η σύµπτωση οντοτήτων. Με την
εντολή “Snapping > Snap to Sketch” επιτυγχάνεται σύµπτωση των κόµβων του θε-
µατικού επιπέδου που ψηφιοποιείται.

3ο Βήµα: Ψηφιοποίηση θεµατικού επιπέδου LANDUSE_DG

Από τη στιγµή που έχουν οριστεί οι κατάλληλες παράµετροι για την ψηφιοποίηση,
ο χρήστης έχει τη δυνατότητα να ενεργοποιήσει τη διαδικασία από την εργαλειοθήκη
“Editor > Start Editing”. Η εργαλειοθήκη προσφέρει πλήθος από εργαλεία, τα οποία
επιτελούν βασικές αλλά και προχωρηµένες λειτουργίες. Κατά τη διαδικασία της ψη-
φιοποίησης πολλά από τα εργαλεία αυτά εµφανίζονται µε τη µορφή mini toolbars
σε µικρή απόσταση από
τον κέρσορα για ευκολό-
τερη πρόσβαση.

Για την εκκίνηση της δια-
δικασίας ψηφιοποίησης
θα πρέπει αρχικά να
ενεργοποιήσουµε το πα-
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Mini Εργαλειοθήκη Editor



ράθυρο “Create Features”. Αυτό είναι εφικτό
µέσα από την εργαλειοθήκη “Editor > Ed-
iting Windows“. Στο πάνω µέρος του πα-
ραθύρου που εµφανίζεται, θα πρέπει να
εισαχθεί το προς ψηφιοποίηση επίπεδο, το
οποίο έχει δηµιουργηθεί στον ArcCatalog.
Πρόκειται για το επίπεδο LANDUSE_DG.

Ο χρήστης έχει κάθε φορά τη δυνατότητα να επιλέγει τα επίπεδα, τα οποία είναι
σε θέση να επεξεργαστεί ή να ψηφιοποιήσει µε κριτήριο την τοπολογία τους κτλ.

Το δεύτερο εικονίδιο δίνει στο χρήστη τη δυνατότητα να δηµιουργήσει ένα νέο επί-
πεδο (Template), να αντιγράψει ένα ήδη υπάρχον, να διαγράψει, ακόµα και να επε-

ξεργαστεί τις ιδιότητές του µέσα από τα Properties.

Στο κάτω µέρος του παραθύρου ο χρήστης µπορεί
να επιλέξει µεταξύ διαφόρων “Construction Tools”
για τη διαδικασία της ψηφιοποίησης.

Στη νέα ανανεωµένη έκδοση ArcMap 10.1 παρέ-
χονται επιπλέον “Construction Tools” όπως το
“Auto Complete Freehand” εργαλείο για την ελεύ-
θερη σχεδίαση οντοτήτων. Παράλληλα, έχουν προ-
στεθεί επιπλέον δύο Tabs στο παράθυρο “Create
Features”. Το ένα επιτρέπει τη δηµιουργία οντοτήτων
- αντικειµένων (Create Features), ενώ το δεύτερο

µε την ονοµασία “Edit Sketch Properties” επιτρέπει την επεξεργασία των τιµών
“ X,Y ” για κάθε σηµείο του επιλεγµένου θεµατικού επιπέδου. 

Έχοντας, λοιπόν, επιλέξει το επίπεδο LANDUSE_DG (template) προς ψηφιοποίηση,
αυτοµάτως ο κέρσορας παίρνει το σχήµα σταυρού. Η ψηφιοποίηση είναι πλέον δυ-
νατό να αρχίσει, εισάγοντας κάθε φορά τα σηµεία τα οποία ορίζουν τα πολύγωνα
της εικόνας  (αρχείο LANDUSE_GR ). 

Στο παράδειγµα που ακολουθεί, παρουσιάζονται τρεις διαφορετικοί τρόποι ψηφιο-
ποίησης των διαφόρων πολυγώνων/επιφανειών που φαίνονται στην Εικόνα 3.1., αξιο-
ποιώντας κάθε φορά τη βέλτιστη διαδιακασία. 
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α) ∆ιαδικασία ψηφιοποίησης µε χρήση του εργαλείου “Polygon”

Η διαδικασία αυτή αποτελεί τον πιο απλό τρόπο ψηφιοποίησης πολυγώνων. Συγκε-
κριµένα, ο χρήστης θα πρέπει αρχικά να εξετάσει το αρχείο εικόνας και να επιλέξει
το πρώτο πολύγωνο προς ψηφιοποίηση. Στην περίπτωση αυτή ορίζεται ότι το πρώτο
πολύγωνο προς ψηφιοποίηση είναι το αυτό µε τον αριθµό 59. Ο χρήστης, µε το
εργαλείο “Polygon” από τα “Construction Tools”, είναι σε θέση να ψηφιοποιήσει
την επιφάνεια αυτή. 

H ψηφιοποίηση των
ορίων κάθε πολυγώνου
γίνεται µε τη χρήση του
ποντικιού και την εισα-
γωγή µε απλό κλικ των
σηµείων,  ώστε να απο-
τυπώνεται ακριβώς η γε-
ωµετρία της γραµµής.
Όσο πιο κυρτό είναι το
τµήµα του ορίου που ψη-
φιοποιείται τόσο περισσό-
τερα «κλικ» πρέπει να
γίνουν για την ακριβή
αποτύπωσή του. Κατά τη
διάρκεια της ψηφιοποίησης ο χρήστης έχει πλήρη πρόσβαση στα εργαλεία πλοήγη-
σης. Αυτό σηµαίνει ότι µπορεί να εστιάζει κατά περίπτωση στην περιοχή ενδιαφέ-
ροντος. Με παρατεταµένο κλικ στο κεντρικό πλήκτρο του ποντικιού ενεργοποιείται το
εργαλείο “Pan”, µε αποτέλεσµα να διευκολύνεται η εισαγωγή των σηµείων. Η εναλ-
λαγή από το εργαλείο “Pan” στη διαδικασία ψηφιοποίησης γίνεται µε επιλογή από
τα  “Construction Tools” του παραθύρου “Create Features”, του εκάστοτε εργαλείου
ψηφιοποίησης πχ. “Polygon”. Η λήξη της διαδικασίας ψηφιοποίησης επιτυγχάνεται
µε διπλό αριστερό κλικ. Στην περίπτωση ψηφιοποίησης πολυγωνικού επιπέδου το τε-
λικό σηµείο ψηφιοποίησης είναι κοινό µε το αρχικό. Το αποτέλεσµα της ψηφιοποί-
ησης φαίνεται στην Εικόνα 3.4.

β) ∆ιαδικασία ψηφιοποίησης µε χρήση του εργαλείου “Autocomplete Polygon”

Με το εργαλείο “Autocomplete Polygon” από τα “Construction tools” προσφέρεται

ΚΕΦΑΛΑΙΟ 3 ΕΙΣΑΓΩΓΗ ΓΕΩΓΡΑΦΙΚΩΝ ∆Ε∆ΟΜΕΝΩΝ50

Εικόνα 3.4: Ψηφιοποίηση πολυγώνου 59 (γαλάζιο χρώµα)



η δυνατότητα στο χρήστη  να ψηφιοποιήσει µια επιφάνεια, εκµεταλλευόµενος τα
κοινά όρια µε τα γειτονικά πολύγωνα.

Από την Εικόνα 3.4 γίνεται φανερό ότι το πολύγωνο 59, που ψηφιοποιήθηκε, έχει
κοινά όρια µε τα πολύγωνα 60, 64, 65, 66, 68 και 69.  

Σε αυτό το σηµείο εξετάζεται το πολύγωνο 66 που έχει κοινά όρια µε το πολύγωνο
59. Με το εργαλείο “Auto Complete Polygon”, ο χρήστης εκµεταλλεύεται τόσο τα
κοινά όρια µεταξύ των δύο πολυγώνων (59 και 68), όσο και το αποτέλεσµα της
διαδικασίας “Snapping”, εκτελώντας ταχύτερα τη διαδικασία της ψηφιοποίησης.

Αφού επιλέξει αρχικά το πολύγωνο (59)
του οποίου τα όρια είναι κοινά µε αυτά
του πολυγώνου (66), αρκεί η ενεργοποί-
ηση της εργαλειοθήκης “Snapping” και
η ψηφιοποίηση των υπόλοιπων σηµείων
από τα οποία αποτελείται το ζητούµενο
πολύγωνο (66)

Στη διπλανή εικόνα φαίνονται τα σηµεία
της ψηφιοποίησης του πολυγώνου αυτού. 

Το τελευταίο σηµείο που εισάγεται είναι
το σηµείο 7 µε τη βοήθεια του “Snap-
ping”. Σε αυτό το σηµείο ολοκληρώνεται
η ψηφιοποίηση µε διπλό κλικ. 

Αυτόµατα το πολύγωνο µε αριθµό 68
λαµβάνει επιπλέον τα κοινά όρια µε το
πολύγωνο 59. Επίσης, το πολύγωνο 69
που είναι µεταξύ των δύο αυτών πολυ-
γώνων, δηµιουργήθηκε αυτόµατα κατά
την ολοκλήρωση της ψηφιοποίησης του
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πολυγώνου 68 µε τη χρήση του εργαλείου “Auto Complete Polygon”.

Η ίδια διαδικασία θα ακολουθηθεί αφενός για την ψηφιοποίηση και των υπόλοιπων

πολυγώνων, τα οποία έχουν κοινά όρια µεταξύ τους, και αφετέρου για τα πολύγωνα

που έχουν κοινά όρια τόσο µε το πολύγωνο 59, όσο και µε το πολύγωνο 68.

γ) ∆ιαδικασία ψηφιοποίησης µε χρήση του εργαλείου “Cut Polygon”

Το εργαλείο αυτό χρησιµοποιείται στις περιπτώσεις όπου ένα πολύγωνο είναι εσω-
τερικό άλλου πολυγώνου.

Από την Εικόνα 3.4 γίνεται φανερό ότι, το πολύγωνο 59 που ψηφιοποιήθηκε, εµπε-
ριέχει επτά άλλα πολύγωνα (70, 71, 72, 73, 74, 75, 76) καλύπτοντάς τα, ενώ έχει
κοινά όρια µε τα πολύγωνα 60, 64, 65, 66, 68 και 69.  Στην περίπτωση των πο-
λυγώνων που εµπεριέχονται / καλύπτονται από το πολύγωνο µε αριθµό 59 προτεί-
νεται η χρήση της εντολής “Cut Polygon”.

Σε αυτό το σηµείο θα εξεταστεί το παράδειγµα της ψηφιοποίησης του πολυγώνου
µε αριθµό 70. Για την ψηφιοποίησή του ο χρήστης θα πρέπει να ακολουθήσει τα
παρακάτω βήµατα εργασιών:

Επιλογή του πολυγώνου µε “ID = 59” το οποίο εµπεριέχει το πολύγωνο µε
“ID = 70 µε τη βοήθεια του εργαλείου “Select Features By Rectangle”      .
Άνοιγµα της εργαλειοθήκης “Effects” και καθορισµός του επιπέδου
LANDUSE_DG µε κάποια διαφάνεια (transparency). Με τον τρόπο αυτό ο χρή-
στης θα είναι σε θέση να βλέπει από το αρχείο εικόνας LANDUSE_GR τα
όρια των πολυγώνων κατά την ψηφιοποίηση
Επιλογή του εργαλείου “Cut Polygon” από την εργαλειοθήκη “Editor” και

έναρξη της ψηφιοποίησης του πολυγώνου µε αριθµό 70.

Ολοκλήρωση της διαδικασίας ψηφιοποίησης µε διπλό κλικ.
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ΠΡΟΣΟΧΗ!!! Κάθε γραµµή ψηφιοποιείται µία και µόνο φορά. Για οποι-
οδήποτε πολύγωνο έχει κοινά όρια µε κάποιο γειτονικό ακολουθείται η
παραπάνω διαδικασία µε τη χρήση του εργαλείου “Auto Complete
Polygon”.



Οι κόµβοι για την ψηφιοποίηση του πολυγώνου µε αριθµό 70 φαίνονται στην
Εικόνα 3.5. Το αποτέλεσµα της ψηφιοποίησης είναι η δηµιουργία µιας επιπλέον εγ-
γραφής στον πίνακα περιγραφικών χαρακτηριστικών. Η παραπάνω διαδικασία επα-
ναλαµβάνεται και για την ψηφιοποίηση των πολυγώνων 71, 72, 73, 74, 75, 76.

Εικόνα 3.5: Ψηφιοποίηση πολυγώνου 70 µε χρήση του εργαλείου Cut Polygon.

Ακολουθώντας την ίδια
διαδικασία και για τα
υπόλοιπα πολύγωνα που
εµπεριέχονται στο πολύ-
γωνο 59, το αποτέλεσµα
είναι αυτό της Εικόνας
3.6. 
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Εικόνα 3.6: Αρχείο
LANDUSE_DG µετά την ολο-

κλήρωση της διαδικασίας
ψηφιοποίησης



3.4. Εισαγωγή περιγραφικής πληροφορίας

Η εισαγωγή των περιγραφικών χαρακτηριστικών ακολουθεί τη διαδικασία της ψη-
φιοποίησης. Στην περίπτωση του επιπέδου LANDUSE_DG θα καταχωρηθεί ο αριθµός
κάθε πολυγώνου στο πεδίο ID.  Για την καταχώρηση της πληροφορίας αυτής ο χρή-
στης πρέπει να ακολουθήσει τα παρακάτω βήµατα εργασιών:

Άνοιγµα του Πίνακα Περιγραφικών Χαρακτηριστικών του επιπέδου LANDUSE_DG
µε δεξί κλικ στο επίπεδο και επιλογή της εντολής “Open Attribute table”
από τη λίστα που εµφανίζεται. Ο πίνακας περιέχει τρεις στήλες (FID, Shape,
Id).
Ενεργοποίηση της διαδικασίας Editing µέσα από την εργαλειοθήκη “Editor >
Start Editing”.
Επιλογή κάθε εγγραφής του πίνακα και καταχώρηση της πληροφορίας στο
πεδίο ID µε πληκτρολόγηση. 

Η επιλογή µιας εγγραφής στον πίνακα οδηγεί στον ταυτόχρονο χρωµατισµό µε γα-
λάζιο χρώµα, τόσο της εγγραφής στον πίνακα, όσο
και του πολυγώνου στο οποίο αντιστοιχεί η εγγραφή
αυτή. Με τον τρόπο αυτό διευκολύνεται η διαδικασία
καταχώρησης της πληροφορίας.

Στη συνέχεια παρουσιάζονται οι δύο τρόποι µε τους
οποίους είναι δυνατή η επιλογή ενός πολυγώνου: 

Ο συνήθης τρόπος είναι µε τη χρήση του εργαλείου
“Select Features”     . Με απλό κλικ σε ένα πο-
λύγωνο, αυτοµάτως επιλέγεται και στον πίνακα, κά-
νοντας δυνατή την αναγνώρισή του. Ο χρήστης
είναι σε θέση να εισάγει την πληροφορία την οποία
αντλεί από το αρχείο της εικόνας.  

Εναλλακτικό τρόπο αποτελεί η επιλογή µιας οποιασ-
δήποτε εγγραφής στον πίνακα, η αντίστοιχη επιλογή
του πολυγώνου και η αναγνώριση της θέσης του
στον χώρο. 

Το αποτέλεσµα της εισαγωγής των διαφόρων τιµών
για κάθε πολύγωνο φαίνεται στον διπλανό πίνακα.
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3.5. Εµφάνιση Ετικετών / Labels

Πολλές φορές είναι αναγκαίο η πληροφορία που είναι αποθηκευµένη στον πίνακα
ενός θεµατικού επιπέδου να εµφανίζεται στον χάρτη. Αυτό είναι εφικτό µέσα από
τις “Ιδιότητες/ Properties” του θεµατικού επιπέδου. 

Έχοντας πια εισάγει την πληροφορία του κωδικού για κάθε πολύγωνο του θεµατικού

επιπέδου LANDUSE_DG στο πεδίο ΙD του πίνακα, ο χρήστης είναι σε θέση να εµ-
φανίσει την πληροφορία αυτή ταυτόχρονα µε τη γεωµετρία του επιπέδου, όπως φαίνεται
στην εικόνα που ακολουθεί. Επίσης, έχει τη δυνατότητα να χρησιµοποιήσει διαφορετικό
χρώµα για την απεικόνιση ενός πολυγώνου µε βάση την τιµή ενός πεδίου. Περισσό-
τερες λεπτοµέρειες για την εµφάνιση ετικετών παρατίθενται στο όγδοο κεφάλαιο. 
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ΠΡΟΣΟΧΗ!! Για να είναι δυνατή η καταχώρηση πληροφορίας στον Πίνακα
περιγραφικών χαρακτηριστικών ενός επιπέδου, ο χρήστης θα πρέπει να είναι
σε κατάσταση Editing µέσα από την εργαλειοθήκη “Editor > Start Editing”.

Εικόνα 3.7: Παράθυρο ιδιοτήτων επιπέδου LANDUSE_DG.shp



Αυτό είναι δυνατόν, ύστερα από την αναγνώριση του θεµατικού επιπέδου από τον “Πί-
νακα Περιεχοµένων / Table Of Contents” και το άνοιγµα µε δεξί κλικ στο επίπεδο
των “Ιδιοτήτων/ Layer Properties” του επιπέδου αυτού. Στο σχετικό παράθυρο ο χρή-
στης θα πρέπει να ακολουθήσει τα βήµατα που παρουσιάζονται στην Εικόνα 3.7.

Τα βήµατα αυτά είναι τα εξής: 
Επιλογή της καρτέλας “Labels”.
Επιλογή της εντολής “Label Features in this layer”.
Επιλογή της πρώτης µεθόδου απεικόνισης των ετικετών-labels (Label all the fe-
atures the same way).
Επιλογή του πεδίου “Label Field”, του οποίου η πληροφορία θα χρησιµοποιηθεί
ως ετικέτα στο επίπεδο. Στη συγκεκριµένη περίπτωση πρόκειται για το πεδίο
“ΙD”.
Επιλογή του είδους και του µεγέθους γραµµατοσειράς. 
Επιλογή της θέσης εµφάνισης της ετικέτας. 
Μέσα από την ετικέτα  “Symbol” ο χρήστης είναι σε θέση να τροποποιήσει
τον τρόπο εµφάνισης της ετικέτας, έχοντας στη διάθεσή του πλήθος εργαλείων,
και να αποθηκεύσει τον τρόπο εµφάνισης της ετικέτας για µελλοντική χρήση.

Εικόνα 3.8: Επίπεδο LANDUSE_DG µε την πληροφορία “ID”

Με την επιλογή ΟΚ οι αλλαγές αποθηκεύονται και το αποτέλεσµα είναι αυτό της
Εικόνας 3.8.
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3.6. Ορισµός Συστήµατος Συντεταγµένων (Define Projection)

Το θεµατικό επίπεδο LANDUSE_DG που προέκυψε από τη διαδικασία της ψηφιο-

ποίησης, αν και έχει συντεταγµένες, δεν εµφανίζονται στην καρτέλα “Properties >
General”. 

Μέσα από το περιβάλλον του ArcCatalog µε δεξί κλικ στο επίπεδο LANDUSE_DG
και επιλογή της εµφάνισής των “Properties” του επιπέδου αυτού, µέσα από την

καρτέλα “XY Coordinate System”, ο χρήστης είναι σε θέση να επιλέξει το Σύστηµα
Συντεταγµένων. Αυτό είναι εφικτό µε τη χρήση του χωρικού φίλτρου µε πληκτρο-
λόγηση και αναζήτηση
του επιθυµητού Συστή-
µατος Συντεταγµένων,
µε τη χρήση του ει-
κονιδίου    . Στην
περίπτωση που το επι-
θυµητό Σύστηµα Συν-
τεταγµένων πρόκειται
να χρησιµοποιηθεί
µελλοντικά, µε την
επιλογή του εικονιδίου

προστίθεται στη
λίστα «Αγαπηµένων -
Favorites» του παρα-
θύρου, όπως φαίνεται
στην Εικόνα 3.9 που
ακολουθεί. 

Επιπρόσθετα, ο χρή-
στης µπορεί να εισά-
γει το Σύστηµα
Συντεταγµένων ενός
άλλου υπάρχοντος θε-
µατικού επιπέδου µε τη χρήση της επιλογής “Import” µε τη χρήση του εικονιδίου

. Αυτό είναι υποβοηθητικό στις περιπτώσεις που επιθυµούµε να αποδώσουµε
σε ένα θεµατικό επίπεδο το Σύστηµα Συντεταγµένων άλλων θεµατικών επιπέδων
που έχουµε ήδη στη διάθεσή µας. 
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Εικόνα 3.9 : Παράθυρο για τον ορισµό του προβολικού συστήµα-
τος συντεταγµένων.



Για το σκοπό αυτό θα αξιοποιηθεί το επίπεδο LUAT από το φάκελο

{...\\DATA\BASIC\SHAPEFILES}, το οποίο ακολουθεί το Σύστηµα Συντεταγµένων
“Clarke_1866_UTM_Zone_18”. 

Στην Εικόνα 3.9, εµφανίζεται το παράθυρο µε τα βήµατα εργασιών που πρέπει να
ακολουθήσει ο χρήστης για την αξιοποίηση του Συστήµατος Συντεταγµένων του θε-
µατικού επιπέδου LUAT.

Επιλογή της καρτέλας “XY Coordinate System” και κατόπιν επιλογή του εικο-

νιδίου “Add Coordinate System”  .

Επιλογή της εντολής“Import”. Με την ενεργοποίηση της εντολής αυτής ανοίγει

ένα νέο παράθυρο µε την ονοµασία “Browse for Datasets or Coordinate Sys-
tems”. Αναζήτηση του επιπέδου “LUAT” το οποίο θα αξιοποιηθεί για τον καθο-
ρισµό του συστήµατος συντεταγµένων.
Με την επιλογή της εντολής ”Add” η διαδικασία επιλογής του θεµατικού επι-
πέδου ολοκληρώνεται.
Ολοκλήρωση της διαδικασίας µε την επιλογή ΟΚ.

Με την ολοκλήρωση της διαδικασίας “Import”, το θεµατικό επίπεδο LANDUSE_DG
έχει αποκτήσει πλέον το επιθυµητό Σύστηµα Συντεταγµένων
“Clarke_1866_UTM_Zone_18”.

O ορισµός του συστήµατος συντεταγµένων αποτελεί µια απλή διαδικασία, η οποία
µπορεί να γίνει τόσο από το περιβάλλον του ArcCatalog, όσο και από αυτό του
ArcMap. Στην ενότητα 2.4.2.2. εξετάστηκε ο προσδιορισµός του Συστήµατος Συντε-
ταγµένων για ένα θεµατικό επίπεδο µε χρήση της εργαλειοθήκης “ArcToolbox”
µέσα από την εφαρµογή ArcCatalog. Αυτό είναι εφικτό και από το περιβάλλον του
ArcMap.

3.7. Επίλογος

Στο κεφάλαιο αυτό παρουσιάστηκε η διαδικασία ψηφιοποίησης γεωµετρικών και πε-
ριγραφικών χαρακτηριστικών ενός επιπέδου, ενώ στο επόµενο αναλύεται συνοπτικά
η διαδικασία διόρθωσης πιθανών λαθών, τοπολογικών ή µη. 
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4.1. Εισαγωγή

Η διόρθωση των πιθανών λαθών και η δόµηση της τοπολογίας αποτελεί το επόµενο
στάδιο µετά την ψηφιοποίηση. Η τοπολογικά ορθή γεωγραφική βάση δεδοµένων
είναι απαραίτητη για την εξαγωγή αξιόπιστων συµπερασµάτων κατά τη φάση της
Ανάλυσης. 

Για τη δόµηση της τοπολογίας πρέπει να ακολουθηθούν κάποια βασικά στάδια:

∆ηµιουργία Γεωβάσης (New Personal Geodatabase)
∆ηµιουργία Feature Dataset στη Γεωβάση 
Εισαγωγή πολυγωνικού
επιπέδου ως Feature Class
στο Feature Dataset
∆όµηση της τοπολογίας
µε χρήση συγκεκριµένων
τοπολογικών κανόνων

Η δόµηση και ο έλεγχος της το-
πολογίας βασίζεται σε συγκεκρι-
µένους κανόνες. Στην περίπτωση
πολυγωνικών χαρακτηριστικών οι
κανόνες αυτοί φαίνονται στον
παρακάτω πίνακα:
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4 ∆ιόρθωση Λαθών
και Τοπολογία

Τοπολογικοί κανόνες Πολυγώνων Παράδειγµα

Να µην υπάρχει επικάλυψη µεταξύ πολυγώνων

Να µην υπάρχουν κενά µεταξύ πολυγώνων

Να µην περιέχεται ένα πολύγωνο σε ένα άλλο

Να µην καλύπτει το ένα πολύγωνο το άλλο

Πίνακας 4.1: Παραδείγµατα τοπολογικών κανόνων για
πολύγωνα



4.2. ∆όµηση τοπολογίας (LANDUSE_DG)

Στην ενότητα αυτή θα εξεταστούν αναλυτικά τα βήµατα που απαιτούνται για τη δη-
µιουργία Γεωβάσης και τη δόµηση της τοπολογίας µέσα από το περιβάλλον του
ArcCatalog. 

Τα βήµατα αυτά είναι τα ακόλουθα:

Άνοιγµα περιβάλλοντος ArcCatalog
∆ηµιουργία ενός φακέλου, ο οποίος θα περιέχει όλα τα αρχεία που θα προ-
κύψουν από τη δόµηση της τοπολογίας. Ο φάκελος αυτός βρίσκεται στο ακό-
λουθο «µονοπάτι» {...\\DATA\RESULTS\3_TOPOLOGY_BEFORE_VALIDATION}
∆ηµιουργία Γεωβάσης µε δεξί κλικ στο φάκελο αυτό και επιλογή της εντολής

“New > Personal Geodatabase”
Ακολουθεί η δηµιουργία Feature Dataset στη Γεωβάση. Με δεξί κλικ στο αρχείο
“Personal Geodatabase” και επιλογή της εντολής “New > Feature Dataset”,
ανοίγει ένα παράθυρο στο οποίο θα πρέπει αρχικά να οριστεί η ονοµασία
του Feature Dataset και στη συνέχεια  να οριστεί προαιρετικά το σύστηµα συν-
τεταγµένων είτε κάνοντας “Import” µέσω της επιλογής “Αdd Coordinate Sys-
tem” , είτε επιλέγοντάς το από τους φακέλους, είτε αναζητώντας το
µε τη χρήση του διαθέσιµου φίλτρου. 
Τέλος, ορίζεται η τιµή “Tolerance” ίση µε 0,001 για κάθε διάσταση. Με την

επιλογή  “Finish” δηµιουργείται ένα κενό Feature Dataset
Στο σηµείο αυτό ο χρήστης θα πρέπει να εισάγει το θεµατικό επίπεδο για το
οποίο επιθυµεί να εκτελέσει τη διαδικασία της δόµησης της τοπολογίας. Αυτό
είναι εφικτό µε δεξί κλικ στο “Feature Dataset” και επιλογή της εντολής

“Import > Feature Class (Single)”
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ΠΡΟΣΟΧΗ!! Οι παραπάνω εργασίες εκτελούνται µέσα από το περιβάλλον
του ArcCatalog.



Με την επιλογή αυτή ανοίγει το πα-
ράθυρο της διπλανής εικόνας όπου
ο χρήστης καλείται:

Να εισάγει το θεµατικό επίπεδο
LANDUSE_DG, το οποίο προ-
έκυψε από το προηγούµενο κε-
φάλαιο.
Να ορίσει τη θέση στην οποία θα αποθηκευθεί το παραγόµενο “Feature Class”:
{…\\DATA\RESULTS\3_TOPOLOGY\NewPersonalGeodatabase.mdb\TOPOLOGY
_BEFORE_VALIDATION}
Να ορίσει την ονοµασία του (LANDUSE_TP)

Με την επιλογή “ΟΚ” η εισαγωγή του
επιπέδου στο Feature Dataset της Perso-
nal Geodatabase ολοκληρώνεται.

Ακολουθεί η δόµηση της τοπολογίας.

Με δεξί κλικ στο Feature Dataset
που δηµιουργήθηκε (TOPOLOGY)
και επιλογή της εντολής “New>To-
pology”, ανοίγει το παράθυρο της
διπλανής εικόνας: Στο παράθυρο
αυτό, και ακολουθώντας τα βήµατα,
ο χρήστης καλείται να δώσει ένα όνοµα για την Τοπολογία
(TOPOLOGY_OF_LANDUSE_DG), καθώς επίσης και να ορίσει την τιµή του
“Cluster Tolerance” (0,1).
Στη συνέχεια καλείται να επιλέξει το επίπεδο στο οποίο θα εφαρµόσει τους
τοπολογικούς κανόνες για τη δόµηση της τοπολογίας (Επίπεδο LANDUSE_TP)
Ακολουθεί η εισαγωγή µιας τιµής µεταξύ του 1 και του 50. Όσο µεγαλύτερη
είναι η τιµή, τόσο µικρότερη είναι η µετακίνηση των χαρακτηριστικών. Η µε-
γαλύτερη τιµή είναι η µονάδα. Στη συγκεκριµένη περίπτωση θα χρησιµοποιηθεί
η τιµή “Rank = 30”.
Στο τελικό στάδιο επιλέγονται οι κανόνες για τη δόµηση της τοπολογίας. Στη
συγκεκριµένη περίπτωση ελήφθησαν υπόψη δύο κανόνες, οι οποίοι παρουσιά-
ζονται στη συνέχεια:
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1ος κανόνας:
∆εν θα πρέπει να υπάρχει επικαλυπτόµενο

τµήµα µεταξύ πολυγώνων του ίδιου

επιπέδου.

2ος κανόνας:
∆εν θα πρέπει να δηµιουργούνται κενά

µεταξύ των πολυγώνων ενός επιπέδου.

Τα αποτελέσµατα της δόµησης της τοπολογίας {...\\DATA\ RESULTS\3_TOPOLOGY
_BEFORE_VALIDATION\New Personal Geodatabase\TOPOLOGY \...}, τα οποία
παρουσιάζονται στην Εικόνα 4.1., είναι δύο επίπεδα όπου το µεν πρώτο (TOPOLOGY
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Εικόνα 4.1: Λάθη κατά τη δόµηση της Τοπολογίας



_OF_LANDUSE_DG) περιέχει όλα τα σφάλµατα, ενώ το δεύτερο (LANDUSE_TP)
αποτελεί το επίπεδο, του οποίου τα λάθη ο χρήστης είναι σε θέση να διορθώσει

µε τη χρήση των κατάλληλων εργαλείων της εργαλειοθήκης “Topology”, όπως εξε-
τάζεται στην επόµενη ενότητα.

Έχοντας ακολουθήσει τα βή-
µατα τα οποία απαιτούνται
για τη δόµηση της τοπολο-
γίας ενός επιπέδου, προ-
έκυψε η ακόλουθη Γεωβάση:

4.3. ∆ιόρθωση τοπολογικών λαθών

Για τη διορθωση των τοπολογικων λαθών προς διευκόλυνση του χρήστη θα γίνει η
αντιγραφή και µετονοµασία του φακέλου {...\\DATA\RESULTS\3_ TOPOLOGY_
BEFORE_VALIDATION\} σε {...\\DATA\RESULTS\3_TOPOLOGY_AFTER_VALIDA-
TION\} µέσα στο περιβάλλον του ArcCatalog, έτσι ώστε ο χρήστης να είναι σε
θέση να διακρίνει τις αλλαγές στο επίπεδο LANDUSE_TP. Στη συνέχεια εξετάζονται

οι δύο τοπολογικοί κανόνες οι οποίοι έχουν τεθεί.

4.3.1. Τοπολογικός Κανόνας: Must Not Overlap

Στην περίπτωση των πολυγώνων µε κωδικό 74 και 75 υπάρχει λάθος, το οποίο
οφείλεται στη µη πλήρωση του πρώτου τοπολογικού κανόνα: «∆εν θα πρέπει να
υπάρχει επικάλυψη µεταξύ πολυγώνων του ίδιου επιπέδου». 

Εργαλειοθήκη TOPOLOGY
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Γεωβάση
Feature Dataset
Feature Class
Topology
}

ΠΡΟΣΟΧΗ!! Για την ενεργοποίηση της εργαλειοθήκης “Topology” απαι-
τείται η εκκίνηση της διαδικασίας editing για το επίπεδο της τοπολογίας
µέσα από την εργαλειοθήκη “Editor > Start Editing”. Η εργαλειοθήκη

“Topology” εµφανίζεται µε δεξί κλικ στη γκρι περιοχή του παραθύρου

του προγράµµατος.



Ο χρήστης πρέπει να επιλέξει µεταξύ δύο µεθόδων, για να τον βοηθήσουν να
διορθώσει τα λάθη που εµφανίστηκαν κατά τη δόµηση της τοπολογίας. 

Η πρώτη µέθοδος, που µπορεί να ακολουθήσει ο χρήστης, περιλαµβάνει τη διόρ-
θωση των λαθών µε χρήση της εργαλειοθήκης “Topology”.

Τα βήµατα εργασιών που καλείται να ακολουθήσει ο χρήστης στην περίπτωση αυτή,
είναι τα ακόλουθα:

Ενεργοποίηση της εντολής
“Editor > Start Editing”.
Με την επιλογή αυτή ενερ-
γοποιείται η εργαλειοθήκη
“Topology” µε την οποία
θα διορθωθούν τα τοπολο-
γικά λάθη.
Επιλογή του επιπέδου της
Τοπολογίας (Topology)
στην εργαλειοθήκη “Topo-
logy”. Αυτό είναι εφικτό µε
την επιλογή του εικονιδίου
“Select Topology” και
την επιλογή της εκάστοτε
γεωβάσης από το οµώνυµο παράθυρο που εµφανίζεται.
Αναζήτηση των τοπολογικών λαθών του κανόνα που εξετάζεται. Για το σκοπό
αυτό, µε τη χρήση του εργαλείου   ο χρήστης µπορεί να επιλέξει µια
οντότητα στην οποία αναγνωρίζεται ένα λάθος και κατόπιν να ανοίξει τον πί-
νακα µέσω του εργαλείου “Error Inspector” . Με το άνοιγµα του πίνακα
ο χρήστης θα αντλήσει απαραίτητες πληροφορίες, όπως φαίνονται στην παρα-
κάτω εικόνα..
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Συγκεκριµένα, µέσω του πίνακα αντλούνται πληροφορίες για τον κανόνα ο οποίος
παραβιάστηκε, για το επίπεδο στο οποίο παρουσιάζεται το λάθος και για τον κωδικό
των πολυγώνων στα οποία εντοπίζεται το λάθος.

Ακολουθεί η επιλογή του τµήµατος, το οποίο εµφανίζεται να καλύπτει το γει-
τονικό πολύγωνο. Αυτό επιτυγχάνεται µε τη χρήση του εργαλείου. “Topology
Edit Tool”    . Ύστερα από την επιλογή του τµήµατος αυτού ενεργοποιούνται

και τα υπόλοιπα εργαλεία. Με το εργαλείο “Modify Edge” ο χρήστης
είναι σε θέση να µεταβάλει τα όρια του πολυγώνου και να τα ταυτίσει µε τα
πραγµατικά, έτσι ώστε να εξαλείψει το τοπολογικό λάθος της επικάλυψης.
Το τελευταίο στάδιο απαιτεί την επικύρωση των παραπάνω σταδίων της διόρθωσης
µε τη χρήση του εργαλείου “Validate Topology In Specified Area” .

Η δεύτερη µέθοδος αφορά στην επεξεργασία του πίνακα “Error Inspector” για
τη διόρθωση των τοπολογικών λαθών. 

Τα βήµατα εργασιών είναι τα εξής:

Άνοιγµα του πίνακα “Error Inspector”    .
Επιλογή του κανόνα από τη λίστα “Show” για την αναγνώριση συγκεκριµένων
τοπολογικών λαθών.
Αναζήτηση (Search Now) των επιπέδων και συγκεκριµένα των χαρακτηριστικών
τους στα οποία εµφανίζονται τα τοπολογικά λάθη. Κατά την αναζήτηση του κα-
νόνα “Must not Overlap” το αποτέλεσµα ήταν η εµφάνιση ενός τοπολογικού
λάθους µεταξύ των χαρακτηριστικών 18 και 19 του επιπέδου LANDUSE_TP. Η
επιλογή του κανόνα από τη λίστα έχει ως αποτέλεσµα το χρωµατισµό της µε
απόχρωση του µπλε, ενώ ταυτόχρονα η γεωµετρική απει-
κόνιση του επιλεγµένου τοπολογικού λάθους γίνεται µε
µαύρο χρώµα.
Ακολουθεί η διόρθωση του τοπολογικού λάθους. Με δεξί
κλικ στον κανόνα εµφανίζεται µια λίστα εντολών, µε τη
βοήθεια της οποίας θα γίνει η διόρθωση του λάθους µε-
ταξύ των χαρακτηριστικών 17 και 18. 

Οι εντολές που εµφανίζονται µε δεξί κλικ στον κανόνα αυτό,
παρουσιάζονται στη διπλανή εικόνα:
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Με την εντολή “Show Rule Description” ο χρήστης πληροφορείται για τις περιπτώ-
σεις που ισχύει ο τοπολογικός κανόνας.

Με την εντολή “Subtract” δίνεται η δυνατότητα αφαίρεσης ενός λάθους από τη
λίστα του πίνακα.

Η εντολή “Merge” χρησιµοποιείται
στην περίπτωση που υπάρχει επικά-
λυψη πολυγώνων (κοινό τµήµα). Ο
χρήστης είναι σε θέση να συγχω-
νεύσει το επικαλυπτόµενο τµήµα µε
το πολύγωνο στο οποίο ανήκει.
Στη συγκεκριµένη περίπτωση, όπου υπάρχει κοινό τµήµα για τα πολύγωνα µε ΙD ίσο

µε 74 και 75, ο χρήστης καλείται να επιλέξει το “Feature” του επιπέδου, µέσα στο
οποίο θα συγχωνευθεί το λάθος (κοινό επικαλυπτόµενο τµήµα).

Στη συγκεκριµένη περίπτωση το “Feature” στον πίνακα “Error Inspector” αντιστοιχεί

στο OBJECTID στον πίνακα περιγραφών του επιπέδου LANDUSE_TP. Με επιλογή

καθενός “Feature” χωριστά από τη λίστα του πίνακα “Merge”, ο χρήστης έχει τη
δυνατότητα να δει το πολύγωνο στο οποίο ανήκει, παρατηρώντας τη γεωµετρία του
επιπέδου. Το επιλεγµένο “Feature” στο οποίο θα γίνει η συγχώνευση του επικαλυ-
πτόµενου τµήµατος, όπως φαίνεται από την εικόνα, είναι αυτό µε τον αριθµό 17,
το οποίο αντιστοιχεί στο πολύγωνο 74.  Με τον τρόπο αυτό το λάθος διορθώνεται
και δεν αποτελεί πλέον εγγραφή στον πίνακα “Error Inspector”.

4.3.2. Τοπολογικός Κανόνας: Must Not Have Gaps

Η αναγνώριση του συγκεκριµένου τοπολογικού λάθους είναι δυνατή µέσα από τον
πίνακα “Error Inspector”     . 

Εικόνα 4.2 : Τοπολογικό λάθος “Must not have gaps”
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Όπως και στην περίπτωση του προηγούµενου τοπολογικού λάθους, ο χρήστης, επι-
λέγοντας τον κανόνα από τη λίστα του πίνακα και
κάνοντας δεξί κλικ, έχει στη διάθεσή του κάποιες εν-
τολές για τη διόρθωση του λάθους αυτού. Το συγκε-
κριµένο «λάθος» αφορά στο εξωτερικό πολύγωνο του
επιπέδου LANDUSE_TP. ∆εν πρόκειται για λάθος, και

για το λόγο αυτό µε την εντολή “Mark as Exce-
ption”, ο χρήστης µπορεί να το ορίσει ως εξαίρεση,
παραβλέποντάς το ουσιαστικά από τη λίστα του πίνακα
“Error Inspector”.

4.4 ∆ιόρθωση µη τοπολογικών λαθών

Παρατηρώντας την Εικόνα 4.3, µετά τη διόρθωση των τοπολογικών λαθών, είναι φα-

νερά κάποια ακόµα λάθη, τα οποία δεν σχετίζονται µε τους τοπολογικούς κανόνες.

Η ταυτόχρονη εµφάνιση των δύο αρχείων (θεµατικό επίπεδο LANDUSE_TP και

εικόνα LANDUSE_GR) είναι δυνατή µέσα από το ArcMap µε τη χρήση της εργα-

λειοθήκης “Effects” και συγκεκριµένα του εργαλείου “Adjust Transparency”.

Μετά την εµφάνιση των δύο αρχείων στο περιβάλλον του ArcMap, ακολουθεί η
ενεργοποίηση της εργαλειοθήκης “Effects”, µέσω της οποίας ο χρήστης είναι σε
θέση να εµφανίσει το ένα από τα δύο επίπεδα µε κάποιο βαθµό διαφάνειας όπως
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ΠΡΟΣΟΧΗ!! Το µενού εντολών που εµφανίζεται µε δεξί κλικ στον

πίνακα “Error Inspector” διαφοροποιείται ανάλογα µε τον τοπολογικό
κανόνα.



φαίνεται στην εικόνα 4.3 που ακολουθεί.  Τα βήµατα που πρέπει να ακολουθήσει

ο χρήστης είναι τα ακόλουθα:

Επιλέγεται τo επίπεδο (LANDUSE_TP) το οποίο θα εµφανίζεται µε κάποιο πο-

σοστό διαφάνειας στην εργαλειοθήκη “Effects”. Πρόκειται για το επίπεδο που

βρίσκεται στην αρχή της λίστας εµφάνισης των επιπέδων στο “Table of
Contents” .
Ακολουθεί η επιλογή του ποσοστού διαφάνειας µε τη χρήση του εργαλείου

“Adjust Transparency”. Κάθε φορά επιλέγεται το επιθυµητό ποσοστό διαφάνειας.  

Η εµφάνιση των ετικετών / Labels του επιπέδου LANDUSE_TP διευκολύνει τη σύγ-
κριση των δύο επιπέδων για τον έλεγχο πιθανών µη τοπολογικών λαθών (Βλέπε

υποκεφάλαιο 3.5.). Το αποτέλεσµα ύστερα από τον ορισµό διαφάνειας και εισαγωγής

των ετικετών / labels, εµφανίζεται στην εικόνα 4.3 που ακολουθεί.
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Εικόνα 4.3: Σύγκριση αρχείου εικόνας LANDUSE_GR µε το επίπεδο LANDUSE_TP



Λάθος 1ο: Πολύγωνα 0 και 68

Συγκρίνοντας την εικόνα αυτή µε αυτή του αρχείου προς ψηφιοποίηση, είναι φανερό
πως πρόκειται για ένα ενιαίο πολύγωνο. Για τη διόρθωση του λάθους αυτού θα
χρησιµοποιηθεί η εντολή “Merge”.

Επιλέγοντας από τον πίνακα του επιπέ-
δου τις επιθυµητές εγγραφές (“ID = 0”
και “ID = 68”) µε κλικ και “Shift”, είναι
πλέον δυνατή η συγχώνευση των δύο
πολυγώνων σε ένα µε την εντολή “Edi-
tor > Merge”. (Περισσότερες λεπτοµέ-
ρειες για τη διαδικασία της επιλογής
δίνονται στο Υποκεφάλαιο 7.3.1.)

Κατά τη διαδικασία της συγχώνευσης ο χρήστης θα πρέπει να ορίσει το πολύγωνο
που θα συγχωνευθεί στο άλλο.

Η απόφαση αυτή είναι σηµαντική, γιατί
το πολύγωνο το οποίο θα διατηρηθεί
θα κρατήσει και την περιγραφική πλη-
ροφορία της στήλης ΙD. 

Το αποτέλεσµα της συγχώνευσης είναι
τόσο η γεωµετρική διόρθωση, όσο και
η διόρθωση στον πίνακα περιγραφικών
πληροφοριών.

Όπως φαίνεται στην εικόνα, λείπει η
εγγραφή µε “OBJECTID* = 7” από τον πίνακα, η οποία αντιστοιχούσε στο λανθα-

σµένο διαχωρισµό του πολυγώνου 68 σε δύο επιµέρους πολύγωνα (“ΙD= 0” και

“ID= 68”)

Λάθος 2ο: Πολύγωνο 60

Το πολύγωνο µε “ID = 60”, µε µια πρώτη µατιά, φαίνεται σωστό. Παρ’ όλα αυτά
στο αρχείο εικόνας το οποίο ψηφιοποιήθηκε, εµφανίζεται ένα επιπλέον Label µε
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“ID = 64”. Πρόκειται ουσιαστικά για δύο πολύγωνα των οποίων η γραµµή, η οποία
τα διαχωρίζει, δεν είναι άµεσα ορατή, µε αποτέλεσµα να µην έχει ληφθεί υπόψη
κατά την ψηφιοποίηση. 

Για τη διόρθωση του λάθους θα πρέπει, αρχικά, να επιλεγεί το πολύγωνο µε
“ID=60” και κατόπιν να χωριστεί. Αυτό είναι δυνατό µε το εργαλείο “Cut Polygon
Tools”    της εργαλειοθήκης Editor.

Επιλέγοντας το εργαλείο   , πρέπει να προστεθεί η γραµµή που λείπει, κάνοντας
κλικ λίγο έξω απο το πολύγωνο, τόσο στην αρχή, όσο και στο τέλος της. Η
γραµµή αυτή χωρίζει αυτόµατα το παλιό σε δύο νέα πολύγωνα (γεωµετρική διόρ-
θωση) και σε δύο νέες εγγρα-
φές (διόρθωση περιγραφικής
πληροφορίας).

Στη διπλανή εικόνα παρουσιά-
ζονται τα σηµεία, τα οποία χρη-
σιµοποιήθηκαν για το
διαχωρισµό του πολυγώνου σε
δύο νέα πολύγωνα.

Με την ολοκλήρωση του διαχωρισµού
του λανθασµένου πολυγώνου σε δύο
νέα, προκύπτει ο πίνακας της διπλανής
εικόνας. Εµφανίζονται δύο εγγραφές
στον πίνακα µε “ID = 60”. Ο χρήστης
είναι σε θέση να επιλέξει την εγγραφή
που αντιστοιχεί στο πολύγωνο µε “ID
= 64” (έχοντας υπόψη του το αρχείο
εικόνας tif) και να κάνει τη διόρθωση
της πληροφορίας.

Όπως φαίνεται από τον πίνακα, η εγγραφή µε “Shape Area = 2243,83” αντιστοιχεί

στο πολύγωνο µε “ID = 64”. Μετά τη διόρθωση και των µη τοπολογικών λαθών
προκύπτει το επίπεδο που φαίνεται στην Εικόνα 4.4, εφαρµόζοντας τη διαδικασία
εµφάνισης ετικετών της ενότητας 3.5.
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Εικόνα 4.4.: Τελικό επίπεδο ύστερα από τη διόρθωση όλων των λαθών

4.5. Επίλογος

Στο κεφάλαιο αυτό ολοκληρώθηκε το στάδιο της δόµησης τοπολογίας σε ένα θε-
µατικό επίπεδο, καθώς και της διόρθωσης των πιθανών τοπολογικών και µη λαθών. 

Στο επόµενο κεφάλαιο ακολουθεί το στάδιο της διαχείρισης του Πίνακα Περιγρα-
φικής Πληροφορίας ενός θεµατικού επιπέδου. 
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5.1. Εισαγωγή

Ένα βασικό χαρακτηριστικό των Γεωπληροφοριακών Συστηµάτων είναι η σύνδεση

των γεωµετρικών οντοτήτων µε τις περιγραφικές τους ιδιότητες. Στο περιβάλλον του

ArcMap 10.1 for Desktop κάθε θεµατικό επίπεδο συνοδεύεται από τον αντίστοιχο

πίνακα περιγραφικών δεδοµένων. Από το “Table Of Contents” και µε δεξί κλικ σε

οποιοδήποτε επίπεδο, ο χρήστης µπορεί να µεταβεί στον “Attribute Table” του επι-

πέδου αυτού. 

Κάθε πίνακας αποτελείται από στήλες και γραµµές. Οι γραµµές αποτελούν τις εγ-

γραφές ενός πίνακα, ενώ οι στήλες αφορούν στα πεδία του. Ο χρήστης µπορεί

να εισάγει όσα πεδία επιθυµεί. Το κάθε πεδίο είναι µοναδικό και περιέχει συγκε-

κριµένη πληροφορία. Οι εγγραφές είναι σε πλήθος όσες και οι οντότητες του επι-

πέδου, δηλαδή για κάθε οντότητα-εγγραφή αποθηκεύεται πληροφορία σε κάθε πεδίο.
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5 ∆ιαχείριση
Περιγραφικής Πληροφορίας

Code Area Name LandUse
001
002
... ... ... ... 

}

Εγγραφές Πίνακα

Πεδία Πίνακα

Εικόνα 5.1: Σχηµατική απεικόνιση Πίνακα µε πεδία και εγγραφές



5.2. Προκαθορισµένα πεδία πίνακα περιγραφικής πληροφορίας

Κατά τη δηµιουργία ενός επιπέδου από το περιβάλλον του ArcCatalog δηµιουργείται
αυτόµατα ο αντίστοιχος πίνακας περιγραφικής πληροφορίας.  Ο πίνακας αυτός
έχει τη µορφή της παρακάτω εικόνας και αποτελείται από τρία προκαθορισµένα
πεδία, τα οποία είναι τα ακόλουθα:

FID: Κάθε πολύγωνο χαρακτηρίζεται από έναν µοναδικό αριθµό. Η αρίθµηση γίνεται
µε αύξουσα σειρά κατά την ψη-
φιοποίηση.

Shape: Πληροφορία για τη γεω-
µετρία του επιπέδου που έχουµε
ψηφιοποιήσει. 

Id: Η προκαθορισµένη τιµή είναι
µηδενική. Ο χρήστης µπορεί να
χρησιµοποιήσει το field αυτό για
την εισαγωγή της κωδικοποίησής
του. 

Στον πίνακα της διπλανής εικόνας
παρουσιάζονται τα τρία προκαθο-
ρισµένα πεδία και οι εγγραφές
του πίνακα του θεµατικού επιπέ-
δου LANDUSE_TP, οι οποίες είναι
όσες και τα πολύγωνα χρήσεων
γης. 

Στη συνέχεια παρουσιάζονται οι βασικές δυνατότητες διαχείρισης ενός Πίνακα Πε-
ριγραφικής Πληροφορίας. Γι’ αυτό το σκοπό θα χρησιµοποιηθεί ο πίνακας του επι-
πέδου LANDUSE_TP, που προέκυψε από το Κεφάλαιο 4.

5.3. Προσθήκη νέου πεδίου 

Κατά τη δηµιουργία ενός νέου επιπέδου (σηµείου, γραµµής, πολυγώνου) ή κατά την
επεξεργασία ενός υπάρχοντος, ο χρήστης θα πρέπει παράλληλα µε τη γεωµετρία
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να επεξεργαστεί τον αντίστοιχο πίνακα για την καταχώρηση της περιγραφικής πλη-
ροφορίας. Για το λόγο αυτό θα πρέπει να καθορίσει συγκεκριµένες παραµέτρους.  

Οι παράµετροι περιλαµβάνουν:
Την ονοµασία του πεδίου (Field)
Τον τύπο δεδοµένων του πεδίου (Short Integer, Long Integer, Float, Double,
Text, Date)
Το χώρο αποθήκευσης που απαιτείται για κάθε πεδίο

Συνήθως, η εισαγωγή της περιγραφικής πληροφορίας ακολουθεί αυτή της ψηφιο-
ποίησης. Για τη συντόµευση του συνολικού χρόνου του έργου µπορεί να επιλεχθεί
η ταυτόχρονη επεξεργασία του πίνακα µε την ψηφιοποίηση. 

Στη συνέχεια θα εξεταστεί το παράδειγµα δηµιουργίας ενός νέου πεδίου µε την
ονοµασία LU_CODE στον πίνακα του επιπέδου LANDUSE_TP και την εισαγωγή της
πληροφορίας που αντιστοιχεί για κάθε εγγραφή ανάλογα µε την τιµή ID. 

Το πεδίο αυτό θα περιέχει τον κωδικό αριθµό των χρή-
σεων γης για κάθε πολύγωνο (εγγραφή του πίνακα).

Στον Πίνακα 5.1. δίνεται ο κωδικός αριθµός ID κάθε
πολυγώνου µε την αντίστοιχη τιµή LU_CODE. Με τη βοή-
θεια του πεδίου ID ο χρήστης θα µπορέσει να εισάγει
την πληροφορία του κωδικού χρήσης γης LU_CODE για
κάθε εγγραφή του πίνακα του επιπέδου LANDUSE_TP.

Για να γίνει αυτό θα πρέπει να ακολουθήσει τα παρα-
κάτω βήµατα εργασιών:

Άνοιγµα του πίνακα “Table of Contents” του επι-
πέδου LANDUSE_TP µε δεξί κλικ στο επίπεδο και
επιλογή της εντολής “Open Attribute table” (Ο
πίνακας αυτός περιέχει πέντε προκαθορισµένες
στήλες, µε το πεδίο ID να περιέχει τον κωδικό
αριθµό κάθε πολυγώνου).
∆ηµιουργία ενός νέου πεδίου µε την ονοµασία
LU_CODE, οι παράµετροι του οποίου θα είναι οι
ακόλουθες:
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ID LU_CODE
59 400

60 200

61 400

62 200

63 200

64 300

65 200

66 300

67 300

68 200

69 300

70 200

71 300

72 300

73 300

74 300

75 200

76 300

77 300

Πίνακας 5.1.: Κωδικός
LU_CODE για κάθε πολύγωνο



Αυτό είναι εφικτό µέσα από το εικονίδιο “Table Options” του Πίνακα
(Table). Με κλικ στο βέλος ανοίγει µια λίστα µε εντολές, όπως φαίνεται στην
παρακάτω εικόνα. 

Η εντολή “Add Field” δηµιουργεί νέο πεδίο
στον Πίνακα (Table). Στο παράθυρο που ανοίγει
ο χρήστης καλείται να εισάγει τις παραµέτρους
ως ακολούθως:

Ακολουθεί η επεξεργασία του πίνακα µε πληκτρολόγηση και εισαγωγή της
τιµής LU_CODE στο αντίστοιχο πεδίο για κάθε εγγραφή, ανάλογα µε την τιµή
Id, σύµφωνα µε τον Πίνακα 5.2. µε την προυπόθεση ότι ο χρήστης βρίσκεται
σε κατάσταση “Editing” µέσω της εργαλειοθήκης “Editor > Start Editing”.
Τέλος, η διαδικασία ολοκληρώνεται µέσω της εργαλειοθήκης “Editor > Save
Edits” και “Editor > Stop Editing” µε την οποία ο χρήστης αποθηκεύει τις
τιµές που πληκτρολόγησε και τερµατίζει τη διαδικασία επεξεργασίας. 
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Όνοµα Πίνακα Όνοµα πεδίου Τύπος πεδίου Data Precision

LU_CODE LU_CODE Short Integer 4 

ΠΡΟΣΟΧΗ!!: Η εισαγωγή ενός νέου πεδίου στον πίνακα, είναι

εφικτή είτε ο χρήστης είναι σε κατάσταση “Editing” µέσω της ερ-

γαλειοθήκης “Editor > Start Editing” είτε όχι.



Ο πίνακας που προκύπτει, ύστερα από τη δηµιουργία νέου πεδίου και την πληκτρο-
λόγηση τιµής για κάθε εγγραφή του πίνακα
στο πεδίο αυτό, παρουσιάζεται στη διπλανή
εικόνα.

5.4. Εµφάνιση Πίνακα στον ArcMap

Ο χρήστης µπορεί να εµφανίσει τό-
σους πίνακες, όσους και τα επίπεδα
πληροφορίας,  τα οποία έχει προσθέσει
στο περιβάλλον της εφαρµογής Arc-
Map 10.1 for Desktop. 

Σε αντίθεση µε τις προηγούµενες εκ-
δόσεις του ArcMap, όλοι οι πίνακες
γίνονται ορατοί από το ίδιο παράθυρο.
Ο χρήστης αρκεί να επιλέξει το
άνοιγµα ενός πίνακα, και αυτοµάτως ο
προηγούµενος πίνακας που ήταν ορατός
µέχρι τότε προστίθεται ως tab στο
κάτω µέρος του παραθύρου. Με αυτόν
τον τρόπο ο χρήστης µπορεί να ανοίγει
κάθε φορά τον επιθυµητό πίνακα, επι-
λέγοντας το tab µε το όνοµά του.
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ΠΡΟΣΟΧΗ!!: Στην περίπτωση λά-
θους καταχώρησης των παραµέτρων
ή του ονόµατος ενός πεδίου, ο
χρήστης θα πρέπει να διαγράψει το
πεδίο µε δεξί κλικ πάνω στο πλαί-
σιο µε την ονοµασία του πεδίου και
επιλογή της εντολής “Delete Field”
και στη συνέχεια να επαναλάβει τη
διαδικασία από την αρχή

Εικόνα 5.2.: Η εµφάνιση των πινάκων γίνεται
στο ίδιο παράθυρο



5.5. ∆ηµιουργία Νέου Πίνακα

Στη συνέχεια εξετάζονται  διάφοροι τρόποι µε τους οποίους ο χρήστης του ArcMap
µπορεί να δηµιουργήσει νέους πίνακες και να εισάγει πληροφορίες. 

Για το σκοπό αυτό θα πρέπει να δηµιουργηθεί ένας νέος πίνακας στον οποίο θα
καταγράφεται το κόστος ανά εκτάριο, ανάλογα µε τη χρήση της γης του κάθε πο-
λυγώνου.

Ο Πίνακας αυτός αποτελείται από δύο στήλες όπου:
LU_CODE = Κωδικός Χρήσης γης
COST_HA = Κόστος / Εκτάριο

Οι πιο απλοί συνήθεις τύποι πινάκων, που αξιοποιεί το ArcMap, είναι είτε αυτοί της
Βάσης ∆εδοµένων DataBase (.dbf) είτε αυτοί του λογισµικού Excel (.xls). 

5.5.1. Πίνακας .dbf

Για τη δηµιουργία ενός πίνακα σε Dbf µορφή, ο χρήστης αρκεί να ανοίξει το πε-
ριβάλλον της εφαρµογής ArcCatalog. Ύστερα από την επιλογή του φακέλου που θα
χρησιµοποιηθεί για την αποθήκευση του αρχείου ({..\\DATA\RESULTS\ 4_TABLES}),
είναι σε θέση µε δεξί κλικ στο δεξί παράθυρο “Εµφάνισης ∆εδοµένων” να επιλέξει
τη δηµιουργία ενός νέου αρχείου Πίνακα, ακολουθώντας τις εντολές “New >
dBASE Table”. Ο πίνακας που θα δηµιουργηθεί θα έχει την ονοµασία CostHa. Σε
περίπτωση λάθους µπορει να γίνει διόρθωση µε δεξί κλικ στο αρχείο και επιλογή
της εντολής “Rename”, µέσα από το περιβάλλον του ArcCatalog.

Κατόπιν, µέσω των επιλογών “Properties” στον παραγόµενο πίνακα, ο χρήστης
είναι σε θέση να προσθέσει επιπλέον πεδία και να ορίσει τις παραµέτρους για το
καθένα από αυτά. Στη συνέχεια φαίνονται οι παράµετροι ορισµού του πίνακα αυτού.

Έπειτα, ακολουθεί η εισαγωγή του αρχείου στον ArcMap µέσω του εικονιδίου “Add
Data”. Ακολουθεί η επεξεργασία του, ενεργοποιώντας την εντολή “Editor > Start
Editing”. Με τον τρόπο αυτό, µετά το άνοιγµα του πίνακα CostHa µε δεξί κλικ και

επιλογή της εντολής “Open”, είναι δυνατή η καταχώρηση της πληροφορίας µε πλη-
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LU_CODE COST_HA
200 15000

300 10000

400 10000

Όνοµα Πίνακα Όνοµα πεδίου 
Field Name

Τύπος πεδίου
Data Type

Field Properties
Precision

CostHa
LU_CODE Short Integer 4

COST_HA LongInteger 9



κτρολόγηση. Το αποτέλεσµα είναι ο Πίνακας της πα-
ραπάνω εικόνας.

Τόσο ο πίνακας σε µορφή dbf, όσο και ο πίνακας
που θα προέλθει από το περιβάλλον του Excel, εµ-
φανίζονται µε τον ίδιο τρόπο κατά την εισαγωγή τους
στην εφαρµογή ArcMap, µε τη χρήση της επιλογής

“List By Source” στο παράθυρο του “Table Of
Contents”, όπως φαίνεται στην Εικόνα 5.3 που ακο-
λουθεί.  

5.5.2. Πίνακας .xls

Η δηµιουργία ενός πίνακα σε αυτή τη µορφή αποτελεί µια απλή διαδικασία χρήσης
του Microsoft Office Excel. Ύστερα από τη δηµιουργία δύο στηλών (πεδία πίνακα)
και την εισαγωγή του ονόµατος για την κάθε µία, θα πρέπει να εισαχθεί η αντί-
στοιχη πληροφορία σε κάθε πεδίο. Θα πρέπει να οριστεί το “Format Cells”, ως

“General”, ώστε να καταστεί εφικτή η σύνδεση του πίνακα αυτού µε τον Πίνακα
του επιπέδου LANDUSE_TP. Τέλος, ο χρήστης θα πρέπει να αποθηκεύσει το φύλλο
εργασίας του αρχείου του Excel µε το όνοµα CostHa, ανεξάρτητα από την ονοµασία
αποθήκευσης του αρχείου Excel. Ο πίνακας αυτός θα αποθηκευθεί στο φάκελο
{..\\DATA\RESULTS\ 4_TABLES}. Τέλος, µε την εντολή “Add Data” θα προστεθεί

στο ArcMap όπως έγινε και µε τον πίνακα .dbf.

5.6. Σύνδεση Πινάκων (Join)

Όπως ίσως είναι γνωστό, ένα βασικό χαρακτηριστικό όλων των σχεσιακών Βάσεων
∆εδοµένων είναι η σύνδεση των πινάκων τους. Ο απλούστερος τύπος σύνδεσης
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Εικόνα 5.3: Εµφάνιση πινάκων µορφής .dbf και .xls στον
Πίνακα Περιεχοµένων



είναι 1:1. ∆ηλαδή, η µία εγγραφή του ενός πίνακα να συνδέεται µε µία εγγραφή
του άλλου. Επίσης, υπάρχουν οι συνδέσεις του τύπου Μ:1, όπου πολλές εγγραφές
του ενός πίνακα αντιστοιχούν σε µία εγγραφή του δεύτερου πίνακα. Οι συνδέσεις
1:1 ή Μ:1 υλοποιούνται µε την εντολή Join, σε αντίθεση µε τις συνδέσεις τύπου 1:Μ,
οι οποίες υλοποιούνται µε τη βοήθεια της εντολής Relate στο περιβάλλον του Arc-
Map. 

Στην προκειµένη περίπτωση  θα εξεταστεί η ένωση του πίνακα του επιπέδου
LANDUSE_TP και των Πινάκων σε µορφή .Dbf και Excel, που δηµιουργήθηκαν στην
προηγούµενη ενότητα. Ο τελευταίος πίνακας περιλαµβάνει την κωδικοποιηµένη πλη-
ροφορία της χρήσης γης, που έχει κάθε πολύγωνο, µε το αντίστοιχο κόστος ανά
εκτάριο. Η σύνδεση αυτή είναι του τύπου Μ:1. Το ArcMap επιτρέπει τη σύνδεση πι-
νάκων, µε την προϋπόθεση της ύπαρξης κοινού πεδίου στους πίνακες αυτούς. Το
πεδίο αυτό είναι το LU_CODE.

Συγκεκριµένα, για τη συνένωση των παραπάνω πινάκων έχουν οριστεί οι παράµετροι
για το πεδίο LU_CODE ως εξής:

Η διαδικασία που θα πρέπει να ακολουθήσει ο χρήστης είναι απλή:

Αναγνώριση του θεµατικού επιπέδου LANDUSE_TP στο “Table Of Contents”.
Με δεξί κλικ στο επίπεδο αυτό και επιλογή της εντολής “Joins and Relates
ο χρήστης επιλέγει “Join”. 
Συµπλήρωση των παραµέτρων του παραθύρου “Join Data” που εµφανίζεται:
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ΠΡΟΣΟΧΗ!! Οι παράµετροι του πεδίου συσχέτισης του πρώτου πίνακα
LANDUSE_TP (Πίνακας Χρήσεων γης) θα πρέπει να συµφωνούν µε τις

παραµέτρους του αντίστοιχου πεδίου στο δεύτερο πίνακα CostHa (Πίνα-
κας Κόστος/ Εκτάριο).

Όνοµα Πίνακα Όνοµα πεδίου Τύπος πεδίου Data Precision
LU_CODE Id Short Integer 4



Επιλογή του πεδίου στο οποίο θα
βασιστεί η σύνδεση των πινάκων
Επιλογή του πίνακα ο οποίος θα
ενωθεί µε τον πίνακα του επιλεγ-
µένου επιπέδου (Πίνακας CostHa
.dbf ή .xls)
Επιλογή του κοινού πεδίου
“LU_CODE” στον επιλεγµένο πί-
νακα CostHa
Ορισµός των ιδιοτήτων της ένω-
σης (διατήρηση όλων των εγγρα-
φών, διατήρηση των κοινών
εγγραφών των πινάκων)
Επικύρωση της ένωσης
Ολοκλήρωση της διαδικασίας µε
την επιλογή ΟΚ

Το αποτέλεσµα της ένωσης των δύο
πινάκων είναι η πρόσθεση των πεδίων
του δεύτερου πίνακα στον πρώτο. Η
ένωση αυτή είναι προσωρινή και απο-
θηκεύεται µόνο στο .mxd.

Για τη µόνιµη αποθήκευση του αποτελέ-
σµατος της ένωσης των δύο πινάκων,
αρκεί ένα δεξί κλικ στο επίπεδο(
LANDUSE_TP) µέσα από το “Table Of
Contents” και επιλογή της εντολής

“Data > Export Data”. Στο παράθυρο
αυτό ο χρήστης επιλέγει το φάκελο
στον οποίο θα αποθηκευθεί ο νέος πί-

νακας, καθώς και τα στοιχεία που επιθυµεί να αποθηκευθούν.
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ΠΡΟΣΟΧΗ!! Σε κάθε περίπτωση, µε την εντολή Export Data, αν τυχόν
έχουν επιλεγεί ορισµένες εγγραφές του πίνακα, το αποτέλεσµα θα είναι
ένα νέο επίπεδο µε τις εγγραφές αυτές ΜΟΝΟ. 



Το όνοµα και η θέση αποθήκευσης του αποτελέσµατος της ένωσης των δύο πινάκων
είναι: {..\\DATA\RESULTS\5_JOIN ATTRIBUTES \LANDUSE_JN}.

Ο Πίνακας που προκύπτει από τη συνένωση των πινάκων LANDUSE_TP και
CostHa.dbf φαίνεται στην Εικόνα 5.4 που ακολουθεί.

Εικόνα 5.4: Ο πίνακας που προέκυψε από τη διαδικασια Join

Είναι φανερό, ότι ο πίνακας αυτός περιέχει τα πεδία και των δυο πινάκων, όπως
φαίνεται και στην Εικόνα 5.4. Το πεδίο, µε βάση το οποίο έγινε η συγχώνευση των
πινάκων (πεδίο LU_CODE), εµφανίζεται δύο φορές. Στο δεύτερο πεδίο προστίθεται
ο αριθµός “1 ”. 

Στην περίπτωση πεδίων τα οποία εµφανίζονται δύο φορές µετά τη συνένωση πινά-
κων, όπως το  LU_CODE_1, αλλά και πεδίων τα οποία δεν έχουν χρησιµότητα
(OID, Field1), ο χρήστης είναι σε θέση είτε να τα απενεργοποιήσει, ώστε να  µην
εµφανίζονται στον πίνακα, είτε να τα διαγράψει.

5.6.1. Απενεργοποίηση Πεδίου και αλλαγή θέσης στον πίνακα

Η απενεργοποίηση ενός πεδίου γίνεται µέσα από το περιβάλλον του ArcMap στον
πίνακα “Table” του θεµατικού επιπέδου, µε δεξί κλικ στο µη επιθυµητό πεδίο και
επιλογή της εντολής “Turn Field off”. 

Η ίδια διαδικασία µπορεί να γίνει και µέσα από τις ιδιότητες του θεµατικού επιπέδου.
Με δεξί κλικ στο επίπεδο και επιλογή της εντολής “Properties”, ο χρήστης, επιλέ-
γοντας στο παράθυρο που εµφανίζεται την καρτέλα “Fields”, έχει τη δυνατότητα να
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επιλέξει τα πεδία του πί-
νακα που επιθυµεί να εµ-
φανίζονται κατά το
άνοιγµά του.

Επίσης, µέσα από το πε-
ριβάλλον αυτό είναι σε
θέση να επιλέξει τη σειρά
εµφάνισης των πεδίων,
χρησιµοποιώντας τα βέλη,
όπως φαίνεται στην δι-
πλανή εικόνα. Εναλλα-
κτικά, η αλλαγή της
σειράς µε την οποία εµ-
φανίζονται τα πεδία γίνε-
ται και µε το άνοιγµα του
πίνακα µέσω της διαδικασίας “Drag & Drop”, όπου ο χρήστης επιλέγει ένα πεδίο
και το µετακινεί αριστερά ή δεξιά, καθορίζοντας την επιθυµητή γι’ αυτό θέση.
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Ιδιότητες επιπέδου > Καρτέλα “Fields”

Εικόνα 5.5.: ∆ιαγραφή πεδίου από πίνακα



5.6.2. ∆ιαγραφή πεδίου από πίνακα

Η διαγραφή ενός πεδίου γίνεται µέσα από το περιβάλλον του ArcCatalog. Πιο συγ-
κεκριµένα, η διαδικασία της διαγραφής επιτυγχάνεται µέσα από την καρτέλα “Pre-
view > Table” και µε δεξί κλικ στα µη επιθυµητά πεδία (OID, Field1 και LU_CODE_1)
µέσω της εντολής “Delete Field” (Εικόνα 5.5) επιτυγχάνει τη διαγραφή του.

Το πεδίο αυτό ο χρήστης µπορεί, είτε να το απενεργοποιήσει µε δεξί κλικ στο
πεδίο και επιλογή των εντολών ώστε να µην είναι ορατό, είτε να το διαγράψει µό-
νιµα και αντίστοιχα µέσα από. Έτσι, ο νέος πίνακας µετά τη διαγραφή του πεδίου

LU_CODE_1 είναι ο ακό-
λουθος:

Ο πίνακας που προκύπτει,
ύστερα από τη διαγραφή
των µη επιθυµητών πε-
δίων, είναι αυτός της Ει-
κόνας 5.6.

5.7. Επίλογος

Στο κεφάλαιο αυτό ολοκληρώθηκε η διαδικασία διαχείρισης του Πίνακα Περιγραφικής
Πληροφορίας ενός θεµατικού επιπέδου. 

Στο επόµενο κεφάλαιο ολοκληρώνονται οι διαδικασίες διαχείρισης των γεωγραφικών
δεδοµένων.  
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Εικόνα 5.6: Πίνακας ύστερα από τη διαγραφή µη επιθυµητών πεδίων

ΠΡΟΣΟΧΗ!! Στην περίπτωση υπάρχοντος πεδίου του οποίου επιθυµεί να
αλλάξει τον ορισµό των παραµέτρων ή το όνοµά του, θα πρέπει να
χρησιµοποιηθεί η εντολή “Calculate”. Αρχικά, θα πρέπει να δηµιουργηθεί
νέο πεδίο µε τις κατάλληλες παραµέτρους και στη συνέχεια µε δεξί
κλικ στο πεδίο αυτό και µέσω της εντολής “Calculate”, ο χρήστης µπορεί
να εισάγει τις τιµές ή τους χαρακτήρες του παλιού πεδίου.



6.1. Εισαγωγή

Συνήθως, η διαδικασία της ψηφιοποίησης χαρακτηριστικών σε µια περιοχή µελέτης
επιµερίζεται σε φύλλα χάρτη. Αυτό συµβαίνει, κυρίως, για την ευκολότερη διαχείριση
της γεωγραφικής βάσης σε όλα τα στάδια µιας τυπικής µελέτης ΓΣ έως και τη
χαρτογραφική απόδοση. Επίσης, περισσότεροι του ενός χρήστες µπορούν να δια-
χειριστούν δεδοµένα στην ίδια περιοχή µελέτης.

Στο κεφάλαιο αυτό και συγκεκριµένα στο πλαίσιο του εκπαιδευτικού παραδείγµατος
που εκπονείτε, θα πρέπει να ενωθούν δύο επίπεδα που προέρχονται από γειτονικά
φύλλα χάρτη. Το ένα επίπεδο προϋπάρχει στη γεωγραφική βάση δεδοµένων που
δίνεται στο βιβλίο αυτό και το άλλο έχει προκύψει από το προηγούµενο κεφάλαιο.

Για την επίτευξη του σκοπού αυτού θα πρέπει να υλοποιηθούν 3 στάδια. Το πρώτο
στάδιο είναι η ταύτιση των χαρακτηριστικών στο όριο των χαρτών, το δεύτερο η
ένωσή τους, ενώ το τρίτο η απλοποίηση των χαρακτηριστικών στην ενιαία πια βάση.

6.2. Ταύτιση οντοτήτων γειτονικών φύλλων χάρτη

Κατά τη διαδικασία της ένωσης επιπέδων από γειτονικά φύλλα χάρτη διαπιστώνεται,
τις περισσότερες φορές, η µη ταύτιση των γραµµών ή των  πολυγώνων στα όρια
των επιπέδων. Πριν ο χρήστης προχωρήσει στην ένωση των επιπέδων από διαφο-
ρετικά φύλλα χάρτη, θα πρέπει να διορθώσει και να ταυτίσει τελικά τα όρια των
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6 Ένωση 
Φύλλων Χάρτη



οντοτήτων είτε αυτά είναι γραµµές είτε πολύγωνα, ώστε να έχει τελικά µια ενιαία
και αδιαίρετη γεωγραφική βάση δεδοµένων.  Για το σκοπό αυτό ακολουθείται µια
διαδικασία, η οποία προσαρµόζει τη γεωµετρία ενός επιπέδου πληροφορίας σε ένα
άλλο, το οποίο θεωρείται σταθερό. Η διαδικασία αυτή στο Arc Map ονοµάζεται
“Rubbersheet”.

Συγκεκριµένα, το θεµατικό επίπεδο, το οποίο παρουσιάζει στρεβλώσεις (Source
Layer), υποβάλλεται σε µια διαδικασία τεντώµατος κατά την οποία µετακινείται και
προσαρµόζεται στο οριζόµενο ως σταθερό γειτονικό θεµατικό επίπεδο (Target Layer).
Αρχικά, ο χρήστης ορίζει τα επίπεδα που συµµετέχουν. Στη συνέχεια εισάγει συν-
δέσµους (Displacement Links) µε βάση τους οποίους προσαρµόζει τη γεωµετρία
του µετακινούµενου θεµατικού επιπέδου ως προς το σταθερό. Στις περιπτώσεις που
υπάρχουν χαρακτηριστικά, τα οποία δεν χρειάζονται µετακίνηση, εισάγονται τα λε-
γόµενα “Identity Links”.

Εναλλακτικά, όταν τα “Identity Links” είναι αρκετά, ο χρήστης έχει τη δυνατότητα
να ορίσει µόνο τις περιοχές που θα παραµορφωθούν στο µετακινούµενο επίπεδο,
χωρίς να ορίσει “Identity Links”.

Ως αποτέλεσµα, µέσα από την αλλαγή της γεωµετρίας ενός ή περισσότερων θε-
µατικών επιπέδων µε βάση κάποια άλλα θεωρούµενα σταθερά επίπεδα, επιτυγχάνεται
η οµοιογένεια της γεωγραφικής βάσης.

6.2.1. Προσαρµογή Επιπέδου LANDUSE_JN µε βάση το επίπεδο LUAT και
τη χρήση “Identity Links”.

Στο σηµείο αυτό παρουσιάζεται η διαδικασία της ταύτισης των ορίων δύο γειτονικών
πολυγωνικών θεµατικών επιπέδων των LUAT και LANDUSE_RS. Το πρώτο θεµατικό
επίπεδο βρίσκεται στο φάκελο {…\\DATA\BASIC\SHAPEFILES}, ενώ το δεύτερο απο-
τελεί το παραγόµενο επίπεδο της συνένωσης των πινάκων του προηγούµενου κεφα-
λαίου (LANDUSE_JN), ύστερα από την αντιγραφή και µετονοµασία του στον
ακόλουθο φάκελο {…\\DATA\RESULTS\6_RUBBERSHEET}.

Με µια γρήγορη µατιά στα θεµατικά αυτά επίπεδα µέσα από το περιβάλλον του Ar-
cMap θα έλεγε κανείς ότι οι κόµβοι στην ένωση των φύλλων ταιριάζουν. Εστιά-
ζοντας, όµως περισσότερο, γίνεται αντιληπτό ότι έξι κόµβοι δεν ταυτίζονται, όπως
φαίνεται στην Εικόνα 6.1.

ΚΕΦΑΛΑΙΟ 6 ΕΝΩΣΗ ΦΥΛΛΩΝ ΧΑΡΤΗ86



Εικόνα 6.1.: Μη ταυτόσηµοι κόµβοι µεταξύ των επιπέδων

Τα βασικά βήµατα εργασιών για την ταύτιση των ορίων των δύο επιπέδων είναι τα
ακόλουθα:

∆ηµιουργία αρχείου mxd για την προσθήκη των επιπέδων LANDUSE_RS και LUAT 

Ορισµός µεθόδου προσαρµογής των θεµατικών επιπέδων

Άνοιγµα της εργαλειοθήκης “Spatial Adjustment”.

Ενεργοποίηση της εργαλειοθήκης µε “Start Editing” στην εργαλειοθήκη “Editor”.

Μετάβαση στο µενού της εργαλειοθήκης “Spatial Adjustment” και επιλογή της

εντολής “Set Adjust Data”. Στο σηµείο  αυτό ο χρήστης καλείται να δηλώσει
το θεµατικό επίπεδο, το οποίο επιθυµεί να προσαρµόσει. Το επίπεδο αυτό
είναι το LANDUSE_RS.
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ΠΡΟΣΟΧΗ!! Αν οι κόµβοι που δεν ταυτίζονται είναι λιγότεροι από έξι,
τότε ο χρήστης µπορεί να ακολουθήσει τη διαδικασία που παρουσιάζεται
στο υποκεφάλαιο 6.2.2. 

i) 

ii) 



Ακολουθεί η επιλογή της µεθόδου προσαρµογής του θεµατικού επιπέδου µέσα

από το µενού της εργαλειοθήκης: “Spatial Adjustment > Adjustment Methods
> Rubbersheet”.

Μετάβαση στο µενού της εργαλειοθήκης “Spatial Adjustment” και επιλογή της
εντολής “Options”. Στο παράθυρο ο χρήστης ορίζει ως “Adjustment Method”
τη µέθοδο “Rubbersheet”, ενώ µέσα από τα “Options” της µεθόδου επιλέγει

“Natural Neighbor”. 

Επικυρώνοντας την επιλογή της µεθόδου στο παράθυρο “Rubbersheet” µε την

επιλογή “OK”, ο χρήστης µέσα από την καρτέλα “Edge Match” του παραθύρου
“Adjustment properties” (Options) είναι σε θέση να ορίσει τόσο το επίπεδο

που χρησιµοποιείται  ως “Source Layer”, δηλαδή το επίπεδο LANDUSE_RS,
όσο και το επίπεδο που θα χρησιµοποιηθεί ως “Target Layer”, δηλαδή το
επίπεδο LUAT.

Τέλος, µε την επιλογή OK το παράθυρο διαλόγου “Adjustment Properties”
κλείνει, αποθηκεύοντας τις παραµέτρους προσαρµογής.

Ορισµός ανοχής (Vertex Snapping)

Στη συνέχεια, και εφόσον έχουν οριστεί οι παραπάνω παράµετροι στην εργα-

λειοθήκη “Snapping”, ορίζεται η ανοχή για τη σύµπτωση των κορυφών: (Vertex
Snapping)                . 

Εισαγωγή στοιχείων µετακίνησης (Displacement Links)

Ακολουθεί η προσθήκη των “Displacement Links” ή αλλιώς των στοιχείων που

υποβοηθούν τη διαδικασία της ταύτισης. Τα σηµεία αυτά συνδέουν ουσιαστικά

τις συντεταγµένες των στοιχείων του επιπέδου που µετακινείται (Source Layer)
και αυτού που παραµένει σταθερό (Target Layer) κατά τη διαδικασία της µε-
τακίνησης (Spatial Adjustment).

Τα σηµεία, τα οποία θα χρησιµοποιηθούν ως displacement links, φαίνονται

στην Εικόνα 6.1. Για την εισαγωγή των σηµείων αυτών χρησιµοποιείται το ερ-

γαλείο “New Displacement Link tool”     στην εργαλειοθήκη “Spatial Adju-
stment”. Η διαδικασία ορισµού τους είναι η εξής:
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iii) 

iv) 



Αρχικά, επιλέγεται η κορυφή του χαρακτηριστικού
από το θεµατικό επίπεδο που αποτελεί το “So-
urce Layer” και στη συνέχεια η κορυφή του χα-
ρακτηριστικού από το επίπεδο “Target Layer”,
όπως φαίνεται στη διπλανή εικόνα.

Η ίδια διαδικασία ακολουθείται για τα υπόλοιπα
πέντε σηµεία της Εικόνας 6.1, επιλέγοντας ως
αρχή την κορυφή του επιπέδου LANDUSE_RS
και ως προορισµό την κορυφή του επιπέδου
LUAT.

Καθορισµός Σηµείων Αγκίστρωσης (Identity Links)

Το επόµενο βήµα αφορά στον καθορισµό σηµείων αγκίστρωσης. Τα σηµεία
αυτά χρησιµοποιούνται για να αποτραπεί η µετακίνησή τους κατά τη διάρκεια
προσαρµογής, δεδοµένου ότι η θέση τους είναι ορθή. 

Το εργαλείο, το οποίο χρησιµοποιείται για τον καθορισµό τους, ονοµάζεται
“New Identity Link Tool” και βρίσκεται
στην εργαλειοθήκη “Spatial Adjustment”.

Η εισαγωγή των σηµείων γίνεται µε απλό κλικ,
ύστερα από την επιλογή του εργαλείου σε ση-
µεία του επιπέδου που θεωρούνται σταθερά.  

Το µοναδικό σηµείο, το οποίο χρησιµοποιήθηκε
στη συγκεκριµένη περίπτωση, παρουσιάζεται στη
διπλανή εικόνα.

Μέσω του εικονιδίου     “View Link Table”
της εργαλειοθήκης “Spatial Adjustment” ο χρή-
στης µπορεί να επιθεωρήσει τις συντεταγµένες των σηµείων που όρισε ως
“Identity Links”, καθώς και τα σηµεία “Displacement Link” που αφορούν στις
περιοχές που χρειάζονται διόρθωση.  Εναλλακτικά, ο πίνακας αυτός εµφανίζεται
µέσα από την εργαλειοθήκη “Spatial Adjustment > Links > View Link Table”.
Στη συνέχεια παρατίθεται η εικόνα του Πίνακα µε τα σηµεία αυτά και τις συν-
τεταγµένες τους.
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v) 

LANDUSE_RS



Μέσα από τον πί-
νακα γίνεται αντιλη-
πτό ότι για τα έξι
σηµεία, τα οποία
χρειάζονται διόρ-
θωση, υπάρχουν
δύο ζεύγη συντεταγ-
µένων, οι συντεταγ-
µένες του επιπέδου
αφετηρίας LANDUSE_RS και οι συντεταγµένες του επιπέδου προορισµού LUAT.
Αντιθέτως, για τα σηµεία “Identity Links” αποθηκεύονται µόνο οι συντεταγµένες
κάθε σηµείου τα οποία, όπως έχει αναφερθεί, είναι σταθερά σηµεία του επι-
πέδου LANDUSE_RS.

Επικύρωση και αποθήκευση των αλλαγών 

Στο σηµείο αυτό ο χρήστης, έχοντας εισάγει και τα σηµεία αγκίστρωσης,
είναι σε θέση να ολοκληρώσει τη διαδικασία, επιλέγοντας “Adjust” από το

µενού της εργαλειοθήκης “Spatial Adjustment”.

Στη συνέχεια µέσα από την εργαλειοθήκη “Editor > Save Edits” αποθηκεύονται

οι αλλαγές, ενώ κάνοντας “Stop Editing” η διαδικασία ολοκληρώνεται.

Με την επικύρωση των αλλαγών τα “Displacement Links” (6 σηµεία) µετατρέ-
πονται σε “Identity Links”, όπως φαίνεται στην Εικόνα 6.3., µε τα ήδη υπάρ-
χοντα “Identity Links” να παραµένουν ως έχουν.

Το αποτέλεσµα της διαδικασίας αποθηκεύεται στο φάκελο {..\\DATA\RESULTS\
6_RUBBERSHEET}, όπου
βρίσκεται το επίπεδο
LANDUSE_RS του οποίου
τα όρια µεταβλήθηκαν.
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Εικόνα 6.2.: Πίνακας Συνδέσµων (Link Table)

Εικόνα 6.3.: Πίνακας Συνδέσµων (Link Table) µετά την επικύ-
ρωση των αλλαγών

vi) 



6.2.2. Προσαρµογή Επιπέδου LANDUSE_JN βάσει του επιπέδου LUAT µε
χρήση του εργαλείου “Limited Adjustment Area tool”

Στην ενότητα αυτή εξετάζεται η µέθοδος προσαρµογής ενός επιπέδου στο γειτονικό

του, θεωρούµενο σταθερό επίπεδο, µε τη χρήση του εργαλείου    “Limited
Adjustment Area tool”. Το εργαλείο αυτό βοηθά το χρήστη να περιορίσει την πε-
ριοχή εφαρµογής της µεθόδου “Rubbersheet”. Συγκεκριµένα, επιτρέπει στο χρήστη
να σχεδιάσει ένα πολύγωνο γύρω από τα χαρακτηριστικά τα οποία επιθυµεί να

προσαρµόσει. Όλα τα χαρακτηριστικά, εκτός του πολύγωνου, δεν επηρεάζονται από

την εκτέλεση της µεθόδου. Το εργαλείο αυτό αντικαθιστά ουσιαστικά τη διαδικασία

εισαγωγής “Identity Links”, σταθερών δηλαδή σηµείων, µε αποτέλεσµα την εξοικο-
νόµηση χρόνου στην περίπτωση µεγάλου αριθµού σηµείων.

H διαδικασία προσαρµογής αφορά στα χαρακτηριστικά του επιπέδου LANDUSE_LA
και του επιπέδου LUAT. Το πρώτο θεµατικό επίπεδο αποτελεί το παραγόµενο επίπεδο
που προέκυψε ύστερα από τη συνένωση πινάκων του προηγούµενου κεφαλαίου

(LANDUSE_JN), ύστερα από την αντιγραφή και µετονοµασία του στον ακόλουθο

φάκελο {...\\DATA\RESULTS\6_RUBBERSHEET}, ενώ το δεύτερο βρίσκεται στο φάκελο

{…\\DATA\BASIC\SHAPEFILES}.

Τα βασικά βήµατα εργασιών για την ταύτιση των ορίων - χαρακτηριστικών των δύο

επιπέδων είναι τα ακόλουθα:

∆ηµιουργία αρχείου mxd για τη φιλοξενία των επιπέδων LANDUSE_LA και LUAT 

Ορισµός µεθόδου προσαρµογής των θεµατικών επιπέδων (Βλέπε § 6.2.1)

Ορισµός ανοχής (Βλέπε § 6.2.1)

Καθορισµός περιοχής προς επεξεργασία µέσω του εργαλείου   “Limited Adjustment
Area Tool” 

Στο σηµείο αυτό ο χρήστης καλείται να ορίσει την περιοχή η οποία περιλαµβάνει

τα χαρακτηριστικά του επιπέδου LANDUSE_LA, τα οποία θα µετακινηθούν, ώστε να
ταυτιστούν µε τα χαρακτηριστικά του επιπέδου LUAT.
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iii) 



Για τον ορισµό της περιοχής αυτής γίνεται χρήση του εργαλείου “Limited
Adjustment Area Tool”     µέσα από την εργαλειοθήκη του “Spatial Adju-
stment”

Με το εργαλείο αυτό ο χρήστης
έχει τη δυνατότητα να σχεδιάσει
το πολύγωνο που επιθυµεί, κάνο-
ντας κλικ σε κάθε σηµείο και
διπλό κλικ στο τελευταίο. Το πο-
λύγωνο που σχηµατίζεται στη συγ-
κεκριµένη περίπτωση φαίνεται µε
γκρι απόχρωση στη διπλανή
εικόνα.

Εισαγωγή Displacement Links

Ακολουθεί η προσθήκη “Displacement Links” ή αλλιώς σηµείων σύνδεσης. Τα
σηµεία σύνδεσης συσχετίζουν ουσιαστικά τις συντεταγµένες του επιπέδου που
χρησιµοποιείται ως “Source Layer” και αυτού που χρησιµοποιείται ως “Target
Layer” κατά τη διαδικασία του “Spatial Adjustment”. 

Τα σηµεία, τα οποία θα χρησιµοποιηθούν ως “Displacement Links”, είναι τα
ίδια µε αυτά που χρησιµοποιήθηκαν στην ενότητα 6.1.1. Τα σηµεία αυτά παρου-
σιάζονται στην Εικόνα 6.1. Για την εισαγωγή των σηµείων αυτών χρησιµοποιείται
το εργαλείο “New Displacement Link Tool”    µέσα από την εργαλειοθήκη
“Spatial Adjustment”. Η διαδικασία ορισµού τους είναι η ίδια µε αυτή που
ακολουθήθηκε στην προηγούµενη ενότητα.

Αρχικά, ο χρήστης επιλέγει την κορυφή του χαρακτηριστικού από το θεµατικό
επίπεδο που αποτελεί το “Source Layer” και στη
συνέχεια την κορυφή του χαρακτηριστικού από
το “Target Layer”, όπως φαίνεται στη διπλανή
εικόνα.

Η ίδια διαδικασία ακολουθείται για τα υπόλοιπα
σηµεία της Εικόνας 6.1, επιλέγοντας αρχικά την
κορυφή του επιπέδου LANDUSE_LA και ορίζον-
τας ως σηµείο προορισµού την κορυφή του επι-
πέδου LUAT µέσα στα όρια του πολυγώνου.
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LANDUSE_LA



Ακολουθεί το άνοιγµα του Πίνακα συνδέσεων “Link Table” µέσω του εικονιδίου

“View Link Table” της εργαλειοθήκης “Spatial Adjustment”. Ο πίνακας
που εµφανίζεται είναι αυτός της Εικόνας 6.4.

Στον πίνακα διακρίνονται τα έξι σηµεία µε τις αρχικές συντεταγµένες, καθώς
και τις συντεταγµένες προορισµού.

Επικύρωση και αποθήκευση των αλλαγών 

Στο σηµείο αυτό ο χρήστης, έχοντας εισάγει τα σηµεία αγκίστρωσης, είναι
σε θέση να ολοκληρώσει τη διαδικασία, επιλέγοντας την εντολή “Adjust” από

το µενού της εργαλειοθήκης “Spatial Adjustment”.

Στη συνέχεια µέσα από την εργαλειοθήκη “Editor > Save Edits” αποθηκεύονται

οι αλλαγές, ενώ κάνοντας “Stop Editing” η διαδικασία ολοκληρώνεται.

Με την επικύρωση
των αλλαγών τα
“ D i s p l a c e m e n t
Links” (6 σηµεία)

µετατρέπονται σε

“Identity Links”,
όπως φαίνεται στην
Εικόνα 6.5.

Το αποτέλεσµα της διαδικασίας αποθηκεύεται στο φάκελο {...\\DATA\RESULTS\
6_RUBBERSHEET}, όπου βρίσκεται το επίπεδο LANDUSE_LA του οποίου τα όρια

µεταβλήθηκαν.
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Εικόνα 6.4.: Πίνακας Συνδέσµων (Link Table)

Εικόνα 6.5.: Πίνακας Συνδέσµων (Link Table) µετά την επικύ-
ρωση των αλλαγών

ii) 



6.3. Ένωση θεµατικών επιπέδων (Merge)

Με τη διαδικασία αυτή συνενώνονται δύο ή περισσότερα θεµατικά επίπεδα ίδιου
τύπου (π.χ. πολύγωνα), µε σκοπό τη δηµιουργία ενός νέου ενιαίου επιπέδου, το
οποίο θα περιέχει τόσο τη γεωµετρία, όσο και την περιγραφική πληροφορία των
συγχωνευµένων επιπέδων. Χρησιµοποιείται τόσο σε πολυγωνικά, όσο και σε σηµειακά
ή γραµµικά θεµατικά δεδοµένα ακόµα και για την ένωση πινάκων.

Για την ορθή ένωση των επιπέδων είναι απαραίτητη η ταύτιση των γεωµετρικών
τους στοιχείων, όπως αναφέρθηκε στο προηγούµενο υποκεφάλαιο, καθώς και η
ταύτιση των παραµέτρων των περιγραφικών τους χαρακτηριστικών.

Σ’ αυτό το εκπαιδευτικό παράδειγµα η διαδικασία της ένωσης ακολουθεί την ταύτιση
των ορίων των γειτονικών θεµατικών επιπέδων LUAT και LANDUSE_LA. 

Το πρώτο επίπεδο που θα χρησιµοποιηθεί για την ένωση ονοµάζεται LUAT και
καλύπτει το µεγαλύτερο τµήµα της περιοχής µελέτης.

Το δεύτερο επίπεδο είναι το LANDUSE_LA που προέκυψε ύστερα από την ταύ-
τιση οντοτήτων γειτονικών φύλλων χάρτη µέσω της διαδικασίας “Rubbersheet”.
(Βλέπε υποκεφάλαιο 6.2.)

Τα επίπεδα αυτά είναι αποθηκευµένα στο φάκελο {…\\DATA\BASIC\ SHAPEFILES} και
{...\\DATA\RESULTS\6_RUBBERSHEET} αντίστοιχα. Μια σχηµατική απεικόνιση της δια-
δικασίας “Merge” µεταξύ των δύο αυτών επιπέδων δίνεται στην Εικόνα 6.6.
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Εικόνα 6.6.: Σχεδιάγραµµα ένωσης θεµατικών επιπέδων

LANDUSE_LA

LUAT LANDUSE_MG



Στη συνέχεια παρατίθενται τα πεδία των πινάκων των δύο επιπέδων που πρόκειται
να ενωθούν: 

Παρατηρώντας τους δύο πίνακες γίνεται φανερό ότι και τα δύο επίπεδα έχουν τα
απαραίτητα πεδία LU_CODE και COST_HA, δηλαδή τον κωδικό χρήσης και το κό-
στος χρήσης ανά εκτάριο.

Ακολουθεί η διαδικασία της ένωσης των δύο επιπέδων µέσω της εργαλειοθήκης
“ArcToolbox > Data Management Tools > General > Merge”:

Ανοίγοντας το παράθυρο της εν-
τολής “Merge”, ο χρήστης πρέπει
να επιλέξει, αρχικά, τα επίπεδα τα
οποία επιθυµεί να ενώσει.
Στο σηµείο αυτό θα πρέπει να
ορίσει το φάκελο στον οποίο θα
αποθηκευθεί το παραγόµενο επί-
πεδο, καθώς και το όνοµά του,
όπως φαίνεται και στη διπλανή
εικόνα. 

Το όνοµα (LANDUSE_MG) που δόθηκε στο παραγόµενο θεµατικό επίπεδο προσδιο-
ρίζει την εντολή “Merge” που χρησιµοποιήθηκε. Ο φάκελος στον οποίο αποθηκεύεται

το αρχείο είναι ο ακό-
λουθος {...\\DATA\RE-
SULTS\7_MERGE}.

Παρατηρώντας τον πίνακα
του παραγόµενου επιπέδου
στην εικόνα 6.7, διαπιστώ-
νεται ότι αποτελεί το άθροι-
σµα των πεδίων των δυο
επιπέδων που ενώθηκαν. 
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Πίνακας επιπέδου LUAT
FID Shape Shape_Area Shape LU_CODE COST_HA

Πίνακας επιπέδου LANDUSE_LA
FID Shape OBJECTID ID Shape Shape_Area LU_CODE COST_HA 

Εικόνα 6.7.: Πίνακας συγχώνευσης επιπέδων



Στον πίνακα που προκύπτει υπάρχουν πεδία τα οποία δεν έχουν χρήσιµη πληροφορία
και τα οποία ο χρήστης µπορεί να τα
απενεργοποιήσει, ώστε να µην καθι-
στούν την ανάγνωση του πίνακα προ-
βληµατική. Πρόκειται για τα πεδία FID,
Shape, OBJECT_ID και ID. Μέσα από
τις ιδιότητες του επιπέδου
LANDUSE_MG µε δεξί κλικ στο επίπεδο,
ο χρήστης µπορεί να απενεργοποιήσει τα
πεδία αυτά αλλά και να µεταβάλει τη
σειρά εµφάνισης των υπόλοιπων πεδίων
µέσα από την καρτέλα “Fields”. (Βλέπε
Υποκεφάλαιο 5.6.1.). Ο τελικός πίνακας
έχει τη µορφή της παρακάτω εικόνας.

6.4. ∆ιαδικασία Dissolve

Η γεωµετρία του επιπέδου LANDUSE_MG, που προ-
έκυψε από την ένωση των δύο γειτονικών φύλλων
χάρτη επιπέδων, φαίνεται στην εικόνα που ακολουθεί. 

Στην εικόνα διακρίνεται το εξωτερικό όριο του πολυ-
γωνικού επιπέδου LANDUSE_LA µε το επίπεδο LUAT
ύστερα από την ένωση των δύο αυτών θεµατικών επι-
πέδων και τη δηµιουργία του LANDUSE_MG.

Για την εξάλειψη του ορίου αυτού θα χρησιµοποιηθεί
η εντολή “Dissolve” µέσα από την εργαλειοθήκη

“Data Management Tools > Generalization” του Arc-
Toolbox.    

Η εντολή “Dissolve” επιτυγχάνει την ενοποίηση γειτονικών πολυγώνων, τα οποία
έχουν τις ίδιες τιµές σε ένα ή περισσότερα επιλεγµένα πεδία στα περιγραφικά
τους χαρακτηριστικά.

Γι’ αυτό το σκοπό ο χρήστης θα πρέπει να ορίσει το πεδίο ή τα πεδία του πίνακα
τα οποία θα συµµετέχουν στη διαδικασία.
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Εικόνα 6.8.: Πίνακας επιπέδου LANDUSE_MG
µετά την απενεργοποίηση των µη επιθυµητών

πεδίων.



Στην περίπτωση του επιπέδου LANDUSE_MG θα αξιοποιηθούν τα πεδία LU_CODE
και COST_HA. Με βάση τις τιµές σε αυτά τα δύο πεδία γίνεται η επεξεργασία
του επιπέδου και η συνένωση των γειτονικών πολυγώνων µε κοινές τιµές. Τα πο-
λύγωνα µε διαφορετικές τιµές παραµένουν ως έχουν. 

Με την επιλογή της εντολής “Dissolve”
εµφανίζεται το παράθυρο της διπλανής
εικόνας.

Αρχικά επιλέγεται το επίπεδο που
πρόκειται να επεξεργαστεί.
Ακολουθεί η επιλογή του ονόµα-
τος του επιπέδου που θα προκύ-
ψει, καθώς και του φακέλου στον
οποίο θα αποθηκευθεί. 
Επιλέγονται τα πεδία µε βάση τα
οποία θα γίνει η συνένωση. 
Απενεργοποιείται η εντολή “Create
Multipart Features” και ενεργοποι-
είται η εντολή “Unsplit lines”.
Η διαδικασία ολοκληρώνεται µε
την εντολή “OK”.

Το αποτέλεσµα της διαδικασίας είναι το επίπεδο LANDUSE_DS, το οποίο φαίνεται
στη διπλανή εικόνα. Το επίπεδο αυτό είναι αποθηκευ-
µένο στο φάκελο {...\\DATA\RESULTS\8_DISSOLVE}.
Όπως είναι φανερό, το όριο µεταξύ των γειτονικών
επιπέδων έχει εξαλειφθεί.  

Ανοίγοντας τον πίνακα του θεµατικού επιπέδου LAN-
DUSE_DS, είναι φανερό ότι απουσιάζει το πεδίο
Shape_Area. Για τον υπολογισµό του αρκεί ο χρήστης
να επιλέξει την εργαλειοθήκη “Spatial Statistics Tools
> Utilities > Calculate Areas” µέσα από το περιβάλ-
λον του ArcToolbox. 
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Στο παράθυρο που ανοίγει ο χρήστης
καλείται να δηλώσει, αρχικά, το επίπεδο
στο οποίο επιθυµεί να αποδώσει την
τιµή της έκτασης για κάθε πολύγωνο
και στη συνέχεια το όνοµα του επιπέ-
δου που θα προκύψει.

Η ολοκλήρωση της διαδικασίας έχει ως
αποτέλεσµα ένα νέο θεµατικό επίπεδο
µε το όνοµα LANDUSE_CA το οποίο είναι αποθηκευµένο στο φάκελο ({..\\DATA\RE-
SULTS\9_CALCULATE}). Στον πίνακα του επιπέδου αυτού έχει προστεθεί µια νέα
στήλη µε την τιµή της έκτασης για κάθε εγγραφή του πίνακα (πολύγωνο). Το πεδίο
αυτό έχει την ονοµασία F_AREA αντί για Shape_Area. 

6.5. Επίλογος

Στο κεφάλαιο αυτό ολοκληρώθηκε το στάδιο της διαχείρισης των γεωγραφικών δε-
δοµένων. Η γεωγραφική βάση δεδοµένων είναι πια πλήρης και ενιαία. Στο επόµενο
κεφάλαιο αναφέρονται τα βασικότερα εργαλεία ανάλυσης του χώρου για διανυσµα-
τικά δεδοµένα. Θα χρησιµοποιηθούν για την χωροθέτηση του κτιρίου, όπως αναφέ-
ρεται στο πρώτο κεφάλαιο του βιβλίου. 
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7.1. Εισαγωγή

Η ανάλυση των δεδοµένων αποτελεί το κυριότερο στάδιο στη διαδικασία µετατροπής
των στοιχείων σε πληροφορία. 

Στο κεφάλαιο αυτό παρουσιάζονται συνοπτικά τα βασικότερα εργαλεία ανάλυσης
διανυσµατικών δεδοµένων, όπως η δηµιουργία ζώνης (Buffer), η επικάλυψη επιπέδων
(Overlay) και η επιλογή (Select) βάσει των ιδιοτήτων τους.

Για το σκοπό αυτό θα χρησιµοποιηθούν τα κριτήρια που αναφέρονται στο πρώτο
κεφάλαιο, στο πλαίσιο του εκπαιδευτικού παραδείγµατος του βιβλίου. Στόχος είναι
η βέλτιστη επιλογή της θέσης για την κατασκευή κτιρίου για έναν αναπτυξιακό
φορέα. Τα κριτήρια είναι τα ακόλουθα:

Πίνακας 7.1: Κριτήρια επιλογής.

Εξίσου σηµαντικός παράγοντας για την επιλογή της θέσης είναι και το κόστος για
την αγορά του οικοπέδου.
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7 Ανάλυση

Κριτήρια επιλογής
1. Τα εδάφη πρέπει να είναι κατάλληλα για την κατασκευή του

2. Η χρήση της γης πρέπει να είναι συµβατή µε την ανέγερσή του

3. Πρέπει να βρίσκεται τουλάχιστον 20 µέτρα µακριά απ το υπάρχον υδρογραφικό δίκτυο

4. Πρέπει να βρίσκεται το πολύ 300 µέτρα από το υπάρχον αποχετευτικό δίκτυο

5. Το συνολικό εµβαδόν του οικοπέδου πρέπει να είναι τουλάχιστον 2 στρέµµατα



Λαµβάνοντας υπόψη τα περιγραφικά χαρακτηριστικά των επιπέδων που έχει ο χρή-
στης στη διάθεσή του, τα κριτήρια εξειδικεύονται ως εξής: 

Πίνακας 7.2: Ανάλυση κριτηρίων.

Για την επίλυση του προβλήµατος, λαµβάνοντας υπόψη τα κριτήρια επιλογής της επι-
θυµητής θέσης που παρατίθενται παραπάνω, απαιτούνται συγκεκριµένες χωρικές δια-
δικασίες, τις οποίες θα πρέπει να ακολουθήσει ο χρήστης. Οι διαδικασίες αυτές
παρατίθενται στα επόµενα υποκεφάλαια. 

7.2. ∆ηµιουργία ζωνών “Buffers”

Η δηµιουργία ζώνης είναι µια από τις πιο στοιχειώδεις διαδικασίες ανάλυσης του
χώρου. Η ζώνη µπορεί να είναι είτε επιρροής είτε αποκλεισµού, ανάλογα µε το αν
το ζητούµενο είναι το εσωτερικό ή το εξωτερικό της.  

Για την επίλυση του προβλήµατος που έχει τεθεί, αρχικά, θα πρέπει να προσδιοριστεί
ζώνη αποκλεισµού απο το Υδρογραφικό δίκτυο.

7.2.1. Ζώνη αποκλεισµού 20 µέτρων από το υπάρχον υδρογραφικό δίκτυο

Με την αξιοποίηση της εντολής “Buffer” θα δηµιουργηθούν ζώνες αποκλεισµού 20

µέτρων από τα ποτάµια. Για να γίνει αυτό, ο χρήστης θα πρέπει να προσθέσει το

θεµατικό επίπεδο STREAMS που βρίσκεται στο φάκελο {...\\DATA\BASIC\SHAPEFILES},

στο περιβάλλον του ArcMap. Κατόπιν, ενεργοποιεί την εργαλειοθήκη “Analysis Tools

> Proximity > Buffer” µέσα από το περιβάλλον του ArcToolbox. Στο παράθυρο
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Ανάλυση κριτηρίων επιλογής

1. Η προτιµώµενη χρήση γης θα πρέπει να είναι «θαµνώδης έκταση»

2. Η καταλληλότητα του τύπου του εδάφους θα πρέπει να είναι: SOILS ≥ 2, µε την τιµή 3 να είναι πιο
επιθυµητή

3. ∆ηµιουργία ζώνης αποκλεισµού (Buffer) 20 µέτρων από το υδρογραφικό δίκτυο

4. ∆ηµιουργία ζώνης επιρροής (Buffer) 300 µέτρων από το υπάρχον αποχετευτικό δίκτυο

5. Το εµβαδόν της τελικής θέσης να είναι τουλάχιστον 2.000 m2



“Buffer” που εµφανίζεται, ο

χρήστης θα πρέπει να ακο-

λουθήσει τα παρακάτω βήµατα

εργασιών, όπως παρουσιάζον-

ται στην Εικόνα 7.1 που ακο-

λουθεί: 

Επιλογή του θεµατικού

επιπέδου STREAMS
Επιλογή της θέσης και

της ονοµασίας του επι-

πέδου που θα προκύψει,

STREAMS_BF {...\\DATA

\RESULTS\10_BUFFER}

Καθορισµός της απόστα-

σης µε βάση την οποία

θα δηµιουργηθεί η ζώνη αποκλεισµού (Buffer)

Καθορισµός του τύπου των πολυγώνων που προκύπτουν (επικαλυπτόµενα ή µη):

“Dissolve Type = ALL”
Ολοκλήρωση της διαδικασίας δηµιουργίας ζώνης αποκλεισµού µε την επιλογή

“ΟΚ”

Το αποτέλεσµα της δηµιουργίας ζώνης αποκλεισµού

σε απόσταση 20 µέτρων από το υδρογραφικό δί-

κτυο, εµφανίζεται στη διπλανή εικόνα. Με κίτρινο

ανοιχτό χρώµα εµφανίζονται οι ζώνες επιρροής,

ενώ µε µπλε χρώµα (γραµµή) απεικονίζεται το δί-

κτυο των ποταµών. Εποµένως, η περιοχή εκτός των

κίτρινων ζωνών πληροί το τρίτο κριτήριο.   
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Για την απεικόνιση των αποτελεσµάτων
των χωρικών διαδικασιών γίνεται χρήση
του επιπέδου TEMPLATE ({...\\DATA
\BASIC\ SHAPEFILES}) ως υπόβαθρο.

Εικόνα 7.1: ∆ηµιουργία ζώνης αποκλεισµού σε απόσταση
20 µέτρων από το υδρογραφικό δίκτυο



Ο πίνακας του θεµατικού επιπέδου STRE-
AMS_BF, ύστερα από τη δηµιουργία ζώνης
αποκλεισµού. αποτελείται από µία µόνο εγ-
γραφή, όπως φαίνεται στη διπλανή εικόνα.
Η εγγραφή αυτή αναφέρεται στις περιοχές
που αποκλείονται για τη χωροθέτηση κτιρίου. 

7.2.2. Ζώνη επιρροής 300 µέτρων από το υπάρχον αποχετευτικό δίκτυο

Αντίστοιχα είναι τα βήµατα εργασιών για τον προσδιορισµό των περιοχών εκείνων
που βρίσκονται σε απόσταση το πολύ 300 µέτρων από το υπάρχον αποχετευτικό δί-
κτυο. Αρχικά, ο χρήστης θα πρέπει να προσθέσει το θεµατικό επίπεδο SEWERS,
που βρίσκεται αποθηκευµένο στο φάκελο {...\\DATA\BASIC\SHAPEFILES}, µέσα στο

περιβάλλον του ArcMap. Στη συνέχεια ανοίγοντας την εργαλειοθήκη “Buffer” µέσα

από το περιβάλλον του ArcToolbox, ακριβώς όπως στην προηγούµενη περίπτωση
του τρίτου κριτηρίου, θα πρέπει να δηµιουργήσει µια ζώνη επιρροής 300 µέτρων
από το υπάρχον αποχετευτικό δίκτυο. 

Στο παράθυρο “Buffer” που
εµφανίζεται, ο χρήστης καλεί-
ται να ακολουθήσει τα παρα-
κάτω βήµατα εργασιών, όπως
παρουσιάζονται στην Εικόνα
7.2 που ακολουθεί:

Επιλογή του θεµατικού
επιπέδου SEWERS.
Επιλογή της θέσης και
της ονοµασίας του επιπέ-
δου που θα προκύψει. Η
ονοµασία του προκύπτον-
τος επιπέδου είναι
SEWERS_BF {...\\DATA\
RESULTS\10_BUFFER}
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Εικόνα 7.2: ∆ηµιουργία ζώνης επιρροής σε απόσταση
300 µέτρων από το αποχετευτικό.



Καθορισµός της απόστασης µε βάση την οποία θα δηµιουργηθεί η ζώνη επιρ-
ροής (Buffer). Η απόσταση αυτή είναι ίση µε 300 µέτρα.
Καθορισµός του τύπου συνένωσης: “Dissolve Type = ALL”.. Περισσότερες λε-
πτοµέρειες δίνονται στο περιβάλλον του παραθύρου.
Ολοκλήρωση της διαδικασίας δηµιουργίας ζώνης επιρροής µε την επιλογή

“ΟΚ”.

Το αποτέλεσµα της δηµιουργίας ζώνης
επιρροής απόστασης 300 µέτρων από το
υπάρχον αποχετευτικό δίκτυο, εµφανίζεται
στη διπλανή εικόνα. Με κίτρινο χρώµα εµ-
φανίζεται η ζώνη επιρροής, ενώ µε κόκ-
κινο (γραµµή) απεικονίζεται το αποχετευτικό
δίκτυο. Εποµένως. η περιοχή η οποία είναι
κατάλληλη για την κατασκευή του κτιρίου,
σ ύ µ φω ν α
µε το κριτή-
ριο 4, είναι
αυτή εντός
της ζώνης
επιρροής.

Από την παρατήρηση του πίνακα του θεµατικού επιπέ-
δου SEWERS_BF, προκύπτει ότι η ζώνη επιρροής είναι
ένα πολύγωνο.

7.3. Επιλογή οντοτήτων µε βάση τις ιδιότητές τους “Select”

Η δεύτερη διαδικασία που θα χρησιµοποιηθεί για τον προσδιορισµό της επιθυµητής
θέσης είναι η επιλογή οντοτήτων µε βάση τα περιγραφικά τους χαρακτηριστικά. 

7.3.1. Επιλογή χαρακτηριστικών του επιπέδου LANDUSE_CA

Υπάρχουν αρκετοί τρόποι επιλογής περιγραφικών χαρακτηριστικών. Στις επόµενες
παραγράφους παρουσιάζεται η απλή διαδικασία Επιλογής χαρακτηριστικών ενός πί-
νακα µε χρήση των πλήκτρων “Ctrl” και “Shift”.
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Τα βήµατα τα οποία θα πρέπει να ακολουθήσει ο χρήστης για την επιλογή συγκε-
κριµένων εγγραφών σε έναν πίνακα είναι τα ακόλουθα:

i. Άνοιγµα του πίνακα στο περιβάλλον ArcMap ({...\\DATA\RESULTS\9_CALCU-
LATE}). Στο κάτω µέρος του παραθύρου του πίνακα αναγράφονται οι συνολικές εγ-
γραφές του πίνακα. Στην περίπτωση επιλογής δύο εγγραφών, διατυπώνεται η
πληροφορία ως εξής: 2 Out of 76 Selected. Αυτό σηµαίνει  ότι από το σύνολο
των 76 εγγραφών έχουν επιλεγεί δύο από αυτές.

ii. Επιλογή εγγραφής. Η επιλογή των
εγγραφών επιτυγχάνεται µε το µαρκά-
ρισµα της εγγραφής από την γκρι πε-
ριοχή στο αριστερό τµήµα του πίνακα,
όπως φαίνεται στη διπλανή εικόνα.

iii. Επιλογή πολλών εγγραφών. Η επι-
λογή µεγάλου αριθµού εγγραφών σε
έναν πίνακα επιτυγχάνεται µε τη χρήση
των πλήκτρων “Shift” και “Ctrl”, όπως
ακριβώς γίνεται και στον Windows Ex-
plorer. 

Με το πλήκτρο “Shift” ο χρήστης είναι σε θέση να επιλέξει πολλές εγγραφές στη

σειρά. Αυτό είναι εφικτό, ακολουθώντας τα παρακάτω βήµατα:

Επιλογή της πρώτης εγγραφής από τον πίνακα (π.χ. εγγραφή µε FID = 26)

Πάτηµα του πλήκτρου “Shift” και επιλογή της τελευταίας εγγραφής από τις

επιθυµητές (π.χ. FID = 51)

Αυτοµάτως επιλέγονται όλες οι εγγραφές, µε την τιµή του πεδίου FID να κυµαίνεται

µεταξύ 26 και 51. 

Με το πλήκτρο “Ctrl” ο χρήστης έχει τη δυνατότητα να επιλέξει εγγραφές που δεν
βρίσκονται κατά αύξουσα σειρά. Για παράδειγµα, στην περίπτωση που ο χρήστης
επιθυµεί να επιλέξει τις εγγραφές µε τιµές “FID” ίσες µε 26, 28, 30, 33 και 35,
θα πρέπει να ακολουθήσει τα παρακάτω βήµατα:
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Επιλογή της πρώτης εγγραφής (όχι απα-
ραίτητα κατά αύξουσα σειρά).

Πάτηµα του πλήκτρου “Ctrl” στο πλη-
κτρολόγιο και διατηρώντας το πατηµένο,
επιλογή κάθε άλλης εγγραφής µε απλό
κλικ στην γκρι περιοχή στο αριστερό
τµήµα του πίνακα.

Το αποτέλεσµα της επιλογής θα είναι αυτό
της διπλανής εικόνας.  

Για τη διευκόλυνση της διαδικασίας της επιλογής εγγραφών ενός πίνακα, µπορεί
να γίνει χρήση των εντολών “Short Ascending” και “Short Descending”. Οι εντολές
αυτές εµφανίζονται µε δεξί κλικ σε οποιοδήποτε πεδίο του πίνακα και δίνουν τη
δυνατότητα στο χρήστη να αλλάξει τη σειρά εµφάνισης των εγγραφών του πεδίου
αυτού, είτε σε αύξουσα είτε σε φθίνουσα σειρά. Η διαδικασία αυτή µεταβάλλει τη
σειρά των εγγραφών και στα υπόλοιπα πεδία του πίνακα.

Έτσι, στην περίπτωση ενός πίνακα µε µηδενικές εγγραφές σε ένα πεδίο, ο χρήστης
µε την επιλογή οποιασδήποτε από τις εντολές αυτές θα µπορούσε να αποµονώσει
µέσα στον πίνακα τις εγγραφές αυτές και µε τη βοήθεια του πλήκτρου Shift να
είναι σε θέση να τις επιλέξει χωρίς κόπο.

Σύµφωνα µε τα παραπάνω η επιλογή των εγγραφών µε τιµή LU_CODE ίση µε 300,

που αντιστοιχεί στη θαµνώδη βλάστηση θα γίνει ακολουθώντας τα εξής βήµατα:

Άνοιγµα του πίνακα του θεµατικού επιπέδου LANDUSE_CA {..\\DATA\RESULTS\

9_CALCULATE} από το οποίο επιθυµούµε συγκεκριµένες µόνο εγγραφές.

Επιλογή µε κλικ στο όνοµα του πεδίου LU_CODE του πίνακα και µε δεξί κλικ

επιλογή της εντολής “Short Ascending”. Με τον τρόπο αυτό οι τιµές στο συγ-
κεκριµένο πεδίο θα εµφανίζονται κατά αύξουσα σειρά. 
Επιλογή της εγγραφής µε “FID = 26”, που αποτελεί την πρώτη κατά σειρά εγγραφή

µε την τιµή του LU_CODE ίση µε 300, και µε χρήση του πλήκτρου Shift επιλογή

της τελευταίας εγγραφής µε “FID = 51” (τελευταία εγγραφή µε τιµή ίση µε

LU_CODE = 300).
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Αποθήκευση των επιλεγµένων εγγραφών του πίνακα παράλληλα µε τη γεωµετρία
τους. Η αποθήκευση των επιλεγµένων εγγραφών ενός πίνακα γίνεται µέσα από
το παράθυρο του πίνακα, επιλέγοντας από τα “Table Options” στο πάνω αριστερό
τµήµα του πίνακα την εντολή “Export”. Αυτοµάτως ανοίγει ένα παράθυρο µε την
ονοµασία “Export Data”, όπου ο χρήστης ορίζει τη θέση και το όνοµα αποθή-
κευσης. Στην περίπτωση αυτή, όµως, απαιτείται η ταυτόχρονη αποθήκευση τόσο
των εγγραφών του πίνακα, όσο και της γεωµετρίας του. Αυτό είναι εφικτό µε
δεξί κλικ στο θεµατικό
επίπεδο LANDUSE_CA και
επιλογή της εντολής “Data
> Export Data”. Αυτοµάτως
ανοίγει ένα παράθυρο που
έχει τη µορφή της παρακάτω
εικόνας, στο οποίο ο χρήστης
επιλέγει ποια χαρακτηριστικά
θα εξάγει, ακολουθώντας τα
εξής βήµατα:

Επιλογή της εντολής “Ex-
port: Selected Features”.
Χρήση του ίδιου συστήµα-
τος συντεταγµένων µε το
αρχικό.
Επιλογή του εικονιδίου του
φακέλου και δηµιουργία ενός φακέλου µε την ονοµασία 11_SELECT µέσα στο
φάκελο RESULTS, στον οποίο θα αποθηκευθεί το αρχείο µε τις επιλεγµένες εγ-
γραφές (LU_CODE=300). Η ονοµασία του αρχείου είναι LANDUSE_SL.
Ολοκλήρωση της διαδικασίας µε την επιλογή
“OK”.

Με την ολοκλήρωση της διαδικασίας ο χρήστης ερωτάται
αν επιθυµεί την προσθήκη του νέου επιπέδου στη λίστα
“Layers”. Η καταφατική απάντηση του χρήστη έχει ως
αποτέλεσµα την προσθήκη του νέου επιπέδου µε την ονο-
µασία LANDUSE_SL στη λίστα αυτή.

Το αποτέλεσµα της επιλογής φαίνεται στη διπλανή εικόνα.
Οι περιοχές που απεικονίζονται µε χρώµα είναι αυτές
που χαρακτηρίζονται θαµνώδεις και η χωροθέτηση κτιρίου
είναι επιτρεπτή.
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Εικόνα 7.3: Παράθυρο εξαγωγής εγγραφών



7.3.2. Επιλογή χαρακτηριστικών του επιπέδου SOILS

Η επιλογή των χαρακτηριστικών του επιπέδου SOILS µε τιµή SUIT µεγαλύτερη ή/και
ίση µε 2 θα γίνει µε τη χρήση της εντολής “Select By Attribute”. Με την εντολή
αυτή ο χρήστης έχει τη δυνατότητα να επιλέξει συγκεκριµένες εγγραφές από τον
πίνακα του θεµατικού επιπέδου που επιθυµεί, χωρίς να ανοίξει τον πίνακα. Αρκεί
µονάχα να γνωρίζει τα πεδία µε βάση τα οποία επιθυµεί να γίνει η επιλογή πε-
ριοχών και τις επιθυµητές τιµές των πεδίων αυτών. Στο πλαίσιο του συγκεκριµένου
εκπαιδευτικού παραδείγµατος ο χρήστης καλείται να επιλέξει τις περιοχές που ικα-
νοποιούν το κριτήριο: “SUIT ≥ 2”.

Η επιλογή είναι εφικτή µε την εντολή Select By Attribute µέσα από το βασικό
µενού: “Selection > Select By Attribute”,, ακολουθώντας τα εξής βήµατα εργασιών:

Επιλογή του θεµατικού επιπέδου από το οποίο επιθυµεί ο χρήστης να γίνει η
επιλογή συγκεκριµένων χαρακτηριστικών. Πρόκειται για το επίπεδο SOILS που
είναι αποθηκευµένο στο φάκελο {...\\DATA\BASIC\ SHAPEFILES}.
Επιλογή της µεθοδολογίας που θα χρησιµοποιηθεί (Create a new selection).
Επιλογή του πεδίου (ή των πεδίων)  µε βάση το οποίο θα γίνει η αναζήτηση
των επιθυµητών χαρακτηριστικών. Το πεδίο
του πίνακα είναι το SUIT και η επιλογή
γίνεται µε διπλό κλικ πάνω στο όνοµά του.
Αυτοµάτως, το πεδίο εισάγεται στο κάτω
µέρος του παραθύρου, όπου συντάσσεται
η εντολή µε βάση την οποία θα γίνει η
αναζήτηση.
Επιλογή του τελεστή που ικανοποιεί το κρι-
τήριο επιλογής. Ο τελεστής που θα χρησι-
µοποιηθεί είναι: “ ≥ ” και η εισαγωγή
του στο πλαίσιο σύνταξης του κριτηρίου
επιλογής γίνεται µε απλό κλικ.
Εµφάνιση των τιµών του πεδίου µε την
επιλογή της εντολής “Get Unique Values”.
Η τιµή που ικανοποιεί το κριτήριο είναι το
«2». Η εισαγωγή της τιµής γίνεται µε
διπλό κλικ. 
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Ανάγνωση του κριτηρίου που συντάχθηκε. Η ανάγνωση έχει ως εξής: Επιλογή
χαρακτηριστικών από το θεµατικό επίπεδο SOILS, όπου το πεδίο SUIT έχει
τιµές µεγαλύτερες ή /και ίσες του ”2”.  Στην περίπτωση λάθους σύνταξης του
κριτηρίου µε την επιλογή “Clear”, επιτυγχάνεται η διαγραφή του και ο χρήστης
είναι σε θέση να συντάξει εκ νέου το ερώτηµά του.
Ολοκλήρωση της επιλογής µε την επιλογή “ΟΚ”.

Η ολοκλήρωση της διαδικασίας έχει ως αποτέλεσµα την επιλογή των περιοχών που
ικανοποιούν το παραπάνω κριτήριο. Για να είναι µό-
νιµο το αποτέλεσµα της επιλογής θα πρέπει ο χρή-
στης να ακολουθήσει το τέταρτο βήµα της
προηγούµενης ενότητας (7.3.1), ώστε να γίνει η απο-
θήκευση των περιοχών αυτών σε ένα νέο αρχείο µε
την ονοµασία SOILS_SL (…\\DATA\RESULTS\11_SE-
LECT). Ακολουθεί η προσθήκη του νέου αυτού θεµα-
τικού επιπέδου στον Πίνακα Περιεχοµένων / Layers
του αρχείου .mxd. 

Το παραγόµενο θεµατικό επίπεδο SOILS_SL φαίνεται
στη διπλανή εικόνα. 

7.4. Επικάλυψη επιπέδων “Overlay”

Μετά τον προσδιορισµό των ζωνών επιρροής και αποκλεισµού, και την επιλογή  των

οντοτήτων σύµφωνα µε τις ιδιότητες τους, ακολουθεί το σηµαντικότερο ίσως βήµα στη

διαδικασία προσδιορισµού της τελικής θέσης, η επικάλυψη επιπέδων. Υπάρχουν διάφορες

παραλλαγές της διαδικασίας επικάλυψης επιπέδων. Η ένωση αποτελεί  την πιο γενική

της µορφή (Union).

Η ένωση δύο ή περισσότερων θεµατικών επιπέδων αποτελεί µια χωρική διαδικασία,
κατά την οποία προκύπτει ένα νέο θεµατικό επίπεδο, το οποίο αποτελεί την ένωση
τόσο των γεωµετρικών, όσο και των περιγραφικών χαρακτηριστικών των επιπέδων
που ενώνονται. Επίσης, το όριο του νέου επιπέδου είναι το υπερσύνολο των ορίων
των επιπέδων που ενώνονται. Η σχηµατική απεικόνιση της χωρικής αυτής διαδικασίας
αποδίδεται στην εικόνα 7.5. 
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7.4.1. Τοµή επιπέδων “Intersect” 

Εκτός της ένωσης στην επικάλυψη πολυγώνων, εναλλακτικές αποτελούν η διαδικασία

της Ταυτότητας (Identity) και της Τοµής (Intersect). Η χωρική διαδικασία της τοµής

ενός πολυγωνικού επιπέδου µε ένα άλλο επίπεδο, το οποίο εκτός από πολυγωνικό

µπορεί να είναι γραµµικό ή σηµειακό, έχει ως αποτέλεσµα ένα νέο θεµατικό πο-

λυγωνικό επίπεδο, του οποίου το γεωµετρικό όριο είναι η τοµή των αρχικών επι-

πέδων, όπως φαίνεται στη σχηµατική απεικόνιση της εικόνας 7.4. που ακολουθεί.

Εικόνα 7.4: Σχηµατική απεικόνιση του τρόπου λειτουργίας των χωρικών διαδικασιών Union και

Intersect

Η χωρική διαδικασία “Intersect” θα χρησιµοποιηθεί για τo συνδυασµό των επιπέδων

LANDUSE_SL και SOILS_SL που προέκυψαν απο το προηγούµενο στάδιο. Η διαδι-

κασία της Τοµής είναι πιο κατάλληλη απο τη διαδικασία της Ένωσης, µια και είναι

χρήσιµη µόνο η κοινή περιοχή των δύο επιπέδων.

Συγκεκριµένα, ο χρήστης, αφού προσθέσει τα δύο παραπάνω θεµατικά επίπεδα στο

περιβάλλον του ArcMap, είναι αναγκαίο στη συνέχεια να εµφανίσει το παράθυρο

της εντολής ”Intersect” µέσα από το περιβάλλον του ArcToolbox (“Analysis Tools

> Overlay > Intersect”). Τα βήµατα εργασιών που θα πρέπει να ακολουθήσει ο

χρήστης για τη συνένωση των δύο θεµατικών επιπέδων είναι τα εξής:
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Εισαγωγή των επιπέδων που

θα συνενωθούν (Input Fea-

tures). Πρόκειται για τα επί-

πεδα LANDUSE_SL και

SOILS_SL (…\\DATA\RE-

SULTS\ 11_SELECT}. 
Επιλογή της θέσης και της
ονοµασίας του παραγόµενου
θεµατικού επιπέδου. Το πα-
ραγόµενο θεµατικό επίπεδο
ονοµάζεται LANDUSE_IN και
αποθηκεύεταιι στο φάκελο
{…\\DATA\RESULTS\12_INTER-
SECT}.
∆ιατήρηση των υπόλοιπων
προεπιλεγµένων παραµέτρων.
Ολοκλήρωση της διαδικα-
σίας της συνένωσης των
δύο επιπέδων µε την επιλογή “ΟΚ”.

Το αποτέλεσµα της χωρικής διαδικασίας “Intersect”
παρουσιάζεται στη διπλανή εικόνα. ∆ιακρίνεται η τοµή
των γεωµετρικών χαρακτηριστικών των δύο επιπέδων. 

Εικόνα 7.6: Πίνακας θεµατικού επιπέδου LANDUSE_IN

Παρατηρώντας τον πίνακα της εικόνας 7.6,  ο χρήστης διαπιστώνει την ένωση της
περιγραφικής πληροφορίας των δύο επιπέδων και πιο συγκεκριµένα, τα πεδία SUIT
και LU_CODE, COST_HA.  
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Εικόνα 7.5: Παράθυρο χωρικής διαδικασίας Intersect



7.4.2. ∆ιαγραφή επιπέδων “Erase”

Παρατηρώντας τα επίπεδα SEWERS_BF και STREAMS_BF και λαµβάνοντας υπόψη
ότι οι περιοχές που πληρούν τα κριτήρια είναι η εσωτερική στο πρώτο επίπεδο και
η εξωτερική στο δεύτερο, διαπιστώνεται ότι είναι δυνατό να χρησιµοποιηθεί µια δια-
δικασία για να σβηστούν τα χαρακτηριστικά του πρώτου επιπέδου µε βάση το δεύ-
τερο.

Εικόνα 7.7: Σχηµατική απεικόνιση του τρόπου λειτουργίας της χωρικής διαδικασίας Erase

Η διαδικασία αυτή είναι η “Erase”. Η διαγραφή θεµατικών επιπέδων αποτελεί µια
εξειδίκευση της χωρικής διαδικασίας της επικάλυψης. Χρησιµοποιείται για τη δια-
γραφή χαρακτηριστικών ενός θεµατικού επιπέδου µε τη χρήση ενός άλλου επιπέδου
που παίζει το ρόλο της «γόµας».  

Συγκεκριµένα, κατά τη διαδικασία αυτή, ο χρήστης θα πρέπει να αφαιρέσει από το
θεµατικό επίπεδο SEWERS_BF τα χαρακτηριστικά που ορίζονται από το θεµατικό
επίπεδο STREAMS_BF. Για να το επιτύχει αυτό, ο χρήστης θα ανοίξει το παράθυρο
της εντολής ERASE_BF µέσα από το περιβάλλον του ΑrcΤoolbox, και συγκεκριµένα,
επιλέγοντας “Analysis Tools > Overlay > Erase”. Με το άνοιγµα του παραθύρου
της χωρικής αυτής διαδικασίας, τα βήµατα εργασιών που πρέπει να ακολουθήσει ο
χρήστης είναι τα ακόλουθα:
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Επιλογή του θεµατικού επιπέδου SEWERS_BF ({...\\DATA\RESULTS\10_BUFFER})
που θα χρησιµοποιηθεί ως βάση (Input Features).
Επιλογή του θεµατικού επιπέδου STREAMS_BF ({...\\DATA\RESULTS\10_BUFFER})

µε βάση το οποίο θα πραγµατοποιηθεί η διαδικασία “Erase” (Erase Features)
Επιλογή της θέσης και της ονοµασίας του παραγόµενου θεµατικού επιπέδου.
Το παραγόµενο θεµατικό επίπεδο ονοµάζεται ERASE_BF {… \\DATA\RESULTS\
13_ERASE}.
Ολοκλήρωση της χωρικής διαδικασίας µε την επιλογή “ΟΚ”.

Αυτό έχει ως αποτέλεσµα ένα νέο θεµατικό επίπεδο, το οποίο ικανοποιεί τη συνθήκη

η ζητούµενη περιοχή να είναι σε απόσταση το πολύ 300 µέτρα από το αποχετευτικό

και τουλάχιστον 20 µέτρα µακριά από το υπάρχον

υδρογραφικό δίκτυο. 

Σύµφωνα µε τον πίνακα του επιπέδου που προέκυψε,

ύστερα από τη διαδικασία Erase, παρατηρείται ότι η

περιοχή αποτελεί ένα πολύγωνο. Η αναζήτηση της ιδα-

νικής περιοχής για την κατασκευή κτιρίου περιορίζεται

στην περιοχή του επιπέδου ERASE_BF.   

7.4.3. ∆ιαδικασία τοµής επιπέδων “Intersect”

Η χωρική αυτή διαδικασία θα χρησιµοποιηθεί και πάλι για τον προσδιορισµό των

κοινών περιοχών των επιπέδων LANDUSE_ΙΝ, του αποτελέσµατος της τοµής, και

ERASE_BF, του αποτελέσµατος της αφαίρεσης. Το αποτέλεσµα θα ικανοποιεί όλα

τα κριτήρια που έχουν τεθεί, δηλαδή η περιοχή να βρίσκεται σε απόσταση όχι µε-

γαλύτερη από 300 µέτρα από το αποχετευτικό, σε µεγαλύτερη από 20 µέτρα από-

σταση από το υδρογραφικό, ενώ ταυτόχρονα η καταλληλότητα να είναι µεγαλύτερη

ή / και ίση µε 2 και η χρήση της γης να είναι θαµνώδης.  

Για να γίνει αυτό, ο χρήστης καλείται αρχικά να προσθέσει τα δύο παραπάνω θε-

µατικά επίπεδα στο περιβάλλον του ArcMap και στη συνέχεια να εµφανίσει το πα-
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ράθυρο της εντολής “Intersect” µέσα από το περιβάλλον του ArcToolbox (“Analysis

Tools > Overlay > Intersect”). Τα βήµατα εργασιών που θα πρέπει να ακολουθήσει

ο χρήστης για τη συνένωση των δύο θεµατικών επιπέδων είναι τα εξής:

Εισαγωγή των επιπέδων

που θα συνενωθούν

(Input Features). Πρόκειται

για τα επίπεδα LAN-
DUSE_ΙΝ και ERASE_BF. 
Επιλογή της θέσης και

της ονοµασίας του πα-

ραγόµενου θεµατικού

επιπέδου. Το παραγόµενο

θεµατικό επίπεδο ονοµά-

ζεται LANDUSE_IN2 και
βρίσκεται στο φάκελο {…

\ \ D A T A \ R E S U L T S \

12_INTERSECT}

∆ιατήρηση των υπόλοι-

πων προεπιλεγµένων πα-

ραµέτρων.

Ολοκλήρωση της διαδικασίας της συνένωσης των δύο επιπέδων µε την επιλογή

“ΟΚ”..

Το αποτέλεσµα της χωρικής διαδικασίας “Intersect”
παρουσιάζεται στη διπλανή εικόνα. Οι περιοχές αυτές

ικανοποιούν ταυτόχρονα όλα τα κριτήρια που έχουν

τεθεί, εκτός απο το κριτήριο του ελάχιστου εµβαδού

και του κόστους αγοράς. 

Στη συνέχεια παρουσιάζεται ο πίνακας του θεµατικού

επιπέδου LANDUSE_IN2 που προέκυψε, ύστερα από τη
διαδικασία της τοµής των δύο επιµέρους θεµατικών

επιπέδων.
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Εικόνα 7.8: Παράθυρο χωρικής διαδικασίας Intersect



Εικόνα 7.9: Πίνακας θεµατικού επιπέδου LANDUSE_IN2

Η µεθοδολογία που ακολουθήθηκε για τον προσδιορισµό των περιοχών µε τα κρι-
τήρια που τέθηκαν, παρουσιάζεται στο επόµενο λογικό διάγραµµα.
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7.5. ∆ιαδικασίες διαχείρισης των αποτελεσµάτων

Στο επίπεδο LANDUSE_IN2, το οποίο έχει προκύψει από τις διαδικασίες χωρικής
ανάλυσης, υπάρχουν κάποια προβλήµατα που πρέπει να αντιµετωπιστούν. Το πρώτο
είναι ότι το κάθε πολύγωνο δεν αποτελεί µια οντότητα στον πίνακα περιγραφικών
χαρακτηριστικών και, επίσης, ότι το εµβαδόν της οντότητας δεν είναι σωστό και
πρέπει να ενηµερωθεί. 

Για τη µετατροπή µιας οντότητας που αποτελείται από πολλά πολύγωνα σε ένα πο-
λύγωνο ανά οντότητα, ακολουθείται η διαδικασία “Multipart to Singlepart”.

7.5.1. ∆ιαδικασία “Multipart to Singlepart”

Η διαδικασία αυτή θα εφαρµοστεί στο θεµατικό επίπεδο LANDUSE_IN2, το οποίο
προέκυψε, ύστερα από τη χωρική διαδικασία “Intersect” στο προηγούµενο υποκεφά-
λαιο. Ο χρήστης, αφού προσθέσει το παραπάνω θεµατικό επίπεδο στο περιβάλλον
του ArcMap, είναι σε θέση να εκκινήσει τη διαδικασία µετατροπής, εµφανίζοντας
το παράθυρο της εντολής “Multipart to Singlepart” (“ArcToolbox: Data Management
Tools > Features > Multi-
part to Singlepart”). Μέσα
από το παράθυρο της εντο-
λής ο χρήστης καλείται να
εισάγει το θεµατικό επίπεδο
το οποίο επιθυµεί να επεξερ-
γαστεί (LANDUSE_IN2, το
επίπεδο αυτό πρέπει να είναι
επιλεγµένο στον πίνακα πε-
ριεχοµένων) και στη συνέ-
χεια να επιλέξει τη θέση και
την ονοµασία του παραγόµενου θεµατικού επιπέδου, όπως φαίνεται στην εικόνα
7.10. Τo αρχείο που προκύπτει από τη διαδικασία αυτή ονοµάζεται LANDUSE_SP
και βρίσκεται στο φάκελο {…\\DATA\RESULTS\14_TO SINGLEPART}

Ο πίνακας του θεµατικού επιπέδου LANDUSE_SP αποτελείται από 16 εγγραφές, ενώ
ο πίνακας του επιπέδου LANDUSE_ΙΝ2 από 13. Έτσι, το κάθε πολύγωνο είναι µια
οντότητα.
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Εικόνα 7.10: Παράθυρο διαδικασίας Multipart to Singlepart



7.5.2 Υπολογισµός εµβαδού “Calculate Areas”

Ο υπολογισµός του εµβαδού για κάθε τµήµα του θεµατικού επιπέδου LANDUSE_SP
που προέκυψε από το προηγούµενο στάδιο είναι απαραίτητος. Ο υπολογισµός της
έκτασης που καλύπτει κάθε
τµήµα γης θα συµβάλλει
στον µετέπειτα υπολογισµό
του κόστους αγοράς και
στην τελική επιλογή του
καταλληλότερου οικονοµικά
τµήµατος γης για την κα-
τασκευή του κτιρίου.

Ο υπολογισµός είναι εφι-
κτός µέσα από το περι-
βάλλον του ArcToolbox (“Spatial Statistics Tools > Utilities > Calculate Areas”).
Με την εµφάνιση του παραθύρου Calculate Areas ο χρήστης καλείται αρχικά να ει-
σάγει το θεµατικό επίπεδο για το οποίο επιθυµεί να υπολογίσει την έκταση κάθε
εγγραφής στον πίνακα. Ακολουθεί η επιλογή της θέσης και της ονοµασίας που θα
δοθεί στο παραγόµενο επίπεδο (LANDUSE_CA2 {…\\DATA\ RESULTS\9_CALCULATE})

Κατά την ολοκλήρωση του υπολογισµού ο χρήστης θα πρέπει να φορτώσει το πα-
ραγόµενο θεµατικό επίπεδο το οποίο είναι αποθηκευµένο στον παραπάνω χώρο. Το
αποτέλεσµα του παραπάνω υπολογισµού είναι η προσθήκη ενός νέου πεδίου στον
πίνακα του επιπέδου µε την ονοµασία F_AREA. Το πεδίο αυτό περιέχει την τιµή του
εµβαδού για κάθε µία από τις 16 εγγραφές του πίνακα. 

7.5.3. Επιλογή περιοχών µε εµβαδό > 2.000 m2.

Από τη στιγµή που οι περιοχές πληρούν τα υπόλοιπα κριτήρια, ο χρήστης έχει τη
δυνατότητα να επιλέξει το τµήµα γης το οποίο είναι πάνω από 2.000m2. Αυτό είναι
εφικτό µε τη χρήση του εργαλείου “Select” µέσα από το περιβάλλον του ArcToolbox,
και συγκεκριµένα, µέσα από την εργαλειοθήκη “Analysis Tools > Extract > Select”.
Η επιλογή της εντολής αυτής έχει ως αποτέλεσµα το άνοιγµα ενός παραθύρου,
όπως φαίνεται στην εικόνα 7.12. 
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Εικόνα 7.11: Παράθυρο διαδικασίας Calculate Areas



Τα βήµατα εργασιών τα οποία καλείται ο χρήστης να ακολουθήσει είναι τα εξής:
Εισαγωγή του θεµατικού επιπέδου το οποίο θα χρησιµοποιηθεί για την επιλογή.
Πρόκειται για το επίπεδο LANDUSE_CA2 για το οποίο έχει υπολογιστεί η
έκταση κάθε τµήµατος γης που εµπεριέχει.
Επιλογή της θέσης αποθήκευσης και της ονοµασίας που θα δοθεί στο παρα-
γόµενο θεµατικό επίπεδο. Το παραγόµενο θεµατικό επίπεδο ονοµάζεται
FINALAREAS και είναι αποθηκευµένο στο φάκελο {...\\DATA\RESULTS\11_SELECT}.
Επόµενο βήµα είναι η χρήση “SQL Expression” για τη διατύπωση του ερωτήµατος,
µε βάση το οποίο θα προκύψουν οι προτεινόµενες θέσεις που θα πληρούν τα
κριτήρια αυτά. Η επιλογή του εικονιδίου     έχει
ως αποτέλεσµα το άνοιγµα ενός νέου παραθύρου
στο οποίο ο χρήστης θα πρέπει να ορίσει τα
ερωτήµατα επιλογής.

Το παράθυρο “Query Builder”, που εµφανίζεται κατά
την επιλογή του εικονιδίου “SQL”, δίνεται στη διπλανή
εικόνα. Η σύνταξη του ερωτήµατος έχει ως εξής. Ο
χρήστης θα πρέπει να επιλέγει πρώτα το πεδίο το
οποίο θα χρησιµοποιείται στο ερώτηµα, κατόπιν τον
τελεστή, µε τη βοήθεια του οποίου θα εκτελείται, και
ύστερα την τιµή του πεδίου που είναι επιθυµητή. 

Αυτό έχει ως αποτέλεσµα το ερώτηµα το οποίο εµφανίζεται στην παραπάνω εικόνα
που είναι της µορφής : “F_AREA” >= 2644.6438657.

Η εκτέλεση του παραπάνω ερωτήµατος έχει ως αποτέ-
λεσµα την επιλογή οχτώ συνολικά περιοχών, οι οποίες
ικανοποιούν τα επιθυµητά κριτήρια για την κατασκευή και ανέγερση  κτιρίου.
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Εικόνα 7.12: Παράθυρο διαδικασίας Select



Ο πίνακας του θεµατικού επιπέδου FINALAREAS µε τις επιθυµητές περιοχές ύστερα
από τη διαγραφή των περιττών στηλών του πίνακα (Shape, FID_ERASE, Id,
FID_LAND_1, FID_SOILS_, SOIL_CODE, Shape_Leng, Shape_Area, ORIG_FID) ακολου-
θώντας τα βήµατα του Υποκεφαλαίου 5.6.2., φαίνεται στην εικόνα 7.13.

Τα συµπεράσµατα στα οποία καταλήγει
κανείς παρατηρώντας τον πίνακα του
επιπέδου είναι τα εξής:

Μόνο ένα πολύγωνο έχει τη µέγιστη
καταλληλότητα εδάφους (τρία), µε τα
υπόλοιπα εφτά πολύγωνα να έχουν κα-
ταλληλότητα ίση µε δύο, ενώ το κόστος
αγοράς θα υπολογιστεί στο επόµενο

βήµα.

7.5.4. Υπολογισµός κόστους αγοράς συνολικής έκτασης

Λαµβάνοντας υπόψη τα δεδοµένα του παραπάνω πίνακα (εικόνα 7.13), ο χρήστης

καλείται να υπολογίσει το κόστος αγοράς κάθε τεµαχίου γης (πολυγώνου), το οποίο

έχει διαφορετική χρήση και έκταση. 

Το πρώτο στάδιο της διαδικασίας υπολογισµού είναι η αναγνώριση των πεδίων

που θα χρησιµοποιηθούν για τον υπολογισµό. Τα πεδία αυτά είναι: 

COST_HA: Κόστος / Ha
F_AREA : Έκταση κάθε πολυγώνου σε m2

Το δεύτερο στάδιο περιλαµβάνει τη δηµιουργία ενός νέου πεδίου στον πίνακα του

τελικού µας επιπέδου FINALAREAS (Βλέπε υποκεφάλαιο 5.2.1.). Στο πεδίο αυτό µε
όνοµα “ΤΟΤ_COST” θα αποθηκευθεί το αποτέλεσµα του υπολογισµού για το συνο-

λικό κόστος κάθε πολυγώνου (εγγραφής του πίνακα). 

Το τρίτο στάδιο περιλαµβάνει τον καθορισµό των παραµέτρων του πεδίου. Για τον
ορισµό των παραµέτρων αυτών επιβάλλεται η αναγνώριση των παραµέτρων των πε-
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Εικόνα 7.13: Πίνακας θεµατικού επιπέδου
FINALAREAS µε τις επιθυµητές περιοχές



δίων που θα χρησιµοποιηθούν στον υπολογισµό. Αυτό επιτυγχάνεται µε “«∆εξί κλικ
> Properties”» σε κάθε ένα από αυτά τα πεδία του πίνακα. Οι παράµετροι των πε-
δίων φαίνονται στον πίνακα που ακολουθεί: 

Πίνακας 7.3: Πίνακας µε τις παραµέτρους των πεδίων

Τo τέταρτο στάδιο περιλαµβάνει τη διαδικασία υπο-
λογισµού. Τα βήµατα που θα πρέπει να ακολουθήσει
ο χρήστης για την απόδοση της τιµής του συνολικού
κόστους αγοράς κάθε τεµαχίου γης είναι τα εξής:

∆εξί κλικ στο νέο πεδίο του πίνακα, µε όνοµα “
ΤΟΤ_COST ”, και επιλογή της εντολής “Field Calcu-
lator”, όπως φαίνεται στη διπλανή εικόνα. 

Με την επιλογή της εντολής αυτής αυτοµάτως ανοίγει
ένα πα-
ράθυρο
σ τ ο
οποίο ο
χρήστης µπορεί να επιλέξει τα πεδία,
µε βάση τα οποία θα υπολογίσει την
τιµή του κόστους για κάθε εγγραφή. 

Στο πάνω αριστερό µέρος του παραθύ-
ρου δίνονται όλα τα πεδία που έχει
στη διάθεσή του ο χρήστης για τον
υπολογισµό. 

Γίνεται αντιληπτό ότι ο χρήστης θα πρέ-
πει να ορίσει τη µέθοδο υπολογισµού,
επιλέγοντας τα απαραίτητα πεδία και
τους σωστούς τελεστές. 
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Όνοµα Πίνακα Όνοµα πεδίου Τύπος πεδίου Data Precision

FINALAREAS

F_Area Double 0

COST_HA Short Integer 5

ΤΟΤ_COST (Νέο πεδίο) Double 0 



Στο δεξί τµήµα εµφανίζονται οι τύποι υπολογισµού (Numeric, String, Date), οι λει-
τουργίες υπολογισµού, καθώς και οι τελεστές (*, /, &. +, κ.ά.). 

Στο κάτω τµήµα του παραθύρου εµφανίζεται η εντολή του υπολογισµού “TOT_COST
= ”. Το κόστος ισούται γενικά µε την έκταση επί το κόστος της έκτασης. Λαµβά-
νοντας υπόψη ότι ένα εκτάριο αντιστοιχεί σε 10.000 µ2., η εντολή θα έχει την εξής
έκφραση: TOT_COST = [Shape_Area] / 10.000 * [COST_HA].

Ο πίνακας που προκύπτει, ύστερα από τον υπολογισµό του κόστους για κάθε πο-
λύγωνο, παρουσιάζεται στην εικόνα 7.14. Από τον πίνακα αυτόν έχουν εξαιρεθεί
διάφορα πεδία τα οποία δεν έχουν καµία σηµασία στο στάδιο αυτό. Αυτό είναι
εφικτό µέσα από τις “Ιδιότητες/ Properties” του θεµατικού επιπέδου και την καρτέλα
“Fields” (Βλέπε υποκεφάλαιο 5.6.1.: Απενεργοποίηση Πεδίου και αλλαγή θέσης στον
πίνακα).

Στον πίνακα περιγραφικής πληροφο-
ρίας της εικόνας 7.14 υπάρχει πλέον
το κόστος ανά τεµάχιο γης µε εµ-
βαδόν µεγαλύτερο απο 2 στρέµµατα,
στην περίπτωση της αγοράς ολόκλη-
ρου του αγροτεµαχίου. Στην περί-
πτωση της αγοράς έκτασης µόνο 2
στρεµµάτων, θα πρέπει να ακολουθη-
θεί η διαδικασία που περιγράφεται
στην επόµενη παράγραφο.

7.5.5. Υπολογισµός Κόστους Αγοράς έκτασης 2.000 m2

Λαµβάνοντας υπόψη τα δεδοµένα του παραπάνω πίνακα, ο χρήστης καλείται να υπολογίσει το
κόστος αγοράς του τεµαχίου γης προς αγορά (πολυγώνου), το οποίο έχει έκταση 2.000 m2.

Το πρώτο στάδιο της διαδικασίας υπολογισµού είναι η αναγνώριση των πεδίων
που θα χρησιµοποιηθούν για τον υπολογισµό. Τα πεδίο αυτά είναι: 
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Για την επιλογή ενός πεδίου απαιτείται διπλό αριστερό κλικ, ενώ για την
επιλογή ενός τελεστή αρκεί µονάχα ένα αριστερό κλικ στο mouse.

Εικόνα 7.14: Τελικός πίνακας επιπέδου
FINALAREAS



COST HA: Κόστος / Ha
F_AREA : Έκταση κάθε πολυγώνου σε m2

Το δεύτερο στάδιο περιλαµβάνει τη δηµιουργία ενός νέου πεδίου στον πίνακα του
τελικού µας επιπέδου FINALAREAS (Βλέπε υποκεφάλαιο 5.3.). Στο πεδίο αυτό µε
όνοµα “COST” θα αποθηκευθεί το αποτέλεσµα του υπολογισµού. 

Το τρίτο στάδιο περιλαµβάνει τον καθορισµό των παραµέτρων του πεδίου, ακολου-
θώντας την ίδια διαδικασία µε το υποκεφάλαιο 7.5.4. Οι παράµετροι των πεδίων
φαίνονται στον πίνακα που ακολουθεί:

Πίνακας 7.4: Πίνακας µε τις παραµέτρους των πεδίων

Τo τέταρτο στάδιο περιλαµβάνει τη διαδικασία υπολογισµού. Αυτό είναι δυνατό µε
δεξί κλικ στο νέο πεδίο του πίνακα, µε όνοµα COST, και επιλογή της εντολής “Field
Calculator” (Βλέπε υποκεφάλαιο 7.5.4.). 

Στο κάτω τµήµα του παραθύρου εµφα-
νίζεται η εντολή του υπολογισµού “
COST =”. Το κόστος ισούται γενικά µε
την έκταση επί το κόστος της έκτασης.
Λαµβάνοντας υπόψη ότι ένα εκτάριο αν-
τιστοιχεί σε 10.000 m2 και ότι το ζητού-
µενο εµβαδόν είναι 2.000 m2, η εντολή
θα έχει την εξής έκφραση: COST =
[2000 / 10.000 * [CostHa].

Με την ολοκλήρωση του υπολογισµού
αυτόµατα το πεδίο COST του πίνακα
ενηµερώνεται µε τα αποτελέσµατα.
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Όνοµα Πίνακα Όνοµα πεδίου Τύπος πεδίου Data Precision

FINALAREAS

F_Area Double 0

COST_HA Short Integer 5

COST (Νέο πεδίο) Double 0 



Ο πίνακας που προκύπτει, ύστερα από τον υπολογισµό του κόστους για κάθε αγρο-
τεµάχιο, αλλά και για ένα τµήµα του έκτασης δυο στρεµµάτων και την απόκρυψη
των πεδίων που δεν είναι χρήσιµα, είναι ο εξής:

7.6. Επιλογή της τελικής θέσης χωροθέτησης

Θα πρέπει να σηµειωθεί ότι η µεθοδολογία χωροθέτησης µιας δραστηριότητας µε
τη χρήση των εργαλείων που περιγράφονται σε αυτό το κεφάλαιο είναι επαναληπτική.
Ο χρήστης επαναλαµβάνει τη διαδικασία, όσες φορές χρειάζεται, µε διαφορετικές
αποστάσεις στις ζώνες επιρροής και αποκλεισµού, ώστε να φτάσει σε ικανοποιητικό
αριθµό κατάλληλων περιοχών. Ανάλογα µε τα κριτήρια και τις αποστάσεις, τις επι-
θυµητές χρήσεις, το εµβαδόν κτλ, µπορούν να προκύψουν αρκετές περιοχές ή και
καµία. Μετά το πέρας της διαδικασίας, όταν ο αριθµός των περιοχών κριθεί ικα-
νοποιητικός, τότε µπορούν να αξιοποιηθούν και άλλα κριτήρια, τα οποία δεν λήφθη-
καν υπόψη εξαρχής.

Στην περίπτωση µας, µετά την επενέργεια όλων των κριτηρίων, προκύπτουν τελικά
8 υποψήφιες περιοχές. Ο αριθµός αυτός κρίνεται διαχειρίσιµος. Τα επιπλέον κρι-
τήρια για την επιλογή της καταλληλότερης θέσης για την κατασκευή κτιρίου του ανα-
πτυξιακού φορέα θα µπορούσαν να είναι τα εξής:

Απόσταση από οδικό δίκτυο 
Απόσταση απο αστική περιοχή για τον περιορισµό των εξόδων µετακίνησης
και µεταφοράς
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Εικόνα 7.15.: Τελικός πίνακας επιπέδου FINALAREAS



Σε συνδυασµό µε τα υπάρχοντα κριτήρια:

Καταλληλότητα εδάφους 
Κόστος 

Παρατηρώντας τον πίνακα της εικόνας 7.15 του θεµατικού επιπέδου FINALAREAS,
που περιλαµβάνει τις πιθανές περιοχές προς χωροθέτηση, µόνο ένα πολύγωνο πα-
ρουσιάζει τη µέγιστη καταλληλότητα εδάφους που ισούται µε 3. Το κόστος αγοράς
οικοπέδου δυο στρεµµάτων στην έκτασή του ανέρχεται στις 3,000 €, ένα ποσό που
κινείται στο µέσο όρο. Αποµένει ο έλεγχος της θέσης του οικοπέδου στην ευρύτερη
περιοχή µελέτης, ώστε το κόστος µεταφοράς να είναι χαµηλό και να βρίσκεται
κοντά σε αστική περιοχή. 

Για την τελική επιλογή χρειαζόµαστε τεχνικές χαρτογραφικής απεικόνισης των δε-
δοµένων, οι οποίες καλύπτονται στο επόµενο κεφάλαιο. Γι’ αυτό το λόγο η τελική
επιλογή θα γίνει στο τέλος του επόµενου κεφαλαίου. 

7.7. Επίλογος

Στο κεφάλαιο αυτό ολοκληρώθηκε το στάδιο της ανάλυσης των γεωγραφικών δε-
δοµένων. Το µετέπειτα στάδιο αποτελεί η χαρτογραφική τους απεικόνιση, η οποία
περιγράφεται στο επόµενο και τελευταίο κεφάλαιο του βιβλίου.
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8.1. Εισαγωγή

Στο κεφάλαιο αυτό παρουσιάζονται οι βασικές αρχές της χαρτογραφικής απόδοσης.
Αναλύονται συνοπτικά τα γραφικά, χαρτογραφικά και εποπτικά στοιχεία του χάρτη.
Επίσης, αναφέρονται τα στάδια σχεδιασµού ενός χάρτη. 

Ο χρήστης θα εξοικειωθεί µε τις βασικές δυνατότητες χαρτογραφικής απεικόνισης
του λογισµικού ArcMap και θα αξιοποιήσει τις γνώσεις του στο σχεδιασµό τριών
χαρτών που θα τεκµηριώνουν οπτικά τα αποτελέσµατα της Ανάλυσης. Οι δύο χάρτες
θα παρουσιάζουν τις περιοχές που είναι κατάλληλες, ενώ ο τρίτος χάρτης την
τελική προτεινόµενη περιοχή.

8.2. Ο χάρτης

Ο χάρτης αποτελεί τη γραφική αναπαράσταση ενός τµήµατος της επιφάνειας της
γης. Κατά το χαρτογραφικό σχεδιασµό γίνεται χρήση διαφορετικών συµβόλων και
ονοµατολογίας για την αναπαράσταση των αντικειµένων ή φαινοµένων ενδιαφέρον-
τος και την κατανόησή τους από τους χρήστες του χάρτη.

Ένας χάρτης διαµορφώνεται από ένα σύνολο θεµατικών επιπέδων. Τα θεµατικά
αυτά επίπεδα αποδίδονται µε τη χρήση συµβόλων. Τα σύµβολα κατατάσσονται σε
σηµειακά, γραµµικά και επιφανειακά, ενώ οι γραφικές τους παράµετροι (µορφή,
διάσταση και χρώµα) ποικίλουν, ώστε να επιτυγχάνεται η αποδοτικότερη µετάδοση
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8 Χαρτογραφική 
Απόδοση



του µηνύµατος στο χρήστη του χάρτη. Για την κατανόηση των θεµατικών επιπέδων
διατίθεται το υπόµνηµα, το οποίο υποστηρίζει την τυποποίηση των συµβόλων του
χάρτη. 

Ορισµένα από τα συστατικά για τον ορθό σχεδιασµό των χαρτών είναι τα ακό-
λουθα:

Σχεδιασµός των στοιχείων του χάρτη
Χρήση συµβολισµού
Καθορισµός του σκοπού του χάρτη
Προσδιορισµός των παραµέτρων (µέγεθος, κλίµακα)
Σχεδιασµός της διάταξης του χάρτη
Επεξεργασία του συµβολισµού των δεδοµένων
∆ηµιουργία τελικού χάρτη
∆ηµιουργία έκθεσης

Τέλος, ο χάρτης αποτελείται από γραφικά, χαρτογραφικά και εποπτικά στοιχεία. Πε-
ρισσότερες λεπτοµέρειες για κάθε µία από τις παραπάνω κατηγορίες στοιχείων
αναφέρονται στις επόµενες παραγράφους.

8.3. Γραφικά Στοιχεία

Τα γραφικά στοιχεία αναφέρονται σε σηµεία, γραµµές ή επιφάνειες, τα οποία απο-
τελούν τα βασικά δοµικά συστατικά των χαρτών. 

Η διάκριση µεταξύ τους βασίζεται στη γεωµετρία τους. Τα σηµεία αποδίδουν την
έννοια της θέσης, αντιπροσωπεύοντας αντικείµενα ή φαινόµενα που ανάγονται σε
µια συγκεκριµένη  θέση (x,y), ενώ µπορούν να επαναλαµβάνονται σε διακριτές θέ-
σεις. Πρόκειται για γραφικά στοιχεία των οποίων το περίγραµµα δεν αντιστοιχεί
στα πραγµατικά όρια των οντοτήτων που αναπαριστούν (π.χ. Σηµεία ενδιαφέροντος).
Οι γραµµές αποδίδουν τόσο διεύθυνση, όσο και θέση, δεδοµένου ότι µπορεί να
θεωρηθούν σαν ένα γραµµικό σύνολο από σηµεία. Τα γραµµικά σύµβολα αναπα-
ριστούν οντότητες µε γραµµική ανάπτυξη και αποτελούνται από έναν άξονα που
ενώνει δύο σηµεία µε γεωγραφική αναφορά (π.χ. Οδικό δίκτυο, υδρογραφικό δίκτυο,
ισοϋψείς κ.λπ.). Τέλος, οι επιφάνειες, επιπλέον από τις γραµµές, αποδίδουν διεύ-
θυνση, θέση και έκταση. Τα επιφανειακά σύµβολα καταλαµβάνουν µια επιφάνεια η
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οποία ανταποκρίνεται στα πραγµατικά όρια της αντίστοιχης οντότητας στο έδαφος
(νοµοί, περιφέρειες, κατόψεις κτιρίων κ.λπ.).

8.4. Χαρτογραφικά Στοιχεία

Τα χαρτογραφικά στοιχεία ενός χάρτη είναι η κλίµακα, η προβολή και τα σύµβολα.

Η κλίµακα αποτελεί κοινό χαρακτηριστικό όλων των χαρτών και υποδεικνύει πόσο
µικρότεροι είναι από την πραγµατικότητα που απεικονίζουν. Οι προσδιορισµοί µικρή
ή µεγάλη, οι οποίοι συνοδεύουν την κλίµακα ενός χάρτη, αναφέρονται στο σχετικό
µέγεθος των αντικειµένων που απεικονίζονται και όχι στο µέγεθος της σµίκρυνσης
που έχουν υποστεί.

Η κλίµακα του χάρτη καθορίζει την αναπαράσταση µιας οντότητας µε σηµειακό,
γραµµικό ή επιφανειακό σύµβολο. Συγκεκριµένα, η αναπαράσταση ενός κτιρίου σε
χάρτη µεγάλης κλίµακας θα γινόταν είτε µε χρήση γραµµικού συµβόλου για την
αποτύπωση του περιγράµµατός του είτε µε χρήση επιφανειακού συµβόλου. Αντίθετα,
σε ένα χάρτη µικρότερης κλίµακας το κτίριο αυτό θα µπορούσε να αναπαρασταθεί
µε σηµειακό σύµβολο.

Η προβολή αποτελεί έναν ακόµα καθοριστικό παράγοντα ενός χάρτη. Με την προ-
βολή η σφαιρική τρισδιάστατη επιφάνεια της γης µεταµορφώνεται σε ένα επίπεδο
δισδιάστατο χάρτη. H προβολή της τρισδιάστατης επιφάνειας της γης είναι δυνατή
σε µία από τις ακόλουθες επιφάνειες:

Επίπεδη επιφάνεια (Αζιµουθιακές προβολές)
Κύλινδρο (Κυλινδρικές προβολές)
Κώνο (Κωνικές προβολές)

Τέλος, τα σύµβολα ενός χάρτη συµπληρώνουν µε τη σειρά τους την κλίµακα και
την προβολή του. Με τον τρόπο αυτό γίνονται εύκολα αντιληπτές οι θέσεις των αν-
τικειµένων που απεικονίζουν, οι σχέσεις που υπάρχουν µεταξύ αυτών των δεδοµένων,
καθώς και άλλες χωρικές πληροφορίες. Η διαφοροποίηση των συµβόλων επιτυγχά-
νεται προσαρµόζοντας τη γεωµετρία, τον προσανατολισµό και άλλα χαρακτηριστικά
των συµβόλων.
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8.4.1. Γραφικές µεταβλητές χαρτογραφικών συµβόλων

Ανεξάρτητα από τη γεωµετρία τους, τα χαρτογραφικά σύµβολα διαφοροποιούνται
όσον αφορά στον προσανατολισµό, στη µορφή, στο χρώµα, στη διάσταση, στο
πρότυπο και στη γραµµατοσειρά.

Προσανατολισµός
Χρησιµοποιείται στις περιπτώσεις διαφοροποίησης όµοιων συµβόλων (συνήθως γραµ-
µικών). Αλλάζοντας τον προσανατολισµό, τα ίδια σύµβολα αντιπροσωπεύουν διαφο-
ρετικές κατηγορίες πληροφοριών.

Μορφή - Σχήµα
Όσον αφορά στα σηµειακά σύµβολα η µορφή τους µπορεί να είναι κανονική ή ει-
κονική. Η µορφή ενός γραµµικού συµβόλου µπορεί να είναι συνεχής ή ασυνεχής,
ενώ για τα επιφανειακά σύµβολα η µορφή καθορίζεται από την πραγµατική έκταση
της οντότητας ανηγµένη στην κλίµακα του χάρτη. Όσον αφορά στα επιφανειακά
σύµβολα υπάρχει πλήθος προτύπων σηµειακών ή γραµµικών συµβόλων για την ανα-
παράσταση της επιφάνειας. Παραδείγµατα δίνονται στον πίνακα 8.1 που ακολουθεί:

Πίνακας 8.1: Μορφή χαρτογραφικών συµβόλων

Χρώµα
Η χρήση του χρώµατος για τη διάκριση των οντοτήτων εφαρµόζεται τόσο στους
ασπρόµαυρους, όσο και στους έγχρωµους χάρτες. Στην έννοια του χρώµατος συµ-
περιλαµβάνονται τρεις βασικές συνιστώσες: απόχρωση, ένταση και βαθµός κορε-
σµού.
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Χαρτογραφικά Σύµβολα Μορφή

Σηµειακά Κανονική Εικονική

Γραµµικά Συνεχής Ασυνεχής

Επιφανειακά Πρότυπα



∆ιάσταση
Αναφέρεται στη διαφοροποίηση των γεωµετρικών ιδιοτήτων ενός συµβόλου (µήκος,
ύψος, επιφάνεια), δηµιουργώντας µια απειρία µεγεθών που απεικονίζουν ποσοτικές
διαφορές.

Σε ό,τι αφορά στη διάσταση των σηµειακών συµβόλων, αυτή επηρεάζει το βαθµό
παρατήρησής τους από το χρήστη του χάρτη. Για το λόγο αυτό όσο πιο σύνθετη
είναι η µορφή ενός συµβόλου, τόσο µεγαλύτερο οφείλει να είναι.

Στην περίπτωση των γραµµικών συµβόλων η έννοια της διάστασης αναφέρεται στο
πάχος του γραµµικού συµβόλου, το οποίο  είτε αναπαριστά την πραγµατική του διά-
σταση στο έδαφος είτε τη σχετική του σπουδαιότητα στο περιεχόµενο του χάρτη. 

Τέλος, στα επιφανειακά σύµβολα ο χαρακτήρας του προτύπου που χρησιµοποιείται
είναι συνάρτηση τεσσάρων παραγόντων: της µορφής, της διάστασης, της απόστασης
και του προσανατολισµού (στην περίπτωση γραµµικών προτύπων) της µονάδας προ-
τύπου. Η διάσταση αναφέρεται τόσο στο µέγεθος του σηµειακού συµβόλου, όσο
και στο πάχος της γραµµής στην περίπτωση των γραµµικών προτύπων.

Πρότυπο
Τα χαρτογραφικά πρότυπα διαµορφώνονται από την επανάληψη βασικών γραφικών
στοιχείων που αποτελούν συνδυασµούς των παραπάνω κατηγοριών συµβόλων. Τα
χαρακτηριστικά που παρουσιάζουν τα πρότυπα είναι η υφή, ο προσανατολισµός και
το µοτίβο.  

Γραµµατοσειρά
Τέλος, η γραµµατοσειρά αναφέρεται στα κάθε µορφής κείµενα τα οποία χρησιµο-
ποιούνται σε ένα χάρτη, όπως είναι τα τοπωνύµια, το υπόµνηµα, ο τίτλος κ.λπ. 

Συνοψίζοντας, η διαφοροποίηση των χαρτογραφικών συµβόλων της ίδιας κατηγορίας
(σηµειακά, γραµµικά, επιφανειακά) οφείλεται στη διαφοροποίηση των παρακάτω χα-
ρακτηριστικών:

Μέγεθος
Φωτεινότητα απόχρωσης 
Υφή του µοτίβου
Απόχρωση
Προσανατολισµό
Σχήµα/ µορφή
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8.5. Εποπτικά Στοιχεία

Τα εποπτικά στοιχεία συµβάλλουν στην αποδοτικότερη αναπαράσταση και κατανόηση
του χάρτη από το χρήστη. 

Τα κυριότερα στοιχεία είναι:
Ο τίτλος του χάρτη που συνήθως αποδίδει το σκοπό για τον οποίο σχεδιά-
στηκε ο χάρτης µε αναφορά στην περιοχή µελέτης.
Το υπόµνηµα το οποίο εξηγεί τα σύµβολα που χρησιµοποιήθηκαν αλλά και
κάθε άλλη πληροφορία αναγκαία για την ανάγνωση και χρήση ενός χάρτη.
Ο δείκτης προσανατολισµού ο οποίος πολλές φορές παραλείπεται, γιατί συ-
νήθως οι χάρτες είναι προσανατολισµένοι µε το Βορρά προς τα επάνω, ενώ
πολλές φορές η χρήση του γίνεται για αισθητικούς λόγους.
Ο δείκτης κλίµακας αποτελεί βασικό βοήθηµα για την ανάγνωση ενός χάρτη.
Αυτό συµβαίνει γιατί πάντα υπάρχει απόσταση µεταξύ δύο οποιωνδήποτε αντι-
κείµενων στο χώρο, τα οποία απεικονίζονται στο χάρτη. Εποµένως, η θέση
που κατέχει στο χάρτη είναι περίοπτη. 

8.6. Βήµατα για τη δηµιουργία χάρτη

Έχοντας πλέον εξοικειωθεί µε την έννοια του χάρτη και των χαρτογραφικών συµ-
βόλων και χαρακτηριστικών, στο υποκεφάλαιο αυτό αναφέρονται τα βασικά βήµατα
για το σχεδιασµό ενός χάρτη, τα οποία είναι:

Καθορισµός του σκοπού του χάρτη
Καθορισµός του µεγέθους και της κλίµακας του χάρτη
Σχεδιασµός της διάταξης του χάρτη
Προετοιµασία των επιπρόσθετων δεδοµένων
Σχεδιασµός του χάρτη

Σύµφωνα µε το πρώτο βήµα, ο χρήστης καλείται να απαντήσει στα εξής ερωτήµατα:
«Για ποιο λόγο σχεδιάζεται ο χάρτης;», «Σε ποιον απευθύνεται;» και «Πώς θα πα-
ρουσιαστεί;»

Οι διαστάσεις του χάρτη και κατ’ επέκταση η κλίµακά του καθορίζεται µε βάση το
σκοπό του χάρτη και το κοινό στο οποίο απευθύνεται.
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Το επόµενο βήµα είναι ο καθορισµός της διάταξης του χάρτη. Η διάταξη του χάρτη
θα πρέπει να είναι τέτοια, ώστε να περιέχει την περιοχή µελέτης µε τα δεδοµένα
προς απεικόνιση. Η διάταξη επηρεάζεται σε µεγάλο βαθµό από το σχήµα της πε-
ριοχής µελέτης. Σηµαντικό ρόλο στη διάταξη παίζουν και τα χαρτογραφικά συστατικά
ενός χάρτη (τίτλος, υπόµνηµα κτλ.).

Το τέταρτο βήµα είναι καθοριστικό για το σχεδιασµό του χάρτη. Στο σηµείο αυτό
ο χρήστης καλείται να επιλέξει τα σύµβολα για κάθε τύπο δεδοµένων που επιθυµεί
να εµφανίσει στο χάρτη, τις τιµές των χαρακτηριστικών για την απεικόνιση, καθώς
επίσης να επεξεργαστεί τον τρόπο εµφάνισης των χαρτογραφικών αυτών συµβόλων
στο υπόµνηµα του χάρτη. 

Ακολουθώντας τα προαναφερθέντα βήµατα ο σχεδιασµός του χάρτη είναι πλέον
εφικτός µε τη χρήση του προγράµµατος ArcMap 10.1 for Desktop, και συγκεκρι-
µένα, µέσα από το περιβάλλον “View>Layout View”.

8.7. Σχεδιασµός χάρτη στο ArcMap

Στο υποκεφάλαιο αυτό εξετάζονται ένα προς ένα τα βήµατα δηµιουργίας χαρτών.
Για το λόγο αυτό γίνεται χρήση των θεµατικών επιπέδων του εκπαιδευτικού παρα-
δείγµατος. Μέσα από τα βήµατα αυτά ο χρήστης θα εξοικειωθεί µε τον τρόπο ει-
σαγωγής χαρτογραφικών χαρακτηριστικών σε ένα χάρτη, τη διαδικασία διαµόρφωσης
του µεγέθους και της διάταξης του χάρτη.

Για να επιτευχθεί όµως ο σχεδιασµός ενός χάρτη θα πρέπει ο χρήστης, αφού ει-
σάγει τα απαραίτητα θεµατικά επίπεδα πληροφορίας σε ένα αρχείο .mxd, να ορίσει
τον τρόπο εµφάνισης του χάρτη σε “Layout View”. 

Αυτό επιτυγχάνεται είτε µέσα από το Κύριο Μενού: “View > Layout View” είτε
από το κάτω µέρος του παραθύρου στο οποίο εµφανίζονται τα δεδοµένα και πάνω
από τη ράβδο µηνυµάτων, επιλέγοντας το εικονίδιο 

Με την επιλογή αυτή ο χρήστης έχει τη δυνατότητα να ασχοληθεί µε τα χαρτογρα-
φικά στοιχεία ενός χάρτη, όπως ο τίτλος, ο προσανατολισµός του Βορρά, η γραφική
κλίµακα σε συνδυασµό µε τα δεδοµένα προς απεικόνιση στο φύλλο χάρτη. Συγκε-
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κριµένα, οι µονάδες του φύλλου χάρτη είναι cm ή inches σε αντίθεση µε την πε-
ρίπτωση της επιλογής “Data View”, όπου τα δεδοµένα απεικονίζονται στο χώρο
µε τις πραγµατικές τους συντεταγµένες. 

Για την πλοήγηση στο περιβάλλον “Layout View” γίνεται χρήση της εργαλειοθήκης

“Layout”. 

Τα εργαλεία που περιλαµβάνει είναι τα ακόλουθα:
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Εικόνα 8.1: Εργαλειοθήκη Layout

Εστίαση στο περιβάλλον layout, είτε µε
κλικ σε ένα σηµείο είτε σχεδιάζοντας
ένα πολύγωνο

Σµίκρυνση περιβάλλοντος layout 

Μετακίνηση του περιβάλλοντος Layout
(φύλλο χάρτη)

Προσαρµογή φύλλου χάρτη στο µέγιστο
επιτρεπτό όριο παραθύρου 

Εστίαση σε κλίµακα 1:1 (100%)

Εστίαση έχοντας ως βάση το κέντρο του
φύλλου χάρτη 

Σµίκρυνση έχοντας ως βάση το κέντρο
του φύλλου χάρτη

Μετάβαση στο προηγούµενο επίπεδο
εστίασης

Μετάβαση στο επόµενο επίπεδο
εστίασης

Καθορισµός επί τις εκατό του
επιπέδου εστίασης

Toggle Draft Mode

Εστίαση στο πλαίσιο των δεδοµένων

Αλλαγή διάταξης χάρτη (Επιλογή µέσα
από λίστα)

Η ενεργοποίησή του παρέχει εργαλεία
για τη διαχείριση διαφορετικών χαρτών

στο ίδιο .mxd

ΠΡΟΣΟΧΗ!! Για τη διαχείριση του φύλλου χάρτη στο περιβάλλον “Layout
View” γίνεται χρήση της εργαλειοθήκης “Layout”.

Στην περίπτωση που ο χρήστης επιθυµεί οποιαδήποτε αλλαγή στα δεδο-
µένα τα οποία περιέχονται στο “Frame” του χάρτη, τότε θα πρέπει να
χρησιµοποιήσει την εργαλειοθήκη “Tools”.



Ο χρήστης  µπορεί να ανατρέχει στην
εργαλειοθήκη “Layout” για την επιλογή
του κατάλληλου προτύπου διάταξης για
το  χάρτη που επιθυµεί να σχεδιάσει.
Τα πρότυπα διάταξης που είναι διαθέ-
σιµα στο χρήστη επιλέγοντας από την
εργαλειοθήκη “Layout” το εικονίδιο   
είναι τα ακόλουθα:

Κάθε πρότυπο “Layout” που επιλέγεται
έχει συγκεκριµένες διαστάσεις. 

Από τη στιγµή που ο χρήστης επιλέξει
το επιθυµητό πρότυπο είναι σε θέση να πληροφορηθεί
για τις διαστάσεις του φύλλου χάρτη. Αυτό είναι εφικτό
µε δεξί κλικ στην κενή περιοχή γύρω και έξω από το
φύλλο χάρτη που εµφανίζεται στο περιβάλλον Layout
View και επιλογή της εντολής “Page and Print Setup”
από τη λίστα, όπως φαίνεται στη διπλανή εικόνα. 

Το αποτέλεσµα της επιλογής
είναι η εµφάνιση ενός παρα-
θύρου στο οποίο ο χρήστης
πληροφορείται για τις διαστά-
σεις του φύλλου χάρτη. 

Οι διαστάσεις και ο προσανα-
τολισµός του συγκεκριµένου
προτύπου φαίνονται στην Ει-
κόνα 8.3. που ακολουθεί.
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Εικόνα 8.2: Πρότυπα διάταξης χαρτών

Εικόνα 8.3: ∆ιαστάσεις προτύπου Portrait Modern



Ο χρήστης, αφού επιλέξει το πρότυπο διάταξης που καλύπτει σε µεγαλύτερο βαθµό

τις απαιτήσεις του, είναι σε θέση να το επεξεργαστεί, διαµορφώνοντας το µέγεθος

και τη θέση των πλαισίων για την τοποθέτηση των εποπτικών, γραφικών και χαρ-

τογραφικών στοιχείων του χάρτη. 

Ο χρήστης µπορεί επίσης να σχεδιάσει τη διάταξη της αρεσκείας του ανάλογα µε

το σκοπό του χάρτη, την έκταση και τον προσανατολισµό της περιοχής, αλλά και

τα χαρτογραφικά στοιχεία που επιθυµεί να εµφανίζονται, στην περίπτωση που δεν

καλύπτεται από τα υπάρχοντα πρότυπα. 

8.8. Σχεδιασµός Χαρτών µε θέµα τις κατάλληλες περιοχές προς
χωροθέτηση

Οι χάρτες που καλείται ο χρήστης να σχεδιάσει θα πρέπει να περιλαµβάνουν τις

υποψήφιες θέσεις χωροθέτησης µε το αντίστοιχο κόστος αγοράς και την καταλλη-

λότητά τους, καθώς επίσης τις χρήσεις γης και το οδικό δίκτυο της περιοχής µε-

λέτης ως υπόβαθρο.

Πιο συγκεκριµένα, θα πρέπει να σχεδιαστούν 2 χάρτες, ένας µε το κόστος για οι-

κόπεδο δυο στρεµµάτων και ένας µε το κόστος ανά αγροτεµάχιο. Τα υπόλοιπα επί-

πεδα του χάρτη θα παραµείνουν τα ίδια και στα δυο σενάρια.

Στις επόµενες παραγράφους καλύπτεται η χαρτογραφική απεικόνιση του υποβάθρου

και στη συνέχεια η απεικόνιση των υποψήφιων θέσεων µε τα χαρακτηριστικά τους.  

Για τη σύνθεση των χαρτών ο χρήστης θα πρέπει να ακολουθήσει τρία στάδια ερ-

γασιών (γραφικό, χαρτογραφικό, εποπτικό), όπως αναφέρθηκαν σε προηγούµενο

υποκεφάλαιο. 

8.8.1. Γραφικό Στάδιο

Στο πρώτο στάδιο, το γραφικό, ο χρήστης θα πρέπει να αναγνωρίσει τη γεωµετρία

των θεµατικών επιπέδων που συµµετέχουν στη χαρτογραφική απόδοση. 
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Πρόκειται για τα επίπεδα LANDUSE_CA, FINALAREAS και ROADS, τα οποία είναι
αποθηκευµένα στους φακέλους {...\\DATA\RESULTS\9_CALCULATE}, {...\\DATA\RE-
SULTS\11_SELECT} και {...\\DATA\BASIC\SHAPEFILES} αντίστοιχα. Τα δύο πρώτα θε-
µατικά επίπεδα είναι επιφανειακά, ενώ το επίπεδο ROADS είναι γραµµικό. Τα
επίπεδα αυτά στη συνέχεια θα πρέπει να εισαχθούν στο περιβάλλον του ArcMap. 

8.8.2. Χαρτογραφικό Στάδιο

Στο επόµενο στάδιο, το χαρτογραφικό, ο χρήστης θα πρέπει να εξετάσει την κλί-
µακα, την προβολή και το συµβολισµό των τριών αυτών θεµατικών επιπέδων. 

Η προβολή αποτελεί σηµαντικό παράγοντα ενός χάρτη και αναφέρεται στο σύστηµα
προβολής του, µε το οποίο η σφαιρική τρισδιάστατη επιφάνεια της γης µεταµορ-
φώνεται σε έναν επίπεδο δισδιάστατο χάρτη. Στην περίπτωση των τριών αυτών θε-
µατικών επιπέδων η προβολή που χρησιµοποιείται είναι η
“Clarke_1866_UTM_Zone_18”.

Όσον αφορά στην κλίµακα του χάρτη, καθορίζεται από τις διαστάσεις του φύλλου
χάρτη και το πλαίσιο στο οποίο θα απεικονιστούν τα θεµατικά επίπεδα, ενώ ο συµ-
βολισµός των επιπέδων πληροφορίας θα γίνει µε τέτοιο τρόπο, ώστε οι θέσεις
των αντικειµένων να γίνονται εύκολα αντιληπτές από το χρήστη του χάρτη.

Στη συνέχεια παρουσιάζονται τα βήµατα που πρέπει να ακολουθήσει ο χρήστης,
ώστε να προετοιµάσει τα δεδοµένα και να καθορίσει τις διαστάσεις του φύλλου
χάρτη στο χαρτογραφικό αυτό στάδιο.

a) Προετοιµασία ∆εδοµένων

Είτε πρόκειται για σηµειακό, είτε για γραµµικό, είτε για επιφανειακό σύµβολο, οποι-
αδήποτε αλλαγή στο χρώµα, τη µορφή και τη διάσταση καθορίζεται µέσα από την
καρτέλα “Symbology” του εκάστοτε επιπέδου.

Συγκεκριµένα, στις περιπτώσεις επιφανειακών συµβόλων ο χρήστης έχει στη διάθεσή
του αρκετές µεθόδους για την εµφάνιση των διαφορετικών χαρακτηριστικών ενός
επιπέδου. Οι µέθοδοι που είναι διαθέσιµες στο λογισµικό ArcMap είναι οι ακόλουθες:
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Features: Με την επιλογή αυτή ο χρήστης αντιστοιχεί ολόκληρη την περιοχή που κα-
λύπτει το επιφανειακό επίπεδο σε ένα µόνο σύµβολο (π.χ. Χρώµα).
Categories: Χρήση διαφορετικού συµβόλου ανά κατηγορία αξιοποιώντας τις µοναδι-
κές τιµές ενός ή περισσοτέρων πεδίων.
Quantities: Χρήση κλίµακας χρωµάτων µε βάση τις τιµές ενός συγκεκριµένου πεδίου
του επιπέδου. Οι µέθοδοι οµαδοποίησης που παρέχονται από το λογισµικό στο
πλαίσιο της µεθόδου Quantities είναι οι ακόλουθες:

Natural Breaks: Η default επιλογή του λογισµικού. Βασίζεται στη στατιστική
ανάλυση των δεδοµένων, προσπαθώντας να βρει τα «φυσικά» όρια των τά-
ξεων.
Quantile: Αντιστοιχεί ίσο αριθµό οντοτήτων σε κάθε τάξη. Στοχεύει στην οπτική
ισοκατανοµή των χρωµάτων στο χάρτη.
Manual: Ο χρήστης αποφασίζει µε βάση την εµπειρία του τα όρια των τάξεων.
Equal interval: Χωρίζει το εύρος των τιµών του πεδίου σε ίσα µέρη µε βάση
τον αριθµό των τάξεων. Για παράδειγµα, για εύρος τιµών από 0 έως 100 και
4 τάξεις το εύρος της καθεµίας θα είναι 0-25, 25-50, 50-75, 75-100.
Defined Interval: Μοιάζει µε την Equal interval µε µόνη διαφορά ότι τα όρια
των τάξεων δεν είναι ίσου εύρους, αλλά µπορεί να ποικίλουν.
Geometric Interval: Είναι µια ενδιάµεση λύση των µεθόδων Equal interval και
Quantile. Συνδυάζει τα πλεονεκτήµατα των δύο µεθόδων.
Standard Deviation: ∆ηµιουργεί οµάδες µε βάση την τυπική απόκλιση (ΤΑ) και
το µέσο όρο (ΜΟ). Αν ο αριθµός των τάξεων είναι 4 τότε οι οµάδες είναι:
ΜΟ έως (+ 1 ΤΑ), (+ 1 ΤΑ) έως (+ 2 ΤΑ), ΜΟ έως (- 1 ΤΑ), (- 1 ΤΑ) έως
(– 2ΤΑ).

Charts: Απόδοση πίτας ή ιστογράµµατος ανά γεωγραφική οντότητα.
Multiple Attributes: Απεικόνιση της ίδιας οντότητας µε τη χρήση περισσότερων του
ενός πεδίου (π.χ. ένα πεδίο για την απόδοση του χρώµατος και ένα πεδίο για τον
καθορισµό του συµβόλου).

Στις περιπτώσεις γραµµικών ή σηµειακών συµβόλων η διαδικασία είναι απλούστερη,
καθώς ο χρήστης έχει στη διάθεσή του είτε την µέθοδο “Features” είτε τη µέθοδο
κατηγοριοποίησης (Categories). Σύµφωνα µε την πρώτη µέθοδο γίνεται η απόδοση
της γεωµετρίας µε τη χρήση ενός συµβόλου, ενώ στη δεύτερη µέθοδο γίνεται
χρήση ενός πεδίου του πίνακα για την εµφάνιση των διαφορετικών χαρακτηριστικών
ενός επιπέδου, τα οποία οργανώνονται σε κατηγορίες µε χρήση διαφορετικών συµ-
βόλων. 
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Στο στάδιο αυτό, αρχικά, εξετάζεται η µέθοδος που θα χρησιµοποιηθεί για την
απόδοση των διαφορετικών χρήσεων γης για το επίπεδο LANDUSE_CA στον πα-
ραγόµενο χάρτη. Για την ενεργοποίηση της κατάλληλης µεθόδου συµβολισµού ο
χρήστης µε δεξί κλικ στο επίπεδο LANDUSE_CA επιλέγει την καρτέλα “Symbology”
από τα “Properties” του επιπέδου. 

Στη συγκεκριµένη περίπτωση επιλέγεται η χρήση διαφορετικού χρώµατος για κάθε
µία από τις τιµές του πεδίου LU_CODE, όπως καθορίζονται από το χρήστη. Το
αποτέλεσµα φαίνεται στην Εικόνα 8.4 που ακολουθεί.

Σύµφωνα µε την παραπάνω εικόνα, τα βήµατα που πρέπει να ακολουθήσει ο χρήστης
για την επιλογή της µεθόδου συµβολισµού είναι τα ακόλουθα:

Επιλογή της µεθόδου συµβολισµού από τη λίστα (“Categories > Unique va-
lues”). Ανάλογα µε τη µέθοδο που επιλέγεται, εµφανίζεται προεπισκόπηση του
αποτελέσµατος στο κάτω αριστερό µέρος.
Επιλογή του πεδίου µε βάση τις τιµές του οποίου θα γίνει η απόδοση διαφο-
ρετικού χρώµατος. Το πεδίο που επιλέγεται είναι το LU_CODE.
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Εικόνα 8.4: Επιλογή µεθόδου συµβολισµού

Θεµατικό επίπεδο “LANDUSE_CA”



Επιλογή εµφάνισης όλων των τιµών από το πεδίο LU_CODE µε την εντολή

“Add All Values”.
Επιλογή της επιθυµητής χρωµατικής παλέτας. Επειδή καµία υπάρχουσα χρωµατική
σύνθεση δεν κρίνεται ικανοποιητική, επιλέγεται η χρήση διακριτών χρωµάτων
από το χρήστη. Αυτό επιτυγχάνεται µε διπλό κλικ
σε κάθε σύµβολο και επιλογή µέσα από το πα-
ράθυρο “Symbol Selector” της επιθυµητής κάθε
φορά απόχρωσης.
Απενεργοποίηση της εµφάνισης των εγγραφών
για τις οποίες δεν υπάρχει καταχωρηµένη τιµή
σε αυτό το πεδίο. Στην προκειµένη περίπτωση
όλες οι εγγραφές έχουν τιµή στο επιλεγµένο
πεδίο.
Ολοκλήρωση της διαδικασίας µε την επιλογή OK.

Το αποτέλεσµα της παραπάνω διαδικασίας παρουσιά-
ζεται στη διπλανή εικόνα.

Μέσα από το παράθυρο της Εικόνας 8.4 ο χρήστης πληροφορείται όχι µόνο για
το πλήθος των διαφορετικών τιµών του πεδίου LU_CODE, αλλά και για το σύνολο
των εγγραφών του πίνακα που εµφανίζουν την τιµή αυτή (Count).

Τέλος, ο χρήστης µέσα από την καρτέλα “Symbology”, και συγκεκριµένα µε δεξί
κλικ στο σύµβολο της κατηγορίας που επιθυµεί να τροποποιήσει, έχει στη διάθεσή
του κάποιες επιπλέον δυνατότητες. 

Οι κυριότερες δυνατότητες αφορούν στην οµαδοποίηση µε βάση τις τιµές του
πεδίου LU_CODE, στην απόδοση χρώµατος από την µικρότερη τιµή προς τη µεγα-

λύτερη ή αντίστροφα, αλλά και στην επεξεργασία
της εκάστοτε χρωµατικής παλέτας για την απόδοση
των διαφορετικών χρήσεων γης.

Τέλος, στο στάδιο αυτό ο χρήστης καλείται να
αποδώσει στα δεδοµένα προς απεικόνιση (LAN-
DUSE_CA) την ονοµατολογία που επιθυµεί να είναι
ορατή στο υπόµνηµα του χάρτη. Αυτό είναι εφικτό
µε δύο τρόπους:
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Με κλικ στο όνοµα του θεµατικού επίπεδου µέσα από τον “Πίνακα Περιεχο-
µένων / Table Of Contents”. Στην περίπτωση αυτή γίνονται δύο κλικ µε το

ποντίκι. Στο πρώτο κλικ το όνοµα του επιπέδου γίνεται µπλε, ενώ µε το

δεύτερο κλικ είναι δυνατή η επεξεργασία του, εισάγοντας το επιθυµητό όνοµα

για το επίπεδο.

Με τον τρόπο αυτό ο χρήστης έχει τη δυνατότητα να αλλάξει όχι µόνο την

ονοµασία του θεµατικού επιπέδου, αλλά και του πεδίου και των τιµών που θα

εµφανίζονται στο υπόµνηµα του χάρτη.

Με δεξί κλικ  και εµφάνιση των “Ιδιοτήτων / Properties” του επιπέδου. Στην

περίπτωση αυτή, µέσα από το παράθυρο Properties του επιπέδου, επιλέγεται το

άνοιγµα της καρτέλας “General”. Στην καρτέλα αυτή ο χρήστης µπορεί να αλ-
λάξει µόνο το όνοµα του θεµατικού επιπέδου. Ανοίγοντας την καρτέλα “Sym-
bology”, έχει τη δυνατότητα να αλλάξει τις τιµές
του πεδίου στη στήλη Label του πίνακα εµφάνι-

σης του συµβολισµού µε τις αντίστοιχες χρή-

σεις γης. 

Σύµφωνα µε τα παραπάνω, οι αλλαγές που θα γίνουν

στην ονοµασία του θεµατικού επιπέδου, είτε µε τον

έναν είτε µε τον άλλο τρόπο, φαίνονται στη διπλανή

εικόνα 
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Θεµατικό επίπεδο “ROADS”

Η καταλληλότερη µέθοδος συµβολισµού για την απόδοση των διαφορετικών κατη-
γοριών οδικού δικτύου του θεµατικού ROADS είναι η µέθοδος “Categories”. Σύµ-
φωνα µε τη µέθοδο αυτή το οδικό δίκτυο διακρίνεται σε δύο κατηγορίες µε βάση
το πεδίο RD_CODE. 

Αυτό είναι εφικτό µε δεξί κλικ στο επίπεδο ROADS και επιλογή της καρτέλας
“Symbology” µέσα από τις “Properties” του επιπέδου. Από το παράθυρο που ανοίγει
ο χρήστης έχει στη διάθεσή του διάφορους τρόπους για την απεικόνιση του οδικού
δικτύου. Η επιλογή της µεθόδου “Categories” και ο ορισµός των παραµέτρων πα-
ρουσιάζονται στην εικόνα 8.5 που ακολουθεί.

Σύµφωνα µε την παραπάνω εικόνα, τα βήµατα που πρέπει να ακολουθήσει ο χρήστης
για την επιλογή της µεθόδου συµβολισµού είναι τα ακόλουθα:

Επιλογή της µεθόδου συµβολισµού από τη λίστα (“Categories > Unique
values”).
Επιλογή του πεδίου RD_CODE µε βάση τις τιµές του οποίου θα γίνει η από-
δοση διαφορετικού χρώµατος στις κατηγορίες του οδικού δικτύου.
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Εικόνα 8.5: Επιλογή µεθόδου συµβολισµού για το επίπεδο
ROADS

Θεµατικό επίπεδο “ROADS”



Επιλογή εµφάνισης όλων των τιµών από το πεδίο RD_CODE µε την εντολή
“Add All Values”.
Επιλογή του κατάλληλου συµβολισµού. Αυτό επιτυγχάνεται µε διπλό κλικ σε
κάθε γραµµικό σύµβολο και επιλογή µέσα από το παράθυρο “Symbol Selector”
της επιθυµητής κάθε φορά απόχρωσης, αλλά και πάχους γραµµής (Πρωτεύον
δίκτυο: Color = κόκκινο, Width = 2,00 και ∆ευτερεύον δίκτυο: Color = κόκκινο
ανοιχτό, Width = 1,20).
Απενεργοποίηση της εµφάνισης των εγγραφών για τις οποίες δεν υπάρχει κα-
ταχωρηµένη τιµή σε αυτό το πεδίο. Στη συγκεκριµένη περίπτωση όλες οι εγ-
γραφές έχουν τιµή στο επιλεγµένο πεδίο.
Ολοκλήρωση της διαδικασίας µε την επιλογή “OK”.

Ακολουθεί η απόδοση της ονοµατολογίας από το χρήστη που επιθυµεί να εµφανί-
ζεται στο υπόµνηµα του χάρτη. Αυτό επιτυγχάνεται είτε µέσα από τον “Πίνακα Πε-
ριεχοµένων” είτε µέσα από το παράθυρο “Properties” του θεµατικού επιπέδου,
ακολουθώντας την ίδια διαδικασία όπως και για το επίπεδο LANDUSE_CA.

Τα δύο παραπάνω θεµατικά επίπεδα θα χρησιµοποιηθούν ως υπόβαθρο στους δύο
χάρτες που απεικονίζουν τις υποψήφιες περιοχές χωροθέτησης. Στις επόµενες πα-
ραγράφους περιγράφεται αφενός ο τρόπος απεικόνισης της καταλληλότητας του
εδάφους και του κόστους αγοράς τεµαχίου 2.000m2 και αφετέρου ο τρόπος απει-
κόνισης της καταλληλότητας του εδάφους και του κόστους αγοράς ολόκληρου του
αγροτεµαχίου.

Θεµατικό επίπεδο “FINALAREAS”

Το θεµατικό αυτό επίπεδο προέκυψε από τη διαδικασία της ανάλυσης και περιλαµ-
βάνει τις περιοχές εκείνες οι οποίες πληρούν όλα τα κριτήρια για την κατασκευή
νέου κτιρίου.

Απεικόνιση: Κόστος αγοράς αγροτεµαχίου δυο στρεµµάτων

Η απόδοση των τελικών περιοχών του επιπέδου FINALAREAS στο χάρτη θα γίνει µε
τη χρήση κλίµακας χρωµάτων µε βάση τις τιµές ενός συγκεκριµένου πεδίου του
επιπέδου. Συγκεκριµένα, η µέθοδος που θα χρησιµοποιηθεί για το συµβολισµό είναι
η “Categories > Unique Values” µε χρήση διαφορετικής απόχρωσης για κάθε τιµή.
Το πεδίο µε βάση το οποίο θα γίνει η χρωµατική απόδοση είναι το πεδίο COST,
όπως φαίνεται στην εικόνα 8.6 που ακολουθεί. 
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Θεµατικό επίπεδο “FINALAREAS”



Σύµφωνα µε την παραπάνω εικόνα, τα βήµατα που πρέπει να ακολουθήσει ο χρήστης
για την επιλογή της µεθόδου συµβολισµού είναι τα ακόλουθα:

Επιλογή της µεθόδου συµβολισµού από τη λίστα (“Categories > Unique
Values”).
Επιλογή του πεδίου COST µε βάση τις τιµές του οποίου θα γίνει η απόδοση
του συµβολισµού. 
Επιλογή εµφάνισης όλων των τιµών από το πεδίο COST µε την εντολή “Add
All Values”.
Επιλογή της επιθυµητής χρωµατικής παλέτας. Επειδή καµία χρωµατική σύνθεση
δεν ικανοποιεί τη χαρτογραφική απεικόνιση, επιλέγεται η χρήση διακριτών χρω-
µάτων από το χρήστη. Αυτό είναι εφικτό µε διπλό κλικ σε κάθε σύµβολο και
επιλογή µέσα από το παράθυρο “Symbol Selector” της επιθυµητής κάθε φορά
απόχρωσης.
Απενεργοποίηση της εµφάνισης των εγγραφών για τις οποίες δεν υπάρχει κα-
ταχωρηµένη τιµή σε αυτό το πεδίο. Στη συγκεκριµένη περίπτωση όλες οι εγ-
γραφές έχουν τιµή στο επιλεγµένο πεδίο.
Ολοκλήρωση της διαδικασίας µε την επιλογή OK.

Ακολουθεί η επεξεργασία της ονοµατολογίας του θεµατικού επιπέδου µε τον ίδιο
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Εικόνα 8.6: Επιλογή µεθόδου συµβολισµού για το επίπεδο
FINALAREAS



ακριβώς τρόπο, όπως έγινε στην περίπτωση των
άλλων δύο θεµατικών επιπέδων. Το αποτέλεσµα φαί-
νεται στη διπλανή εικόνα.

Για την τελική επιλογή της κατάλληλης θέσης χωρο-
θέτησης ο χρήστης είναι χρήσιµο να γνωρίζει και
την καταλληλότητα του εδάφους του εκάστοτε πολυ-
γώνου. Ένας τρόπος απεικόνισής της είναι η εµφά-
νιση των τιµών της για κάθε πολύγωνο. 

Αυτό υλοποιείται ανοίγοντας το παράθυρο των “Ιδιοτήτων / Properties” του επιπέδου
FINALAREAS, το οποίο πλέον εµφανίζεται στην λίστα “Layers” µε την ονοµασία

“Περιοχές Χωροθέτησης”. Κατόπιν επιλέγεται η καρτέλα “Labels”. Σε αυτή ο χρήστης
έχει τη δυνατότητα να επιλέξει από τον πίνακα του θεµατικού επιπέδου το πεδίο του
οποίου οι τιµές επιθυµεί να εµφανίζονται. Συγκεκριµένα, ο χρήστης θα πρέπει να
ακολουθήσει τα εξής βήµατα εργασιών:

Επιλογή της εµφάνισης των ετικετών των χαρακτηριστικών του επιπέδου αυτού
(Label features in this layer - Label all the features the same way).  Με την
επιλογή αυτή οι ετικέτες του επιπέδου θα εµφανιστούν µε τον ίδιο τρόπο.
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Εικόνα 8.7: Βήµατα ορισµού εµφάνισης ετικετών / labels



Επιλογή του πεδίου SUIT από τον πίνακα του οποίου τις τιµές επιθυµεί ο χρή-
στης να εµφανίσει ως ετικέτες. 
Επιλογή του συµβολισµού που θα χρησιµοποιηθεί για την απόδοση των τιµών
του πεδίου αυτού (Arial, 10, Black & Bold). 
Επιλογή της θέσης εµφάνισης των ετικετών µέσα από την ετικέτα “Placement
Properties”. Με την επιλογή αυτή ανοίγει ένα

νέο παράθυρο µε την ονοµασία “Placement Pro-
perties”.
Στην πρώτη καρτέλα µε την ονοµασία “Place-
ment” ο χρήστης µπορεί να ορίσει τον τρόπο
εµφάνισης των ετικετών στο πολυγωνικό αυτό
θεµατικό επίπεδο.
Επίσης, έχει τη δυνατότητα να αποφύγει τυχόν
επαναλήψεις ετικετών στο ίδιο πολύγωνο (“Du-
plicate Labels”), όπως φαίνεται στη διπλανή
εικόνα.
Ολοκλήρωση της διαδικασίας µε την επιλογή
“ΟΚ”.

Αρκετές φορές, κατά την εµφάνιση των τιµών ενός πεδίου µε τη χρήση των ετι-
κετών/ labels, το χρώµα του υποβάθρου τις καθιστά δυσανάγνωστες. Για το λόγο
αυτό ο χρήστης έχει τη δυνατότητα να ορίσει ένα περίγραµµα στις ετικέτες µε το
επιθυµητό κάθε φορά χρώµα, ώστε να µη χρειάζεται η αύξηση του µεγέθους της
γραµµατοσειράς για να είναι διακριτές. Αυτό πραγµατοποιείται µέσα από την καρτέλα
Label και συγκεκριµένα επιλέγοντας “Symbol > Edit Symbol”. 

Με την επιλογή της ετικέτας “Symbol” και παραµετροποίηση των χαρακτηριστικών

εµφάνισης εµφανίζεται ένα νέο παράθυρο µε την ονοµασία “Symbol Selector” στο
οποίο ο χρήστης είναι σε θέση να επιλέξει τον τύπο και το µέγεθος της γραµµα-
τοσειράς, κάτι το οποίο είναι εφικτό και µέσα από την αρχική καρτέλα  “Labels”. 

Με το άνοιγµα της ετικέτας “Edit Symbol” εµφανίζεται ένα νέο παράθυρο στο
οποίο ο χρήστης µπορεί να τροποποιήσει τον τρόπο απεικόνισης των ετικετών, ει-
σάγοντας “Mask” και εκτελώντας πλήθος άλλων αλλαγών, έχοντας στη διάθεσή
του αρκετά εργαλεία. Συγκεκριµένα, µέσα από την καρτέλα “Mask” µπορεί να ει-
σάγει µια µάσκα στην ετικέτα, έτσι ώστε να είναι διακριτή όταν αυτό δεν είναι ευ-

ΚΕΦΑΛΑΙΟ 8 ΧΑΡΤΟΓΡΑΦΙΚΗ ΑΠΟ∆ΟΣΗ144



νοϊκό λόγω χρώµατος της επιφάνειας και της ετικέτας. Στην συγκεκριµένη περίπτωση
επιλέγεται Style = Halo, Size = 0,5. Μέσα από την ετικέτα “Symbol” γίνεται
επιλογή του χρώµατος που θα χρησιµοποιηθεί ως βάση.

Απεικόνιση: Κόστος συνολικής έκτασης αγροτεµαχίου 

Η απόδοση των περιοχών αυτών στο χάρτη θα γίνει µε τη χρήση κλίµακας χρω-
µάτων µε βάση τις τιµές του πεδίου ΤΟΤ_COST του επιπέδου. Η µέθοδος που θα
χρησιµοποιηθεί για το συµβολισµό είναι η “Quantities” µε χρήση χρωµατικής δια-
βάθµισης. Η κατηγοριοποίηση των τιµών του συνολικού κόστους γίνεται σε τρεις
κλάσεις, όπως φαίνεται στην εικόνα 8.8 που ακολουθεί. 

Σύµφωνα µε την παραπάνω εικόνα, τα βήµατα που πρέπει να ακολουθήσει ο χρήστης
για την επιλογή της µεθόδου συµβολισµού είναι τα ακόλουθα:

Επιλογή της µεθόδου συµβολισµού από τη λίστα (“Quantities > Graduated
Symbols”). 
Επιλογή του πεδίου ΤΟΤ_COST µε βάση τις τιµές του οποίου θα γίνει η από-
δοση του συµβολισµού.
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Εικόνα 8.8: Επιλογή µεθόδου συµβολισµού για το επίπεδο
FINALAREAS



∆ηµιουργία κλάσεων για τις τιµές του πεδίου ΤΟΤ_COST. Επιλέγεται η µέθοδος
Manual η οποία κρίνεται πιο κατάλληλη. Αυτό επιτυγχάνεται µε επιλογή της
εντολής “Classify”. Με την επιλογή “Classify” ανοίγει ένα νέο παράθυρο µε
την ονοµασία “Classification” στο οποίο ο χρήστης καλείται να επιλέξει τη µέ-
θοδο κατηγοριοποίησης, αλλά και το πλήθος των κλάσεων. Στη συγκεκριµένη
περίπτωση επιλέγεται η µέθοδος Manual µε αριθµό κλάσεων ίσο µε τρία
(Classes = 3). 

Ανεξάρτητα από τη µέθοδο ο χρήστης µπορεί να ορίσει το εύρος τιµών κάθε
κλάσης. Αυτό υλοποιείται από τον πίνακα “Break Values” του παραθύρου
“Classification”, ορίζοντας τη µέγιστη τιµή κάθε κλάσης, η οποία καθορίζει
αυτοµάτως την ελάχιστη τιµή του εύρους της επόµενης κλάσης. Η εισαγωγή
της τιµής γίνεται µε τη χρήση του πληκτρολογίου. Η τιµή προς επεξεργασία
µε απλό κλικ γίνεται µπλε και είναι δυνατή η αλλαγή της. Η ολοκλήρωση της
διαδικασίας επιλογής παραµέτρων γίνεται µε την επιλογή OK. Ωστόσο ο χρή-
στης έχει τη δυνατότητα να πειραµατιστεί µε τις άλλες διαθέσιµες µεθόδους
κατηγοριοποίησης.

Εναλλακτικά, ο χρήστης µπορεί να µετακινήσει τις στήλες στο παράθυρο “Co-
lumns” στην επιθυµητή θέση. Κάθε φορά που επιλέγεται µια στήλη στο κάτω
µέρος του παραθύρου εµφανίζεται το πλήθος των στοιχείων της συγκεκριµένης
κλάσης, ενώ η γραµµή της κλάσης από µπλε γίνεται κόκκινη.
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Εικόνα 8.9: Επιλογή µεθόδου κατηγοριοποίησης και αριθµού κλάσεων



Επιλογή του κατάλληλου συµβολισµού. Στο στάδιο αυτό ο χρήστης επιλέγει την
παλέτα χρωµάτων µε βάση την οποία θα γίνει η απεικόνιση των τριών
κλάσεων.
Επεξεργασία των τιµών που θα εµφανίζονται στο υπόµνηµα του χάρτη (π.χ.
Αντί για 2644,643866 - 3000,000000, αλλαγή
σε 2500 - 3000).
Ολοκλήρωση της διαδικασίας µε την επιλογή
“OK”.

Ακολουθεί η επεξεργασία της ονοµατολογίας του θε-
µατικού επιπέδου µε τον ίδιο ακριβώς τρόπο, όπως
έγινε στην περίπτωση των άλλων δύο θεµατικών επι-
πέδων. Το αποτέλεσµα φαίνεται στη διπλανή εικόνα.

β) Ορισµός εµφάνισης χάρτη σε Layout View.

Όπως αναφέρεται στο υποκεφάλαιο 8.4., η διαδικασία αυτή είναι εφικτή είτε µέσα
από το “Κύριο Μενού: View > Layout View” είτε από το κάτω µέρος του παρα-
θύρου στο οποίο εµφανίζονται τα δεδοµένα και πάνω από τη ράβδο µηνυµάτων,
επιλέγοντας το εικονίδιο              .

Για την επιλογή προτύπου Layout ο χρήστης
είναι σε θέση:

Να επιλέξει ένα από τα διαθέσιµα πρό-
τυπα. Από την εργαλειοθήκη “Layout” και
το εικονίδιο “Change Layout”      µπο-
ρεί να επιλέξει το επιθυµητό πρότυπο
(Βλέπε υποκεφάλαιο 8.7.).
Να σχεδιάσει εξαρχής το πρότυπο διάτα-
ξης. 

Στην προκειµένη περίπτωση επιλέγεται η δια-
µόρφωση της διάταξης από το χρήστη. 

Ένα σχεδιάγραµµα της προτεινόµενης διάταξης
του φύλλου χάρτη σε µέγεθος Α3 δίνεται στη
διπλανή εικόνα.
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Με βάση το παραπάνω σχεδιάγραµµα ο χρήστης έχει τη δυνατότητα να δηµιουργήσει
το δικό του πρότυπο διάταξης. Τα βήµατα που πρέπει να ακολουθήσει σε περιβάλλον
“Layout View” είναι τα ακόλουθα:

Μετάβαση στο παράθυρο διαµόρφωσης του φύλλου χάρτη. Αρχικά, ο χρή-
στης µε δεξί κλικ στη λευκή περιοχή εκτός των ορίων του φύλλου χάρτη,  και
στη συνέχεια µέσω της εντολής “Page and Print Setup” ανοίγει το παράθυρο
στο οποίο θα πρέπει να καθορίσει τις διαστάσεις του φύλλου χάρτη (Paper:
Size = A3, Orientation = Portrait και Map Page Sizes: Standard Sizes = A3,
Orientation = Portrait).
Εισαγωγή των κατάλληλων πλαισίων. Για την εισαγωγή των πλαισίων, όπως
φαίνονται στο σχεδιάγραµµα της εικόνας 8.10., θα γίνει χρήση της εργαλει-
οθήκης “Draw”. Υπενθυµίζεται ότι η εργαλειοθήκη αυτή, όπως και κάθε άλλη,
εισάγεται στο περιβάλλον του ArcMap µε δεξί κλικ στην γκρι περιοχή του πα-
ραθύρου. 

Συνολικά πρέπει να εισαχθούν και να σχεδιαστούν πέντε πλαίσια (τίτλος, υπό-
µνηµα, γραφική κλίµακα, δύο πλαίσια για τον καθορισµό των ορίων του
χάρτη), καθώς το πλαίσιο για τα
θεµατικά επίπεδα πληροφορίας
υπάρχει ήδη. 

Η εισαγωγή νέων πλαισίων γίνεται
ευκολότερη ορίζοντας Οδηγούς/
Guides στους χάρακες (Rules) που
βρίσκονται στο περιβάλλον Layout
View. Με τον τρόπο αυτό εξασφα-
λίζεται η παραλληλία και η καθε-
τότητα µεταξύ των διαφόρων
πλαισίων και των εξωτερικών
ορίων του φύλλου χάρτη.

Μετά τις απαραίτητες τροποποιήσεις η
τελική διάταξη του Layout έχει τη
µορφή που παρουσιάζεται στην εικόνα
που ακολουθεί. Στην εικόνα αυτή δια-
κρίνονται οι οδηγοί στους χάρακες µε
βάση τους οποίους έγινε η εισαγωγή
των διαφόρων πλαισίων στο φύλλο
χάρτη.
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Εικόνα 8.10: ∆ηµιουργία πλαισίων µε χρήση
οδηγών



Κατά την εισαγωγή ενός πλαισίου στο φύλλο χάρτη µε βάση τους σχετικούς οδη-

γούς στους χάρακες, ο χρήστης θα πρέπει να ορίσει το χρώµα του φόντου και

του περιγράµµατος του πλαισίου, καθώς επίσης και

το πάχος του περιγράµµατος.

Πιο συγκεκριµένα, µε δεξί κλικ στο εκάστοτε πλαίσιο

και επιλογή εµφάνισης των ιδιοτήτων “Properties” του

πλαισίου αυτού. Μέσα από την καρτέλα “Symbol” ο

χρήστης θα πρέπει ανάλογα µε τις απαιτήσεις του να

µεταβάλει τα χαρακτηριστικά αυτά.  

8.8.3. Εποπτικό Στάδιο

Το τρίτο και τελευταίο στάδιο της χαρτογραφικής σύνθεσης είναι το εποπτικό µε

την εισαγωγή των αντίστοιχων στοιχείων στο χάρτη.

Η εισαγωγή των εποπτικών στοιχείων µέσα από το περιβάλλον του ArcMap γίνεται

µέσα από το “Βασικό Μενού > Insert”, όπως φαίνεται και
στη διπλανή εικόνα. 

Στις περιπτώσεις που έχει επιλεγεί ένα υπάρχον πρότυπο

Layout, κάποια από αυτά τα χαρτογραφικά χαρακτηριστικά είναι

ήδη ενσωµατωµένα στη διάταξη του φύλλου χάρτη και ο χρή-

στης αρκεί µονάχα να επεξεργαστεί τον τρόπο µε τον οποίο

αυτά εµφανίζονται. 

Στη συγκεκριµένη περίπτωση όπου η διάταξη του φύλλου χάρτη

καθορίστηκε από το χρήστη, η εισαγωγή των στοιχείων αυτών

θα γίνει µέσα από το “Βασικό Μενού > Insert”. 
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ΠΡΟΣΟΧΗ!! Για την ενεργοποίηση της λίστας εντολών “Insert” ο χρήστης

θα πρέπει να βρίσκεται σε κατάσταση “Data > Layout View”.



a) Τίτλος

Ο πρώτος χάρτης µε την καταλληλότητα του εδάφους και το κόστος αγοράς τεµα-
χίου 2.000m2 θα έχει τίτλο «Χάρτης κόστους αγοράς αγροτεµαχίου δύο στρεµµά-
των», ενώ ο τίτλος του δεύτερου χάρτη, όπου απεικονίζεται η καταλληλότητα του
εδάφους και το κόστος αγοράς ολόκληρης της έκτασης των αγροτεµαχίων, θα
είναι «Χάρτης κόστους αγοράς συνολικής έκτασης αγροτεµαχίου».

Επιλέγοντας την εισαγωγή Τίτλου από το “Βασικό Μενού: Insert > Title” στο πα-
ράθυρο που εµφανίζεται, ο χρήστης καλείται να δώσει τίτλο στο χάρτη. 

Στην παραπάνω εικόνα παρουσιάζεται το παράδειγµα εισαγωγής τίτλου για τον πρώτο
χάρτη. Με την επιλογή ΟΚ ο τίτλος του χάρτη εµφανίζεται σε τυχαία θέση στο
φύλλο χάρτη και ο χρήστης µε τη χρήση του ποντικιού έχει τη δυνατότητα, αφού
το επιλέξει, να το µεταφέρει στο πλαίσιο µε τον αριθµό «1» της διαµόρφωσης του
χάρτη. 

Με δεξί κλικ στο κείµενο του τίτλου και επιλογή εµφάνισης των ιδιοτήτων του
(Properties), ανοίγει ένα παράθυρο στο οποίο ο χρήστης µπορεί να µεταβάλει το
χρώµα, τον τύπο, το µέγεθος της γραµµατοσειράς, τον προσανατολισµό κ.ά. µέσα
από την ετικέτα “Change Symbol” (Arial, 28, Bold).
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ΠΡΟΣΟΧΗ!! Για την εµφάνιση των εποπτικών στοιχείων στα πλαίσια,
θα πρέπει να οριστεί το πλαίσιο να βρίσκεται στο background, ενώ το
στοιχείο ενδιαφέροντος στο προσκήνιο.  

Αυτό πραγµατοποιείται µε δεξί κλικ και επιλογή “Order > Send to back”
και “Order > Bring to front” αντίστοιχα. Με τον τρόπο αυτό οι αλλαγές
είτε στον τρόπο εµφάνισης του πλαισίου είτε στον τρόπο εµφάνισης
του εποπτικού στοιχείου είναι ευχερέστερες.  



β) Υπόµνηµα

Αντίστοιχα, κατά την εισαγωγή υποµνήµατος από το Βασικό Μενού, ο χρήστης είναι
σε θέση να µεταβάλει τον τρόπο µε τον οποίο εµφανίζονται οι πληροφορίες σε
αυτό, είτε µε διπλό κλικ είτε µε δεξί κλικ πάνω στο υπόµνηµα, και εµφάνιση των
ιδιοτήτων “Properties” του εποπτικού αυτού στοιχείου.

Το παράθυρο που εµφανί-
ζεται στο χρήστη κατά το
άνοιγµα των “Ιδιοτήτων/
Properties” του υποµνήµα-
τος φαίνεται στην εικόνα
8.11 που ακολουθεί. Το
παράθυρο αυτό αποτελείται
από πέντε καρτέλες: Gen-
eral, Items, Layout, Frame
και Size and Position.

Στην καρτέλα “General” ο
χρήστης µπορεί κυρίως
να αλλάξει την ονοµασία
του Υποµνήµατος από «Le-
gend» σε «Υπόµνηµα». Επί-

σης, µπορεί να αλλάξει τον τρόπο εµφάνισης της ονοµασίας του Υποµνήµατος.
Μέσω της ετικέτας “Symbol” και το άνοιγµα του παραθύρου ο χρήστης, αφού επι-
λέξει το στυλ της γραµµατοσειράς µε την οποία επιθυµεί να εµφανίζεται η ονοµασία
του υποµνήµατος, µπορεί να επιλέξει το µέγεθος και τον τύπο της γραµµατοσειράς
(Arial, 28, Bold). Επιπρόσθετα, µέσα από το περιβάλλον “Map Layers” έχει τη δυ-

νατότητα να επιλέξει τα θεµατικά επίπεδα πληροφορίας LANDUSE_CA (Χρήσεις γης),

ROADS (Οδικό δίκτυο) και FINALAREAS (Περιοχές χωροθέτησης), τα οποία θα
αποτελέσουν στοιχεία του Υποµνήµατος. Με τη χρήση των ενδιάµεσων βελών είναι
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ΠΡΟΣΟΧΗ!! Κατά την επιλογή οποιουδήποτε εποπτικού στοιχείου µέσα

από ένα πρότυπο “Layout”, θα πρέπει να δίνεται ιδιαίτερη προσοχή,
ώστε να επιλέγονται οι ιδιότητες του στοιχείου και όχι του πλαισίου.

Εικόνα 8.11: Παράθυρο ιδιοτήτων υποµνήµατος



δυνατή η προσθαφαίρεση επιπέδων από τη µία πλευρά (Map Layers) στην άλλη
(Legend Items). Τέλος µέσα από την καρτέλα “General” παρέχεται η δυνατότητα επι-
λογής τεσσάρων ακόµα χαρακτηριστικών για την απεικόνιση του Υποµνήµατος.

Στην επόµενη καρτέλα “Items” ο χρήστης έχει τη δυνατότητα να επιλέξει τα χαρα-

κτηριστικά εµφάνισης για καθένα από τα επιλεγµένα θεµατικά επίπεδα LANDUSE_CA
(Χρήσεις γης), ROADS (Οδικό δίκτυο) και FINALAREAS (Περιοχές χωροθέτησης), τα
οποία θα αποτελέσουν τα στοιχεία του Υποµνήµατος. Συγκεκριµένα, για καθένα από
τα θεµατικά επίπεδα πληροφορίας µπορεί να επιλέξει το στυλ της γραµµατοσειράς
που επιθυµεί και να το εφαρµόσει στα ακόλουθα:  labels, layer name, headings,
class labels, class descriptions.

Επιπλέον, ο χρήστης µπορεί να επιλέξει την εµφάνιση των στοιχείων του υποµνή-
µατός του όχι µόνο σε µία στήλη αλλά σε περισσότερες. Στη συγκεκριµένη περί-
πτωση η εµφάνιση των στοιχείων θα γίνει σε δύο στήλες. Αυτό επιτυγχάνεται
ακολουθώντας τα εξής βήµατα µέσα από το παράθυρο “Legend Properties” και για
τις δύο περιπτώσεις χαρτών:
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Εικόνα 8.12: ∆ιαµόρφωση Υποµνήµατος



Καθορισµός των επιπέδων που θα εµφανίζονται στο υπόµνηµα (Map Layers)
µέσα από την καρτέλα “General”.
Καθορισµός σειράς εµφάνισης των επιπέδων στο υπόµνηµα (Legend Items).
Επιλογή του επιπέδου µέσα από την καρτέλα “Items”, έπειτα από το οποίο
είναι επιθυµητή η δηµιουργία µιας νέας στήλης. Στη συγκεκριµένη περίπτωση
το επίπεδο αυτό είναι το ROADS – Οδικό ∆ίκτυο.
Επιλογή της γραµµατοσειράς και του στυλ εµφάνισης για κάθε ένα από τα θε-
µατικά επίπεδα. Ο χρήστης είναι σε θέση να επιλέξει το στυλ της γραµµατο-
σειράς για τα επιµέρους στοιχεία (labels, layer name, headings, class labels,
class descriptions) κάθε επιπέδου που επιθυµεί να εµφανίζονται στο Υπόµνηµα.
Συγκεκριµένα τα χαρακτηριστικά για κάθε ένα επίπεδο είναι τα ακόλουθα:

Στην περίπτωση του επιπέδου LANDUSE_CA επιλέχθηκε η εµφάνιση της
ονοµασίας του επιπέδου (Layer name) παράλληλα µε την ονοµασία του
πεδίου (labels), µε τις τιµές του οποίου έγινε η απόδοση του χάρτη χρή-
σεων γης (Layer Name: Arial, 16, Bold, Labels: Arial, 15).
Για το επίπεδο ROADS, επιλέχθηκε η εµφάνιση της ονοµασίας του επι-
πέδου και των ετικετών για κάθε κατηγορία οδικού δικτύου. Οι παράµετροι
εµφάνισης του κειµένου ορίστηκαν ως εξής  (Layer Name: Arial, 13,

Bold, Labels: Arial, 12).
Τέλος, για το επίπεδο FINALAREAS εκτός από την ονοµασία του επιπέδου
και των ετικετών των τιµών, εµφανίζεται και η ονοµασία του πεδίου από
το οποίο προήλθαν οι τιµές “Label”. Οι παράµετροι εµφάνισης του κει-
µένου ορίστηκαν ως εξής: (Layer Name: Arial, 13, Bold, Headings: Arial,
12, Bold, Labels: Arial, 12)

Καθορισµός εµφάνισης των θεµατικών επιπέδων σε νέα στήλη του αριθµού
των στηλών από 1 σε 2 (Place Items in a new Column, Column count for items
= 1)Set the number of columns in your legend). Η επιλογή αριθµού µεγαλύτερο
της µονάδας θα είχε σαν αποτέλεσµα τη δηµιουργία τόσων επιπλέων στηλών
στο υπόµνηµα, έπειτα από το επιλεγµένο θεµατικο επίπεδο.
Προεπισκόπηση επιλογών µε την επιλογή ”Εφαρµογή“ στο παράθυρο “Legend
Properties”.
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ΠΡΟΣΟΧΗ!! Η ονοµασία που εµφανίζεται στο υπόµνηµα καθορίζεται
µέσα από τον Table of Contents ή την καρτέλα Symbology από τα Prop-
erties του θεµατικού επιπέδου.



γ) ∆είκτης Γραφικής Κλίµακας

Η εισαγωγή της γραφικής κλίµακας µέσα από το Κύριο Μενού έχει ως αποτέλεσµα
το άνοιγµα ενός παραθύρου, µε την ονοµασία “Scale Bar Selector”, µέσα από το
οποίο ο χρήστης καλείται αρχικά να επιλέξει τη γραφική µπάρα της αρεσκείας του

(Scale Line 1). Στη συνέχεια µέσα από την ετικέτα Properties είναι σε θέση να επε-
ξεργαστεί τον τρόπο απεικόνισης της µπάρας αυτής.

Συγκεκριµένα, το παράθυρο που εµφανίζεται µέσα από τα “Properties” της γραφικής
κλίµακας ονοµάζεται “Scale Bar”, και αποτελείται από τρεις καρτέλες. Στην πρώτη
καρτέλα “Scale and Units” ο χρήστης σε γενικές γραµµές µπορεί να ορίσει τον
αριθµό των διαιρέσεων και υποδιαιρέσεων της γραφικής κλίµακας, αλλά και τη µο-
νάδα µέτρησης της απόστασης στο χάρτη, καθώς επίσης και τον τρόπο που θα εµ-
φανίζεται η µονάδα αυτή στη γραφική κλίµακα (ελληνικοί ή λατινικοί χαρακτήρες).
Στη συγκεκριµένη περίπτωση ο αριθµός των διαιρέσεων και υποδιαιρέσεων ορίζεται
ίσος µε 2, ενώ η µονάδα µέτρησης της απόστασης είναι τα µέτρα (Label: Μέτρα,
Arial, 20, Bold).

Απαραίτητη προϋπόθεση για την εισαγωγή ονοµαστικής ή γραφικής κλίµακας σε
ένα χάρτη, είναι ο καθορισµός της µονάδας µέτρησης που χρησιµοποιεί το “Data
Frame”. Αυτό είναι εφικτό µε δεξί κλικ στα “Layers” του πίνακα “Table of Contents”.
Μέσα από το παράθυρο “Data Frame Properties” που εµφανίζεται και συγκεκριµένα

µέσα από την καρτέλα General, καθορίζονται τα “Units” του χάρτη από “Uknown
Units” στην επιθυµητή µονάδα µέτρησης ανάλογα µε την εφαρµογή (στην περίπτωσή

µας σε “Meters” ).

Στην επόµενη καρτέλα “Numbers and Marks” ο χρήστης µπορεί να ορίσει τη συ-
χνότητα εµφάνισης των τιµών στη γραφική κλίµακα µε βάση το βαθµό των υποδι-
αιρέσεων. Στην καρτέλα αυτή οι προκαθορισµένες τιµές παραµένουν ως έχουν. 

Τέλος, στην καρτέλα “Format” ορίζεται αρχικά ο τύπος και το µέγεθος της γραµ-
µατοσειράς της αρίθµησης στην κλίµακα (Arial, 11, Bold), ενώ µπορεί να τροποποιηθεί
και το µέγεθος της µπάρας.

Για τη στρογγυλοποίηση των τιµών που εµφανίζονται στη γραφική κλίµακα, αρκεί
ένα άνοιγµα της κλίµακας επιλέγοντάς τη και τραβώντας τη µία άκρη µε τη βοήθεια
του ποντικιού, είτε προς τα αριστερά είτε προς τα δεξιά. 
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Το µέγεθος της γραµµατοσειράς για τις τιµές της γραφικής κλίµακας αλλά και η
ίδια η µπάρα θα πρέπει να είναι τέτοια, ώστε να γίνονται ορατά από το χρήστη
του χάρτη. Ένας χάρτης θα πρέπει να είναι ευανάγνωστος χωρίς ιδιαίτερες υπερ-
βολές στο µέγεθος των χαρτογραφικών χαρακτηριστικών.

δ) ∆είκτης Προσανατολισµού

Με την εισαγωγή North Arrow µέσα από το Κύριο Μενού ο χρήστης επιλέγει το
δείκτη εκείνο που ταιριάζει περισσότερο στο σκοπό του χάρτη. Μέσα από την ετικέτα
“Properties” ο χρήστης είναι σε θέση να τροποποιήσει τον τρόπο εµφάνισης του
δείκτη προσανατολισµού. 

8.8.4. Εκτύπωση ή εξαγωγή του χάρτη ως αρχείο εικόνας

Το τελικό στάδιο της χαρτογραφικής απεικόνισης περιλαµβάνει είτε την απευθείας
εκτύπωση του χάρτη (“File > Print”) είτε την εξαγωγή του ως αρχείου εικόνας για
µελλοντική χρήση. Αυτό επιτυγχάνεται µέσα από το “Βασικό Μενού: File > Export
Map”. Στο παράθυρο που ανοίγει, ο χρήστης θα πρέπει να ορίσει τη θέση στην
οποία επιθυµεί να αποθηκευθεί ο χάρτης, το format στο οποίο θα γίνει η εξαγωγή
του αρχείου (TIFF, EMF, PDF, PNG κ.λπ.), αλλά και την ανάλυση της εικόνας (Options:
General).

Στην προκειµένη περίπτωση επιλέχθηκε η εξαγωγή του χάρτη ως αρχείο Pdf µε
ανάλυση (Resolution) τα 300 dpi. Το συγκεκριµένο format είναι το πλέον κατάλληλο
για την µετέπειτα εκτύπωση των χαρτών. Οι παραγόµενοι χάρτες είναι αυτοί των
εικόνων 8.13 και 8.14 που ακολουθούν.
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ΠΡΟΣΟΧΗ!! Για την αποθήκευση των παραµέτρων του Layout αρκεί η
αποθήκευση του .mxd αρχείου. Αν όµως υπάρχει ανάγκη τροποποίησης
του αρχείου .mxd, τότε θα πρέπει ο χρήστης να αποθηκεύσει το αποτέ-
λεσµα του χάρτη σε αρχείο εικόνας.
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Εικόνα 8.13: Χάρτης κόστους αγοράς αγροτεµαχίου δυο στρεµµάτων
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Εικόνα 8.14: Χάρτης κόστους αγοράς συνολικής έκτασης αγροτεµαχίου



8.9. Σχεδιασµός Χάρτη µε θέµα την προτεινόµενη περιοχή

Στο υποκεφάλαιο αυτό εξετάζεται ο σχεδιασµός ενός χάρτη µε θέµα την προτεινό-

µενη περιοχή σε συνδυασµό µε τις περιβάλλουσες χρήσεις γης για την περιοχή

µελέτης. Αντίστοιχα µε το χάρτη της προηγούµενης ενότητας, ο χρήστης θα πρέπει

να ακολουθήσει τρία στάδια εργασιών (γραφικό, χαρτογραφικό, εποπτικό).  

Τα επιπλέον κριτήρια για την επιλογή της καταλληλότερης θέσης κατασκευής κτιρίου

για τον αναπτυξιακό φορέα, όπως αναφέρθηκαν στο τέλος του προηγούµενου κε-

φαλαίου, είναι τα ακόλουθα:

Απόσταση από το οδικό δίκτυο 

Απόσταση από τις αστικές περιοχές

Σε συνδυασµό µε τα υπάρχοντα κριτήρια

Καταλληλότητα εδάφους 

Κόστος 

Λαµβάνοντας υπόψη τα παραπάνω κριτήρια, η περιοχή που προτείνεται για τη χω-

ροθέτηση του κτιρίου εµφανίζεται στην εικόνα 8.15 που ακολουθεί µε γαλάζιο πε-

ρίγραµµα. Ταυτόχρονα στην εικόνα αυτή εµφανίζεται και ο πίνακας του θεµατικού

επιπέδου FINALAREAS, το οποίο πλέον ονοµάζεται «Πιθανές Περιοχές» µε την εγ-

γραφή (FID = 5) του προτεινόµενου αγροτεµαχίου.

Πρόκειται για µια περιοχή η οποία βρίσκεται κοντά στο ποτάµι, ενώ συνορεύει µε

το αστικό τµήµα της περιοχής µελέτης. Επίσης, η καταλληλότητα του εδάφους εµ-

φανίζει τη µέγιστη τιµή (3), ενώ το κόστος για την αγορά 2.000 m2    ανέρχεται στις

3.000,00 €. 

Οι υπόλοιπες περιοχές δεν προτείνονται γιατί, αν και το κόστος αγοράς είναι χα-

µηλότερο, βρίσκονται µακριά από το υπάρχον οδικό δίκτυο και σε µεγάλη απόσταση

από  το αστικό τµήµα της περιοχής. 
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Στη συνέχεια για την ευκολότερη διαχεί-
ριση της προτεινόµενης περιοχής για
χωροθέτηση γίνεται αποθήκευση της επι-
λεγµένης εγγραφής του πίνακα, παράλ-
ληλα µε τη γεωµετρία της περιοχής σε
νέο θεµατικό επίπεδο µε το όνοµα
FINAL. Αυτό είναι εφικτό µε δεξί κλικ

στο θεµατικό επίπεδο FINALAREAS (Πι-
θανές περιοχές) και επιλογή της εντολής
“Data > Export Data”. Αυτοµάτως ανοί-
γει ένα παράθυρο που έχει τη µορφή
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Εικόνα 8.15: Προτεινόµενη περιοχή .

Εικόνα 8.16: Παράθυρο εξαγωγής εγγραφών



της παρακάτω εικόνας στο οποίο ο χρήστης επιλέγει ποια χαρακτηριστικά θα εξάγει
ακολουθώντας τα εξής βήµατα:

Επιλογή της εντολής “Export: Selected Features”.
Χρήση του ίδιου συστήµατος συντεταγµένων µε το αρχικό.
Επιλογή του φακέλου µε την ονοµασία 11_SELECT για την αποθήκευση του
νέου θεµατικού επιπέδου. Η ονοµασία του αρχείου είναι FINAL.
Ολοκλήρωση της διαδικασίας µε την επιλογή “OK”.

Με την ολοκλήρωση της διαδικασίας ο χρήστης ερωτάται αν επιθυµεί την προσθήκη
του νέου επιπέδου στη λίστα “Layers”. Η καταφατική απάντηση του χρήστη έχει ως
αποτέλεσµα την προσθήκη του νέου επιπέδου στη λίστα αυτή. 

Το θεµατικό αυτό επίπεδο θα χρησιµοποιηθεί για το σχεδιασµό του χάρτη µε την
προτεινόµενη περιοχή, έχοντας ως υπόβαθρο τα θεµατικά επίπεδα των χρήσεων
γης και του οδικού δικτύου.

Για τη σύνθεση του χάρτη ο χρήστης θα πρέπει να ακολουθήσει τρία στάδια εργα-
σιών (γραφικό, χαρτογραφικό, εποπτικό), όπως αναφέρθηκε και στην προηγούµενη
ενότητα. 

8.9.1 Γραφικό Στάδιο

Αρχικά, ο χρήστης καλείται να αναγνωρίσει τη γεωµετρία των θεµατικών επιπέδων
που συµµετέχουν στη χαρτογραφική απόδοση. Πρόκειται για τα επίπεδα
LANDUSE_CA, FINAL και ROADS, τα οποία είναι αποθηκευµένα στους φακέλους
{…\\DATA\RESULTS\9_CALCULATE}, {…\\DATA\RESULTS\11_SELECT} και {…\\DATA\
BASIC\SHAPEFILES} αντίστοιχα. Τα δύο πρώτα θεµατικά επίπεδα είναι επιφανειακά,
ενώ το επίπεδο ROADS είναι γραµµικό. Τα επίπεδα αυτά στη συνέχεια θα πρέπει
να εισαχθούν στο περιβάλλον του ArcMap. 

8.9.2. Χαρτογραφικό Στάδιο

Στο επόµενο στάδιο, το χαρτογραφικό, ο χρήστης θα πρέπει να εξετάσει την κλί-
µακα, την προβολή και το συµβολισµό των τριών αυτών θεµατικών επιπέδων.  
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Η προβολή µε βάση την οποία θα γίνει η απόδοση των χαρτογραφικών δεδοµένων

είναι η ίδια µε αυτή των προηγούµενων χαρτών “Clarke_1866_UTM_Zone_18”.
Αντίστοιχα η κλίµακα του χάρτη θα εξαρτηθεί από τις διαστάσεις του φύλλου χάρτη,

οι οποίες θα παραµείνουν ίδιες µε αυτές των προηγούµενων χαρτών. Τέλος, η επι-

λογή του κατάλληλου συµβολισµού στο στάδιο αυτό θα οδηγήσει στη διάκριση της

επιλεγµένης περιοχής προς χωροθέτηση στην ευρύτερη περιοχή µελέτης.

Τα βήµατα που πρέπει να ακολουθήσει ο χρήστης στα πλαίσια του χαρτογραφικού

αυτού σταδίου παρουσιάζονται στη συνέχεια.

a) Προετοιµασία ∆εδοµένων

Θεµατικό επίπεδο “LANDUSE_DS”
Η απόδοση των χρήσεων γης του θεµατικού αυτού επιπέδου θα γίνει µε τη χρήση

του ίδιου συµβολισµού, όπως στο κεφάλαιο 8.7.1.  Ο χρήστης θα πρέπει να ακο-

λουθήσει τα ίδια ακριβώς βήµατα για να επιτύχει τη διάκριση των διαφορετικών

χρήσεων µεταξύ τους, αλλά και της προτεινόµενης περιοχής προς χωροθέτηση του

θεµατικού επιπέδου FINAL.

Επιπλέον, θα πρέπει να γίνει η απόδοση της επιθυµητής ονοµατολογίας, όπως ακρι-

βώς έγινε και στην περίπτωση του προηγούµενου χάρτη. Το αποτέλεσµα της παρα-

πάνω διαδικασίας είναι ίδιο µε αυτό του παραπάνω υποκεφαλαίου. 

Θεµατικό επίπεδο “ROADS”
Όπως και στην περίπτωση του θεµατικού επιπέδου LANDUSE_CA, θα διατηρηθεί η

µέθοδος συµβολισµού που χρησιµοποιήθηκε για το σχεδιασµό του πρώτου χάρτη,

ακολουθώντας τα ίδια βήµατα εργασιών (Βλέπε κεφ. 8.1.1.). 
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ΠΡΟΣΟΧΗ!! Αν ο χρήστης για το σχεδιασµό του δεύτερου χάρτη ερ-
γαστεί στο ίδιο αρχείο MXD µε αυτό του πρώτου χάρτη, τότε αρκεί η

προσθήκη του νέου θεµατικού επιπέδου FINAL. Τόσο τα υπόλοιπα θεµατικά
επίπεδα, όσο και η διαµόρφωση του χάρτη παραµένουν σταθερά. 

Θεµατικό επίπεδο “LANDUSE_CA”

Θεµατικό επίπεδο “ROADS”



Θεµατικό επίπεδο “FINALSHP”

Η απόδοση της προτεινόµενης περιοχής στο χάρτη θα γίνει µε τη χρήση ενός
χρώµατος. Η µέθοδος απεικόνισης που θα χρησιµοποιηθεί µέσα από τις ιδιότητες
του επιπέδου και συγκεκριµένα από την καρτέλα “Symbology” είναι η “Features >
Single Symbol”. Με την επιλογή του “Symbol” εµφανίζεται το παράθυρο “Symbol
Selector” µέσα από το οποίο ο χρήστης είναι σε θέση να επιλέξει το επιθυµητό
χρώµα, όπως φαίνεται στην εικόνα 8.17 που ακολουθεί.

Ακολουθεί η επεξεργασία της ονοµατολογίας του θε-
µατικού επιπέδου µε τον ίδιο ακριβώς τρόπο, όπως
έγινε στο υποκεφάλαιο 8.1.1. Το αποτέλεσµα φαίνεται
στη διπλανή εικόνα. 

β) Ορισµός εµφάνισης χάρτη σε Layout View. 

Όπως αναφέρεται στο υποκεφάλαιο 8.4., η διαδικασία αυτή είναι εφικτή είτε µέσα

από το “Κύριο Μενού: View > Layout View” είτε από το κάτω µέρος του παρα-
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Εικόνα 8.17: Επιλογή µεθόδου συµβολισµού για το επίπεδο FINAL

Θεµατικό επίπεδο “FINAL”



θύρου στο οποίο εµφανίζονται τα δεδοµένα και πάνω από τη ράβδο µηνυµάτων,

επιλέγοντας το εικονίδιο              .

Αν ο χρήστης εργάζεται στο .mxd, που είχε δηµιουργήσει για το σχεδιασµό του

«Χάρτη Χρήσεων Γης» του υποκεφαλαίου 8.6.1., έχει τη δυνατότητα να χρησιµοποι-
ήσει το πρότυπο διάταξης που είχε σχεδιάσει µε βάση το σχεδιάγραµµα της εικόνας

8.5. 

Αυτό τον βοηθά να εξοικονοµήσει χρόνο, καθώς η περιοχή µελέτης δεν έχει αλ-

λάξει, οπότε το πρότυπο διάταξης του προηγούµενου παραδείγµατος παραµένει το

επιθυµητό.

8.9.3. Εποπτικό Στάδιο

Το τρίτο και τελευταίο στάδιο της χαρτογραφικής σύνθεσης είναι το εποπτικό. Αν-

τίστοιχα µε το χάρτη του προηγούµενου παραδείγµατος, η εισαγωγή εποπτικών στοι-

χείων γίνεται µέσα από το “Βασικό Μενού > Insert”. Αν ο χρήστης εργάζεται στο
ίδιο αρχείο µε αυτό του προηγούµενου παραδείγµατος, δεν απαιτείται εκ νέου η

εισαγωγή Τίτλου, Υποµνήµατος, ∆είκτη Προσανατολισµού του Βορρά και ∆είκτη Γρα-

φικής Κλίµακας.

Το πρότυπο διάταξης παραµένει το ίδιο. Το µόνο που αλλάζει είναι τα δεδοµένα

προς απεικόνιση, και συγκεκριµένα ο συµβολισµός τους. Οπότε ο χρήστης αρκεί

να επεξεργαστεί τα ήδη υπάρχοντα εποπτικά στοιχεία. Ο δείκτης γραφικής κλίµακας

και ο δείκτης προσανατολισµού του Βορρά παραµένουν ως έχουν.  

a) Τίτλος

∆εδοµένου ότι ο χρήστης εργάζεται στο ίδιο αρχείο .mxd, καλείται ουσιαστικά να

επεξεργαστεί τον τίτλο του προηγούµενου χάρτη. Με διπλό κλικ στο κείµενο του

τίτλου ανοίγει το παράθυρο “Properties”. Μέσα από το παράθυρο αυτό ο χρήστης

αρκεί να πληκτρολογήσει την ονοµασία του τίτλου του νέου χάρτη. Οι παράµετροι

του µεγέθους και τύπου γραµµατοσειράς είναι ήδη προκαθορισµένες. 
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β) Υπόµνηµα

Με διπλό κλικ στο πλαίσιο του υποµνήµατος είναι δυνατή η επεξεργασία του µε-
γέθους της γραµµατοσειράς του επιπέδου και των ετικετών µέσα από το παράθυρο
“Legend Properties”, και συγκεκριµένα µέσα από την καρτέλα “Items: Font”. Οι πα-
ράµετροι που καθορίζονται για την εµφάνισή τους στο υπόµνηµα είναι ίδιες µε
αυτές του προηγούµενου χάρτη. Αρχικά, επιλέγεται ο τρόπος εµφάνισης του υπο-
µνήµατος και στη συνέχεια ορίζονται τόσο το µέγεθος, όσο και ο τύπος γραµµα-
τοσειράς (Layer Name: Arial, 14, Bold, Labels: Arial, 12).

Επιπρόσθετα, στην καρτέλα “Genaral” ο χρήστης κατά κύριο λόγο µπορεί να αλλάξει
την ονοµασία του Υποµνήµατος από «Legend» σε «Υπόµνηµα» καθώς και να προ-
σθέσει  τα θεµατικά επίπεδα LANDUSE_CA, ROADS και FINAL, τα οποία θα απο-
τελέσουν στοιχεία του Υποµνήµατος. Με τη χρήση των ενδιάµεσων βελών είναι
δυνατή η προσθαφαίρεση επιπέδων από τη µία πλευρά (Map Layers) στην άλλη (Le-
gend Items).

Για ακόµα µια φορά επιλέγεται η απόδοση των συµβόλων στο Υπόµνηµα σε δύο
στήλες, όπως έγινε και στην  περίπτωση του προηγούµενου χάρτη. Ακολουθώντας
τα ίδια βήµατα, το αποτέλεσµα φαίνεται στην εικόνα 8.18 όπου εµφανίζεται ο
χάρτης µε την επιλεγµένη περιοχή. Σε ό,τι αφορά το στυλ κάθε επιπέδου, αυτό πα-
ραµένει το ίδιο για τα θεµατικά επίπεδα LANDUSE_CA και ROADS. Στην περίπτωση
του θεµατικού επιπέδου FINAL επιλέχθηκε η εµφάνιση της ονοµασίας του επιπέδου
για τη διάκριση της περιοχής προς χωροθέτηση από τις υπόλοιπες περιοχές. Οι
παράµετροι εµφάνισης του κειµένου ορίστηκαν ως εξής  (Layer Name: Arial, 14,
Bold).   

γ) ∆είκτης Γραφικής Κλίµακας και ∆είκτης Προσανατολισµού

Ο δείκτης γραφικής κλίµακας παραµένει ως έχει. Στην περίπτωση που τα όρια των

αποστάσεων έχουν τροποποιηθεί, τότε γίνεται στρογγυλοποίησή τους. Σε ό,τι αφορά

το δείκτη προσανατολισµού, από τη στιγµή που η εργασία εκτελείται στο ίδιο φύλλο

χάρτη, παραµένει στη θέση που έχει τοποθετηθεί εξαρχής. Οποιαδήποτε µετατροπή

του είναι εφικτή µε δεξί κλικ και άνοιγµα των ιδιοτήτων του. 
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8.9.4. Εκτύπωση ή εξαγωγή του χάρτη ως αρχείου εικόνας

Το τελικό στάδιο της χαρτογραφικής απεικόνισης, όπως αναφέρθηκε και στην προ-
ηγούµενη ενότητα, περιλαµβάνει είτε την απευθείας εκτύπωση του χάρτη (“File >
Print”) είτε την εξαγωγή του ως αρχείου εικόνας για µελλοντική χρήση. Αυτό πραγ-
µατοποιείται µέσα από το “Βασικό Μενού: File > Export Map”. Στο παράθυρο που
ανοίγει ο χρήστης θα πρέπει να ορίσει τη θέση στην οποία επιθυµεί να αποθηκευθεί
ο χάρτης, το “Format” στο οποίο θα γίνει η εξαγωγή του αρχείου (TIFF, EMF, PDF,

PNG κ.λπ.), αλλά και την ανάλυση της εικόνας (Options: General).

Αντίστοιχα µε τους χάρτες της προηγούµενης ενότητας, στο στάδιο αυτό γίνεται η
εξαγωγή του  χάρτη σε αρχείο Pdf µε ανάλυση (Resolution) τα 300 dpi, µέσα από
το “Βασικό Μενού: File > Export Map”. Ο παραγόµενος χάρτης είναι αυτός της
εικόνας 8.18 που ακολουθεί:
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Εικόνα 8.18: Χάρτης προτεινόµενης περιοχής



8.10. Επίλογος

Στο βιβλίο αυτό παρουσιάστηκαν η δοµή και οι βασικές ιδιότητες του λογισµικού
Arcgis 10.1 for Desktop, το οποίο χρησιµοποιήθηκε στην επίλυση ενός τυπικού προ-
βλήµατος χωροθέτησης. Παράλληλα αναφέρθηκαν οι βασικές αρχές σχεδιασµού
µιας τυπικής µελέτης µε Γεωπληροφοριακά Συστήµατα. 

Ο χρήστης µπορεί να επεκτείνει τις γνώσεις του, αξιοποιώντας την πλούσια υπάρ-
χουσα βιβλιογραφία, τόσο σε έντυπη µορφή, όσο και στο διαδίκτυο.
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A. Αρχικά ∆εδοµένα (Basic) 

Τα δεδοµένα που χρησιµοποιούνται στο βιβλίο αυτό δεν αναφέρονται σε µια πραγ-
µατική περιοχή. Η Γεωγραφική Βάση δεδοµένων που παρέχεται στο χρήστη αποτε-
λείται από έξι διανυσµατικά θεµατικά επίπεδα: χρήσεις γης (LUAT), οδικό δίκτυο
(ROADS), υδρογραφικό δίκτυο (STREAMS), αποχετευτικό δίκτυο (SEWERS), εδαφο-
λογία (SOILS) και το περίγραµµα της περιοχής µελέτης (TEMPLATE).
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Τα θεµατικά αυτά επίπεδα είναι αποθηκευµένα στο φάκελο {…\\DATA\BASIC\SHAPE-
FILES} και χρησιµοποιούνται για την εκπόνηση των παραδειγµάτων του παρόντος βι-
βλίου. Στη συνέχεια δίνεται ο τύπος και τα χαρακτηριστικά κάθε αρχείου Shapefile.

Πιο αναλυτικά:

1. LUAT

Το θεµατικό επίπεδο αποτελείται από 61 πολύγωνα περιγράφοντας τις χρήσεις γης
σε ένα µεγάλο τµήµα της περιοχής µελέτης.  

Το πεδίο LU_CODE χρησιµοποιείται για την αποθή-
κευση των τιµών των διαφόρων χρήσεων γης, ενώ
το πεδίο COST_HA περιέχει το κόστος/Ha για κάθε
χρήση γης. Οι τιµές του κόστους κυµαίνονται µεταξύ
10,000 και 40,000 ευρώ.

Στον πίνακα αναφέρονται οι χρήσεις γης που αντι-
στοιχούν σε κάθε κωδικό του πεδίου LU_CODE.
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LUAT Polygon Yπάρχουσες χρήσεις γης και η κωδικοποίησή τους

ROADS Polyline Οδικο δίκτυο και η κωδικοποίησή του

SEWERS Polyline Αποχετευτικό δίκτυο και η κωδικοποίησή του

SOILS Polygon Εδαφολογική καταλληλότητα

STREAMS Polyline Ποτάµια και η κωδικοποίησή τους

TEMPLATE Polygon Περίγραµµα περιοχής µελέτης

COLUMN TYPE Precision
FID Object ID

Shape Geometry / Polygon

Shape_Area Float Numeric 0

Shape_Length Float Numeric 0

LU_CODE Short Numeric 3

COST_HA Long Numeric 6

LUAT_ID Short Numeric 4 

Πίνακας Περιγραφικής Πληροφορίας

LU_CODE Χρήση Γης
100 Αστική

200 Αγροτική

300 Θαµνώδης

400 ∆ασική

500 Υδάτινη

700 Άγονη



2. ROADS

Το θεµατικό επίπεδο του οδικού δικτύου περιλαµβάνει
45 γραµµικά τµήµατα στην περιοχή µελέτης.

Στον διπλανό πίνακα παρουσιάζεται η κα-
τηγοριοποίηση του οδικού δικτύου.

3. SEWERS

Το θεµατικό αυτό επίπεδο αποτελείται από έξι γραµµικά τµήµατα. Η πληροφορία
στο πεδίο DIAMETER του πίνακα χρησιµοποιείται για τη  διάκρισή τους σε κύριες
και δευτερεύουσες γραµµές. Οι κύριες σωληνώσεις έχουν διάµετρο ίση µε 60 µο-
νάδες, ενώ οι δευτερεύουσες έχουν µικρότερη διάµετρο κατά 15 µονάδες.
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COLUMN TYPE Precision
FID Object ID

Shape Geometry / Polyline

Length Float Numeric 0

RD_CODE Short Numeric 1

ROADS_ID Long Numeric 9

Πίνακας Περιγραφικής Πληροφορίας

COLUMN TYPE Precision
FID Object ID

Shape Geometry / Polyline

Length Float Numeric 0

DIAMETER Short Numeric 2

SEWERS_ID Long Numeric 9

Πίνακας Περιγραφικής Πληροφορίας

RD_CODE Τάξη ∆ικτύου
1 Κύριο (Improved)

2 ∆ευτερεύων (Semi-improved)



4. SOILS

Στο θεµατικό αυτό επίπεδο η περιοχή µελέτης αποτε-
λείται από 43 πολύγωνα τα οποία κατηγοριοποιούνται
µε βάση την καταλληλότητα του εδάφους.

5, STREAMS

Το επίπεδο αυτό αποτελείται από 106 γραµµικά τµή-
µατα του υδρογραφικό δικτυου της περιοχής µελέτης.
Η κατηγοριοποίηση του υδρογραφικού δικτύου βασί-
ζεται στο πεδίο STRM_CODE.

Το θεµατικό επίπεδο STREAMS δίνεται σε µορφή Coverage και πρέπει να µετατραπεί
σε µορφή Shapefile. 

ΕΥΡΕΤΗΡΙΟ174

COLUMN TYPE Precision
FID Object ID

Shape Geometry / Polyline

Shape_Area Float Numeric 0

Shape_Length Float Numeric 0

SOILS_CODE String Length 3

SUIT Short Numeric 1

SOILS_ID Long Numeric 9 

Πίνακας Περιγραφικής Πληροφορίας

SUIT Καταλληλότητα
0 Μη Κατάλληλη

1 Ελάχιστη Καταλληλότητα

2 Μεσαία Καταλληλότητα

3 Υψηλή Καταλληλότητα

COLUMN TYPE Precision
FID Object ID

Shape Geometry / Polyline

Fnode# Long Numeric 0

Tnode# Long Numeric 0

Lpoly# Long Numeric 0

Rpoly# Long Numeric 0

Length Float Numeric 0 

Streams# Double Numeric 0

STRM_CODE Short Numeric 4

STREAMS_ID Long Numeric 9

Πίνακας Περιγραφικής Πληροφορίας

STRM_CODE Τάξη ∆ικτύου
1 Κύριο

2 ∆ευτερεύων



6. TEMPLATE

Το επίπεδο αυτό αποτελείται από δύο εγγραφές που
καλύπτουν το χερσαίο και θαλάσσιο τµήµα της πε-
ριοχής µελέτης.

7. ΕΙΚΟΝΑ LANDUSE

Επίσης η γεωγραφική βάση δεδοµένων, συµπληρώνεται µε την εικόνα LANDUSE η οποία
παρέχεται στο φάκελο {…\\DATA\BASIC\TIFF FILES} και αναφέρεται σε χρήσεις γης, σε
µια περιοχή συµπληρωµατική του θεµατικού επιπέδου LUAT. Η εικόνα αυτή, αφού σαρωθεί
µετατρέπεται σε διανυσµατική µορφή. Το επίπεδο που προκύπτει σε συνδυασµό µε το θε-
µατικό επίπεδο LUAT ορίζουν το τελικό διανυσµατικό επίπεδο χρήσεων γης. 

Εικόνα LANDUSE
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COLUMN TYPE Precision
FID Object ID

Shape Geometry / Polyline

LU_CODE Short Numeric 4

COST_HA Long Numeric 9

Shape_Length Double Numeric 0

Shape_Area Double Numeric 0

Πίνακας Περιγραφικής Πληροφορίας



B. Αποτελέσµατα (Results)

Όπως φαίνεται στην παρακάτω εικόνα, στα αποτε-
λέσµατα υπάρχει ένας φάκελος για κάθε στάδιο
του εκπαιδευτικού παραδείγµατος. Τα περιεχόµενα
αρχεία σε καθένα από αυτούς τους φακέλους είναι
τα αποτελέσµατα της διαδικασίας του σταδίου

αυτού. Για παράδειγµα στο φάκελο {…\\DATA\RE-
SULTS\2_DIGITIZING}, περιέχεται το ψηφιοποι-

ηµένο θεµατικό επίπεδο “Shapefile” (LANDUSE_DG),
το οποίο είναι το αποτέλεσµα της διαδικασίας της
Ψηφιοποίησης. 

Γ. Σύστηµα Συντεταγµένων

Το προβολικό σύστηµα όλων των διαθέσιµων δεδοµένων
καθώς και των αποτελεσµάτων είναι το “Clarke 1866 UTM
ZONE 18” και έχει τις ακόλουθες τιµές:
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